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Preface

The Windows Logic Controller (WinLC) is the programmable logic controller (PLC) for the Windows
Automation Center (WinAC Basis) package. It is fully code-compatible with the SIMATIC product family.
You can use many of the SIMATIC products, such as WinCC, with WinLC.

WinLC uses a PROFIBUS-DP network to control the distributed I/O, such as an ET 200M device. WinLC
uses S7 communications (such as PROFIBUS, Industrial Ethernet, or MPI) for connecting to STEP 7 or
other programming software on another computer.

Audience

This manual is intended for engineers, programmers, and maintenance personnel who have a general
knowledge of programmable logic controllers.

Scope

This document describes the features and the operation of WinAC version 4.1.

Other Manuals

You can find additional information in the online help for STEP 7 and in the following manuals:

e Programming with STEP 7 Manual. This manual provides basic information on designing and
programming a WinLC control program. Use this manual when creating a control program with the
STEP 7 automation software.

o System Software for S7-300/400 System and Standard Functions Reference Manual. WinLC
includes integrated system functions and organization blocks, which you can use when
programming. This manual provides you with descriptions of the system functions, organization
blocks, and loadable standard functions.

o Working with STEP 7 Getting Started Manual. This manual explains the usage and the functions of
the STEP 7 automation software. This manual provides you with an overview of the procedures
used to configure WIinLC and to develop control programs.

To find these and other manuals, select the Start > Simatic > Documentation menu command from the
Start menu of the computer where STEP 7 and SIMATIC NET are installed.
Additional Assistance

For assistance in answering technical questions, for training on this product, or for ordering, contact your
Siemens distributor or sales office.

[H" North America and South [ Europe and Africa [H” Asia and Pacific region
America
Telephone: +1 (800) 333- Telephone: +49 (0) 180 Telephone: +86 10 64 75 75
7421 5050 222 75
Fax: +1 (423) 262-2200 Fax: +49 (0) 180 5050 223 Fax: +86 1064 74 74 74

simatic.hotline@siemens.com adsupport@siemens.com adsupport.asia@siemens.com
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Product Overview

Introduction to PC-Based Control

WinLC is a programmable "soft logic" controller — a software version of an S7 controller — that runs on a
standard computer (PC).

WinLC supports multiple networks and connects

to the distributed I/O, such as ET 200M, by Optional SIMATIC products

means of CP cards (CP 5611, CP 5613 V3, or ! FroTool

CP 5613 V6 or later) that you install in your STER 7 |f WinCC Fro

computer.

As part of the SIMATIC family of automation o
products, WinLC can also communicate with < 10 D'Islmhum II'IIO
STEP 7 or other SIMATIC products, such as == |]

WinCC, ProTool Pro, or other SIMATIC T
S7 controllers, including WinLC, over PROFIBUS, |

Ethernet, or MPI networks. This allows you to use FROFIEUS

WinLC in a typical factory automation

configuration.

Introduction to the Control Panel

The control panel corresponds to the faceplate of the S7 controllers. It enables File CFU Help
you to start or shut down the controller and to perform other controller operations.

The control panel contains the following elements for working with the controller:

e Three mode buttons for changing the operating mode of the controller
(The mode buttons are similar to the keyswitch on a hardware S7
controller)

e Status indicators for the controller FUNTe

e An MRES button for resetting the memory areas RLM

e Menus for controller operations

An icon . is displayed in the Windows taskbar whenever the controller is
operating. When the controller is operating and the control panel is closed, you
can double-click this icon to open the control panel. Opening or closing the
control panel does not influence the state of the controller. The status of the

operator switches and the LEDs are stored in the controller. il

sTop | MRES
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WinLC Features

WinLC is a software version of an S7 controller that executes on a Windows PC. It executes S7 control
programs like other S7 controllers and allows for easy integration with STEP 7 and standard Windows
applications.

SIMATIC Functionality Supported by WinLC

WiInLC provides the following features:

H" Implements a comprehensive subset of the S7 logic blocks of SIMATIC controllers:
Organization Block (OB), System Function Block (SFB), and System Function (SFC)

B  Uses PROFIBUS-DP as its I/0 subsystem, supporting DPV0 and DPV1 slaves (PROFIBUS
DPV1 provides enhanced alarm and status reporting, in order to communicate with intelligent
slave devices)

@ Uses S7 communication services, offering compatibility with SIMATIC applications such as
STEP 7 and WinCC (for tasks such as programming, debugging, or monitoring)

[H"  Supports up to 4 separate PROFIBUS-DP subnets for controlling distributed 1/0

@  Supports the routing of S7 communications through the submodule CP cards of WinLC,
allowing STEP 7 on one subnet to connect to an S7 station (such as an S7-400 controller) on
a different subnet

5

Provides ability to archive and restore control programs

5

Allows you to control the operational mode of WinLC and to view status information from the
control panel

B"  Provides a tuning panel for optimizing system performance

B"  Allows peer-to-peer communications between controllers (hardware or software) on the
network

Windows Functionality Supported by WinLC

Windows Administrator privileges (ADMIN) are not required in order to operate the WinLC controller. With
Power User, User or even with Guest privileges, you can perform operational tasks, such as changing the
operating mode of the controller from RUN to STOP, modifying the sleep time, or restoring an archived
control program.

If you configured WinLC to start at PC boot (and if the controller was consequently started by rebooting the
computer), one user can log off and another user can log on without affecting the operation of the
controller.

Note: Although WinLC supports logging off and logging on as a Windows user, the Windows XP
"Switch User" function is not supported by WinLC.
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New Features for WinAC V4.1

H Improved performance

[  Peer-to-peer
communication

@  Multi-PLC support

@ SIMATIC NET OPC
server

[H  Windows
Administrator
privileges not required

Control programs running on WinLC V4.1 have execution times
up to twice as fast as the same control program running on
WinLC V4.0. The reduction in scan time allows the PC resources
to be utilized by other tasks, such as HMI or data processing
applications.

Other enhancements in WinLC V4.1 reduce the effect of the
STEP 7 programming tools, such as block status and
breakpoints, on the performance of the WinLC controller. In
addition, WinLC V4.1 includes support for new functionality and
improved interactions with STEP 7 and PCS 7

Using STEP 7 V5.3 and a CP card that supports data exchange
with broadcast, WinAC V4.1 provides peer-to-peer
communications between DP slave devices.

Up to 3 WIinAC Slot PLCs (V3.4 or higher) can run on the same
computer with WinLC V4.1 controller.

While the PLCs can communicate with each other (using S7
communication commands such as BSEND and BRCV), each of
the PLCs operates independently. The functionality of the
multiple PLCs is comparable to the operation of multiple S7-400
CPU modules in a segmented rack.

All of the multiple PLCs can be connected simultaneously to
SIMATIC ProTool/Pro, WinCC, or SIMATIC NET OPC
application.

WInAC V4.1 uses the OPC server of SIMATIC NET for
connecting to OPC client applications. Using the SIMATIC NET
OPC server improves the performance of OPC connections
(compared to the OPC server of SIMATIC Computing).

The SIMATIC NET OPC server provides better integration into
STEP 7 configuration, allowing you to use STEP 7 symbols when
configuring your OPC connections.

You are not required to have Windows Administrator privileges in
order to operate the WinAC V4.1 controller.

With Power User, User or even with Guest privileges, you can
change the operating mode of the controller, modify the sleep
time or the minimum scan time, archive or restore a control
program, or set the security option, in addition to other
operational tasks.
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H  WinAC ODK V4.1
interfaces

"  CP 5613-A2

[ Non-retentive DBs

" Diagnostic tool for
computer-related
problems

#* Enhanced support for
Positioning and
Motion applications

You can use the interfaces of the WinAC Open Development Kit
(ODK) to implement custom applications into your control tasks:

e Custom Code Extension (CCX): allows your control
program to call custom DLLs directly from the control
program being executed by the PLC

e Shared Memory Extension (SMX): enables a very fast
and efficient data exchange between the PLC and a
application by providing direct access to a specified
P1/PO area (utilizing dual-port RAM)

e Controller Management Interface (CMI): allows you to
embed the functionality of the WinAC control panel into a
custom application

WinAC V4.1 supports the CP 5613-A2 card.

Using STEP 7 V5.3, you can configure a non-retentive data block
(DB) for your control program.

SFC82 and SFC85 also support the creation of non-retentive
DBs.

WinAC V4.1 provides a software application that provides
system-level information for the customer service engineers to
use in diagnosing computer-related problems, such as when
Windows crashes.

Using a distributed configuration (PROFIBUS-DP and ET 200M),
WiInAC V4.1 supports the following SIMATIC S7 Function
Modules for simple point-to-point positioning and for complex
motion profiles:

e FM 353: Positioning module for stepper motors in
machines with high clock-pulse rates

e FM 354: Positioning module for servo motors in
machines with high clock-pulse rates

WinAC V4.1 also supports the use of SIMOVERT
MASTERDRIVES with complex motion functions, such as CAM
control or electronic gear.
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System Requirements

To use WinAC, your personal computer (PC) must meet the following criteria:

Operating
System

Processor
and memory

Hard drive

Operator
interface

Network
interface

Siemens
software

Microsoft Windows 2000 Professional Service Pack 3 or Microsoft Windows XP
Professional Service Pack 1

Pentium uniprocessor or multiprocessor system:
e 800 MHz or faster, single or dual processor
e 256 Mbytes or more of RAM
e BIOS must support plug-and-play

A hard drive with 125 Mbytes of free space

The setup program uses at least 1 Mbyte additional free space on drive C for the
WiInLC Setup program (Setup files are deleted when the installation is complete)

A color monitor, keyboard, and mouse or other pointing device (optional) that are
supported by Windows

At least one PCI slot with an installed Siemens CP card (CP 5611, CP 5613 V3, or
CP 5613 V6 or later) connected to a PROFIBUS-DP network for distributed 1/O
communication

Communications software: SIMATIC NET V6.2

Note: The SIMATIC NET software must be installed before you install
WinAC.

Programming and configuration software: STEP 7 V5.3 or later

Note: You can use STEP 7 V5.2 if you do not need any of the following
WinAC 4.1 new features:

¢ Improved performance

e Peer-to-peer communication between DP slave devices

e Enhanced support for positioning and motion applications
e Non-retentive DBs

e Multi-PLC support

e WinAC ODK 4.1

e SSL_IDOx1C
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Windows User Privileges

You are not required to have Windows Administrator (ADMIN) privileges in order to perform WinAC
operations, such as changing the operating mode of the controller, modifying the sleep time or the
minimum scan time of the controller, archiving or restoring control programs, or setting the security options.

With Power User, User or even with Guest privileges, you can perform any operation from the WinLC
control panel. This allows you to manage the network privileges for the PC station within your application
and to avoid conflicts during installation, commissioning and operation of a PC-based automation solution
that is part of a larger system.

As shown in the following table, some operations are restricted to certain Windows User privilege classes.

Operation Administrator Power User Guest
User
Installing WinAC software M Allowed Not allowed Not allowed Not allowed
Configuring or modifying the PC [H" Allowed [H" Allowed [H" Allowed  Not allowed
Station
Performing WinAC operations [H" Allowed [H Allowed [ Allowed [ Allowed



Product Overview

Using Help

The online help system provides information about the control panel and the controller. This topic
provides information about using online help:

e Accessing Help from the Control Panel
e Using the Table of Contents

e Using the Index

e Using Full-Text Search

e Printing Help Topics

e Changing the Language of a Help Topic

Accessing Help from the Control Panel
To access online help from the control panel, use one of the following methods:

e You can click one of the following entries on the Help menu to display the electronic manual that
provides the online help:

[H" Help on Panel

The Help > Help on Panel command opens the initial page of the online help for the control
panel when it is not connected to a controller. The table of contents is in the left navigation
pane.

[H"Help on Controller (available when panel is connected to a controller)

The Help > Help on Controller command displays the initial page of the online help for the
controller that is connected to the control panel. It describes controller and control panel
operations. The table of contents is in the left navigation pane.

[ Introduction (available when panel is connected to a controller)

The Help > Introduction command displays a topic that provides an introduction to the
controller and the tasks you can perform with it.

[H Getting Started (available when panel is connected to a controller)

The Help > Getting Started command displays a topic that helps you get started when you
begin using the control panel to work with the controller for the first time.

e You can click the Help button in a dialog or message box to view information about that specific
dialog or message box.

e You can press the F1 key to view context-sensitive help on the currently selected item (for
example, a window, dialog, or menu).
Using the Table of Contents

The table of contents is in the left navigation pane of the browser; you can navigate to any topic by clicking
the mouse:

e Click a book to open it and display the books and topics that it contains.
e Click the book again to close it.
o Click any topic within the table of contents to display that topic.

The topic you are currently viewing is highlighted in the table of contents.
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The table of contents can be either hidden or displayed:
¢ Click the "x" in the left navigation pane to close the table of contents.

e Select the Contents tab or the "Show" link in a topic to display it. (The "Show" link appears only
when you have displayed a context-sensitive topic from the application.)

Using the Index

You can use the index to find information about a specific subject. Use one of the following methods to
access the index:

e Select the Index tab in the navigation pane. (If the Index tab is not visible, click the "Show" link at
the top of the topic. The "Show" link appears only when you have displayed a context-sensitive
topic from the application.)

e Click the Index button in any help topic.

Using Full-Text Search

The help system also provides full-text search capabilities. You can use the search field that is displayed
above the topic, or select the Search tab from the navigation pane. (If the Search field and Search tab are
not visible, click the "Show" link at the top of the topic. The "Show" link appears only when you have
displayed a context-sensitive topic from the application.)

You can use the Boolean operators AND, OR, and NOT and parentheses in your search expression.
Wildcards ("*") are not supported.

Printing Help Topics

To print a single topic that is displayed in your browser, right-click in the topic pane and select Print from
the context menu. Select the print options of your choice.

Changing the Language of a Help Topic

The browser contains language buttons for each of the supported languages. To see the current help topic
in another language, click the language button of your choice. The current topic is displayed in the
language you selected, but the contents, index, and search features of the online help system remain in the
original language. This may be helpful if a topic is unclear and you want to read it in another language.

If you select a language that you did not install, the online help system cannot display the topic in that
language and displays a "Page not found" error. Changing the language of an online help topic does not
change the display language of the control panel.
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Overview of the Installation Tasks

You must install the following products in order to complete the installation of WinAC:
e Communications processor (CP) card and SIMATIC NET software
e WinAC software
e  WInAC Authorization

Note: You must have Windows administrator (ADMIN) privileges to install the WinAC Basis
software.

You must install the SIMATIC NET software before installing the WinAC components.

To install WinAC, you must complete the following tasks:
e Install the SIMATIC NET software.
e |Install the WinAC software.
o Authorize the WinAC software.

Installing SIMATIC NET and the CP Card

WiInAC supports the following Siemens CP cards for communicating with the distributed I/O over a
PROFIBUS-DP subnet: CP 5611, CP 5613 V3, or CP 5613 V6 or later.

You can install up to four CP cards in your computer. For specific installation instructions, refer to
the documentation for your CP card.

WiInAC also requires that you install the SIMATIC NET V6.2 software.

To use a CP card with WinAC, you must install it as a submodule.

Notice

Assigning the CP card as a submodule of WinLC automatically changes the operation
mode of the CP card to PG Operation. However, the Set PG/PC Interface dialog allows
you to change the Interface Parameter Assignment for the CP card when the WinLC
controller is not running. Using the Set PG/PC Interface dialog to change the Interface
Parameter Assignment of a CP card that has already been configured as a submodule
causes an error that prohibits WinLC from going to RUN mode.

For information about recovering from this error, refer to the Use Case on designating the
CP card as a submodule.




Installation

Installing the WinAC Software

The WinAC software includes a Setup program that guides you step by step through the installation
procedure. The Setup program begins automatically when you put the CD in the drive. If the Setup
program does not start automatically, double-click the Setup.exe file on the CD.

Note: You must have Windows administrator (ADMIN) privileges to install the WinAC

software.

If you select the "Run automatic authorization" checkbox in the Target Drive dialog, the Setup program

checks to see whether an authorization is installed on the hard disk. If no authorization is found, a message

notifies you that the software can be used only with an authorization. You can run the authorization
program immediately or you can continue the installation and execute the authorization later.

Follow the instructions of the Setup wizard. From the list of WinAC components, select the components to

be installed.

Note: To use a CP 5611 card or the integrated PROFIBUS interface of a SIMATIC PC as a
submodule of WinLC, you must install the WinAC DP driver for the CP 5611.

If you get messages from FIeTNE i o L R e

SIMATIC NET that say
the CP card is configured
for use with

SIMATIC NET and

STEP 7, click OK. This is
a normal part of the
installation process.

After installing the
components WIinAC, the
Setup wizard prompts you
to insert the WinAC
authorization diskette in
drive A.

The Setup program
notifies you that the
installation is complete.
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Installation

Authorizing the WinAC Software

The WinAC software requires a product-specific authorization (or license for use). There are separate
authorization diskettes for each of the SIMATIC automation software products. You must install the
authorization for each product.

Caution

If improperly transferred or removed, the authorization for the WinAC software may be
irretrievably lost.

The Readme file on the authorization diskette contains guidelines for installing,
transferring, and removing the authorization for the WinAC software. If you do not follow
these guidelines, the authorization for the WinAC software may be irretrievably lost.

Read the information in the Readme file on the authorization diskette, and follow the
guidelines in regard to transferring and removing the authorization.

Installing the Authorization for the First Time

When you install the software for the first time, a message prompts you to install the authorization. Use the
following steps to install the authorization for the WinAC software:

1. When prompted, insert the authorization diskette in a drive.
2. Acknowledge the prompt.

The authorization is transferred to a physical drive, and your computer registers the fact that the
authorization has been installed.

Adding an Authorization at a Later Date

If you attempt to start the WinAC software and no authorization is found, a prompt appears on the screen. If
you want to install the authorization, you can do so using the AuthorsW program. The AuthorsW program
allows you to display, install, and remove authorizations. To authorize the WinAC software, follow these
steps:

1. Select the Start > Simatic > AuthorsW > AuthorsW menu command.
2. Select the Move Authorization tab from the AuthorsW dialog to display the authorizations available.

3. Select the authorization for WinAC 4.1 from the list of available products on the authorization
diskette.

4. Click the right arrow to transfer the authorization from the diskette to your hard drive.

If AuthorsW is not installed on your computer, insert the WinAC installation CD. When the
Setup Components dialog appears, select the AuthorsW checkbox. After the installation is complete, select
the AuthorsW program from the Start menu as described above.
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Removing an Authorization

If you need to repeat the authorization (for example, if you want to reformat the drive on which the
authorization is located), you must first remove the authorization. You need the original authorization
diskette to do this.

Use the following steps to transfer the authorization back to the authorization diskette:
1. Insert the original authorization diskette in the drive.
Select the Start > Simatic > AuthorsW > AuthorsW menu command.
From the list of all authorizations on drive C, select the authorization to be removed.
Select the Authorization > Transfer menu command.

In the dialog, enter the target drive to which the authorization will be transferred.

2

The window with the list of authorizations remaining on the drive is then displayed. Close the
AuthorsW program if you do not want to remove any more authorizations.

You can then use the diskette again to install an authorization.

Running the WinLC Controller without the Authorization

If you remove (or accidentally delete) the authorization for the software, the WinLC controller continues to
operate; however, a notification message appears every six minutes to alert you that the authorization is
missing.

Recovering the Authorization in Case of a Defective Hard Drive

If a fault occurs with the authorization file on your hard disk or on the authorization diskette, contact your
local Siemens representative.

Uninstalling the WinAC Software

Use the following procedure to remove the WinAC software from your computer:
1. Double-click the Add/Remove Programs icon in the Windows Control Panel.

2. Select the WinAC component entry in the displayed list of installed software. Click Add/Remove to
uninstall the software. Each component of WinAC is listed separately.

If the Remove Shared File dialog boxes appear, click No if you are unsure how to respond.

12



Getting Started
Getting Started Overview

The Getting Started section helps you to establish communications between the WinLC controller,
STEP 7, and the distributed (DP) I/O by performing the following tasks:

e Use the Station Configuration Editor to designate the CP card as a submodule of WinLC.
e Use STEP 7 to configure the controller and CP cards and to download the system blocks.

The Getting Started section also helps you understand the basic concepts for setting up WinLC: PC
station, Index, Submodule, and Interface (IF) Slot.

To establish communications for the WinLC controller, you must perform the tasks shown in the following
figure. (Click on one of the numbered sections to see a use case describing that task.)

3
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for the contraller as a submodule of the
controller

ETEFR 7
Hardware
Configuration

1

Inies D!SEH!“OH ‘

WiHLG

T
o

== [=[=]

i
:‘T"
1 m 1|

0
o
'}
o
2
—

CRERE ‘

Prerequisites
Before you can get started, you must install the following components:
e SIMATIC Communications Processor (CP) card, such as a CP 5613
e SIMATIC NET communications software
e  WinLC software
e STEP 7 programming software

Note: STEP 7 can be installed either on the same computer as WinLC or on a remote computer.
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Understanding the Concepts

What Is a PC Station?

The PC station functions as a software-based virtual rack for creating a PC-based automation
system. You create the PC station in the Station Configuration Editor when you install the
SIMATIC NET software. When you install WinLC, it automatically appears in a slot (index) of this
virtual rack in the Station Configuration Editor. You also add one or more CP cards to your PC
Station, which you subsequently configure as a submodule of WinLC.

The PC-based controller (WinLC) is similar to an S7-400 Communications for a Hardware FLC
hardware controller.

The figure shows a communication model for a hardware

controller. STER 7

The hardware controller consists of modules that are CP Card
inserted into a rack. These modules communicate over the e
backplane of the rack.

e STEP 7 communicates with the controller (in this ST-400 CPU with submodule
example, an S7-400 CPU module) over an 27400 CF module
MPI subnet, using a CP card that is installed in the
computer. l

e The controller communicates with other modules, Haraware —
such as a CP module) over the backplane of the Back plan ¢
rack.

e The CP module communicates with the ’
distributed 1/0 over a PROFIBUS-DP subnet.

For this example, the S7-400 controller has a
communications submodule that allows the controller to
communicate with distributed I/O over a PROFIBUS-DP —

subnet. " PROFIBUS-DP

' DOF 110
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WinLC communicates very much like the hardware controller.

Because WiInLC is located on your computer, WinLC uses one or more CP cards (CP 5611, CP 5613 V3,

or CP 5613 V6 or later) for communicating to the distributed (DP) I/0O remotely through the PROFIBUS-DP
network. You use the Station Configuration Editor to configure the CP cards as submodules.

[H"WinLC and any CP card that is not configured
as a submodule communicate over a software
"backplane."

" If STEP 7 is installed on the same computer as
WinLC, STEP 7 communicates over the software
"backplane."

" WinLC uses a submodule CP card to
communicate with the DP 1/O.

[H"STEP 7 on a remote computer uses a CP card
to communicate with WIinLC. In this example, the
local CP card uses the software "backplane" to
communicate with WinLC.

[H"STEP 7 on a PROFIBUS-DP subnet can
communicate with WinLC through the submodule
CP card.

Configuring the "Hardware™ of the PC-
Based Controller

In the same way that you use STEP 7 to create the
control program and system blocks for a hardware
controller, you must use the Hardware
Configuration tool of STEP 7 to configure the
components that you installed in the PC station.
When you download the system blocks to WinLC,

the name of the PC station is renamed to the name

as configured by STEP 7.

Communications for a Software PLC

STEP 7 ME |
FROFIELS

Industrial Ethernet
CF Card [

CF Card — Toftware B
~op, “Eackplane LF Card

i
=
CP Card =

" STERP 7
CF Card WinLC

CF Card

|
=i

STER 7

5
G [

TI:F" Card

PROFIBUS-DP |

After you configure your PC station both in the Station Configuration Editor and in STEP 7, you can

download your control program to the PC station.

Note: To use the CP card for communicating both with STEP 7 and with the distributed 1/0 may

require an additional software license. See your Siemens sales representative or distributor for more

information.
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What Is an Index?

An index is a numbered slot in the virtual rack of the PC station. The PC Station provides slots for
the SIMATIC components of a PC-based automation solution, including not only WinLC and
CP cards, but also SIMATIC HMI and SIMATIC NET OPC.

Each slot in the PC station is assigned a number or index. When you install a SIMATIC component,
such as WinLC or the CP card, the component is inserted in an index line in the

Station Configuration Editor. The Station Configuration Editor shows the configuration of your

PC station.

Note: You install a CP card in a physical location (one of the PCI slots) in your computer. There is
no implied or required correspondence between this physical location and the index of the CP card
in the Station Configuration Editor.

The index number for a CP card in a PC station is its virtual slot on the virtual rack. This can be any index
number you choose. It does not have to be the same as the hardware slot number for the CP card. The
index number in the Station Configuration Editor, however, must be the same as the slot number in the
STEP 7 Hardware Configuration tool for the same component.

You install the CP card in
T a glot of the computer

Ihdex | Mame
The Station Canfiguration q
Editar assigng the CP card to
a logical index B

2
3
4 P 5613
&
=
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What Is a Submodule?

In order for WinLC to communicate with the DP 1/O devices on the PROFIBUS-DP network, you
must designate a PROFIBUS CP card to be a submodule for the controller. With this submodule
approach, WIinLC has full control over the CP card, providing optimum performance and
determinism for operating the I/0. WinLC supports up to four submodules.

If you use a CP 5611 card as a submodule of WinLC, note that you can insert only one CP 5611 in
the PC Station.

You can configure up to a total of four CP cards as submodules for WinLC. CP 5613 cards can be
inserted in any of the four IF slots.

To configure the CP card as a submodule, you move the CP card from an index in the PC station to
an IF slot in the controller.

After you have configured the CP card as a component of the PC station, you can use it only for SIMATIC
communications (such as MPI, TCP/IP, Industrial Ethernet, or PROFIBUS) with STEP 7, SIMATIC HMI, or
other SIMATIC controllers. For example, you can download a program from STEP 7 to WinLC. However,
the CP card cannot communicate with the distributed (DP) I/O on the PROFIBUS-DP network until you
designate it as a submodule of the controller.

Configuring a CP card as a submodule of WinLC
is like installing a CP submodule into a slot of an

S7-400 CPU. | .| S7F-400 CPU
Designating the CP card as a submodule of =

WinLC not only allows WinLC to use that (| CF Card I- — )

CP card for SIMATIC communications when l =
WinLC is active, but also allows WinLC to use = CF Module

that CP card for communicating with the DP 1/O. _
P Station

In order for a submodule CP card to be used for
SIMATIC communications with an application
other than WinLC (on the PC station), the second application must be a configured part of the PC station.

Notice

Any change to the configuration of a submodule causes WinLC to delete the control
program. You must then download a new control program and configuration.

For example: Moving the submodule CP card to a different slot, WinLC recognizes that
the hardware configuration has changed and deletes the control program, even if you had
reconfigured the CP card for the same IF slot in the configuration of the PC station. You
must still reload the control program from STEP 7.
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The figure shows the difference between the CP card as a component of the PC station and the CP card as
a submodule of WinLC.

With the CP card configured
as a component of the

PC station, WinLC can
communicate with STEP 7 on
a remote computer, but STER 7 STER 7
cannot communicate with the
DP 1/0.

With the CP card configured
as a submodule, WinLC can
communicate with both

STEP 7 on a remote ; j_ P Card r — P Card
=l
|

Pl Communication MPI1 and DP 1O Communic ation

&
|

computer (using SIMATIC o |

communications) and with the Component in l |:|' 1 = Submodule of
DP 1/0 on the PROFIBUS-DP the P Station

subnet.

=i the contraller

PiZ: Station 1 PiZ: Station
|
PROFIBUS-DP : PROFIBUS-DP

I I
DP M DP
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What Is an IF Slot?

WinLC provides four interface (IF) slots for designating CP cards as submodules. WinLC must have
exclusive control of any CP card that you move to an IF slot. This allows the controller to
communicate with the distributed (DP) 1/O.

To use the DP network to communicate with 1/0O, you must configure the CP card to be a submodule of
WiInLC. You use the WinLC Properties dialog to move the CP card to one of four interface slots, IF1
through IF4.

The IF slot number of the

submodule is independent of the |I|

PCI hardware slot for the CP card.

However, the IF slot number for the

CP card submodule in the Station [

Configuration Editor must match

the IF slot number in the STEP 7 F 1 SHBmEL2
. . IF ¥ CP 5615

Hardware Configuration tool.

IF 3
You first install both the CP card BN N s
and WinLC in the PC station. You
then move the CP card into one of
the IF slots for WinLC.

CF 5613 =
i
For more information, refer to the =
following topic: Use Case:
Designating a CP Card as a
Submodule

- 2]
iF [ g

=l

WinLc

£ . -9 XY [ S

Station Corfigurstion WIhLC Propetties P Station
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Configuring the CP Card as a Submodule

Use Case: Designating a CP Card as a Submodule

Goal: To configure a CP card as a submodule of WinLC by inserting it into an IF slot of the
controller, and to verify that configuration. The CP card configuration enables WinLC to
communicate with DP 1/O over the PROFIBUS network.

Software Tool: You use the Station Configuration Editor of SIMATIC NET to move the CP card
from the virtual rack to the submodule slot of WinLC.

Next Step: You configure WinLC and all other components of the PC station in STEP 7.

To configure your CP card as a submodule, ensure that the controller is shut down and follow these st

eps:

Imles | Mame

E el WinLC

CP 5613

Double-click the computer icon 5 on the Windows
taskbar. The Station Configuration Editor appears with
WinLC in the second index.

Select an empty index in the PC Station and click the
Add button to display the Add Component dialog.

From the drop-down list, select the CP card to add to the
station configuration and click OK. The Component
Properties dialog appears. You can use this dialog to
make changes to component properties such as baud
rate if necessary. Click OK to add the component to the
station.

Select WinLC and click the Edit button to display the
Edit Component dialog. You can use this dialog to
change the index number for the WinLC controller.

Click the Properties button to display the WinLC
Properties dialog.

IF 1

'——HF : | CF 56T
IF 3

IF 4

In the SubModule tab, the four submodule interfaces are listed
(IF1 to IF4).

1.
2.

Click an empty slot to highlight the IF slot.

Click the Add button to display the list of configured
modules in the PC station.

Select the CP card that you want to configure as a
submodule, and click OK.

Click OK on the WinLC Properties dialog and on the Edit
Component dialog.

Incle | Mame

WinLC

IF
IF =5k

IF

IF 4

The CP card moves from the virtual rack of the PC station to the
submodule slot of the WinLC controller. (This configuration may
take several seconds.)

For multiple CP cards, repeat the above steps as needed.
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You can select an occupied interface slot (IF slot) and click the Edit button to change the interface slot
assignment for a configured CP card, or to change its name.

Notice

Any change to the configuration of a submodule causes WinLC to delete the control
program. You must then download a new control program and configuration.

For example: Moving the submodule CP card to a different slot, WinLC recognizes that
the hardware configuration has changed and deletes the control program, even if you
had reconfigured the CP card for the same IF slot in the configuration of the PC station.
You must still reload the control program from STEP 7.

Do not use the Set PG/PC Interface dialog to change the assignment of the CP card that has been
configured as a submodule of WinLC.

Notice

Using the Set PG/PC Interface dialog to change the Interface Parameter Assignment of a
CP card that has already been configured as a submodule causes an error that prohibits
WinLC from going to RUN mode.

To recover from this error, perform the following steps:
1. Shut down WinLC.
2. Use the WinLC Properties dialog to delete the submodule from WinLC:

e Double-click the computer icon £ on the Windows taskbar to display the Station
Configuration Editor

e Select WInLC and click the Edit button to display the Edit Component dialog and click the
Properties button to display the WinLC Properties dialog.

e Select the submodule and click the Delete button.
4. Use the procedure above to reassign the CP card as a submodule.
5. Restart WinLC.

You must now download a new control program and configuration.
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Testing the Submodule CP Card

Goal: To verify that the submodule CP card is configured correctly.

This test is especially important if you have installed more than one CP card in your computer.
Prerequisite: You must start the WinLC controller.

Software Tool: You use the Station Configuration Editor of SIMATIC NET.

After you start WinLC, you can check the operation of the submodule CP card:

1. Double-click the computer icon 5 on the Windows taskbar. The Station Configuration Editor
appears.

Select the WinLC station and click the Edit button to display the Edit Component dialog.
Click the Properties button to display the WinLC Properties dialog.

Select the interface slot (IF slot) containing the CP card to be tested.

Click the Ring ON button.

The LEDs on the CP card at the back of your computer flash in an alternating pattern so you can
verify that you have configured the correct CP card. The computer also emits an audible beep if the
CP card is functioning.

6. Click the Ring OFF button to end the test of the CP card.

A A

22



Getting Started

Viewing the Diagnostics for the CP Card

You can select an occupied
interface slot (IF slot) and click
the Diagnostics button to view
communication information for a
CP card. The Submodule
Network Diagnostics dialog
displays the current version of
the selected CP card and the bus
parameters.

You can also see a display of all
of the nodes on the
communication network, and the
status of each one. You must
click the Update button to build
this display, because querying
each node puts an additional
load on the communication
network.

Sub-Module Network Diagnostics - CP 5613

x|

— Status/Metwork Diagnostics

Interface: |I F1

|I:F'EE'I 3_BE14[PROFIEBUS]< 3

|The device iz operating in interupt mode.

Bus Parameters | W alle

Highest Station Address 126
Station address of thiz station 2

Baud rate in bitz per second 12.0 Mbpz
Target token rotation time BEO35
Minirurm T zdr 11

b airurn T zdr

Wersion:

a00 |

Siemenz &G CF BE13 EL [E2): P W B0 Hw: 5.0+

—Bus Modes

01234567 8 910111213141516171513
o rrFECrrrrrrrrrrrrrrrr
w2 ol o ol o o
o CFrrrrrrerrrrrerrrrrrr
60 Crrrrrrrrrrrrrrrrrrr
g0 Crrrrererrrrcrrrrrrr
wwrrrrrrrrrrrrrrrrrrrr
1arrrrrrr

ey
[ passive
Update v active

[ active ready

Ok |
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Configuring the Controller in STEP 7

Use Case: Connecting STEP 7 to WinLC

WinLC uses two different network protocols:

e Communications with STEP 7, SIMATIC HMI products, and peer-to-peer communications
with other controllers

e PROFIBUS-DP for communicating with the I/O devices on the DP subnet

In order for WinLC to function as an S7 controller, it must be able to communicate both with STEP 7
and with the distributed (DP) I/O.

The following figure shows how WinLC communicates with distributed I/O over PROFIBUS-DP and with
STEP 7 over MPI.

STEP Y STEP Y
oh the same oh & different
COm pu ter computer

P Internal CP Card I-

d CP Card r |—|

Submodule
{ PROFIEUS

I

WinLc

[nl ]

Pz Station

Configuring Communications between STEP 7 and WinLC

As shown in the following figure, you set the PG/PC interface to the appropriate access point to configure
STEP 7 for communicating with WinLC:

e For a SIMATIC PC station within the STEP 7 project, select the PC Internal access point.
o For a programming device (PG or PC) somewhere on the network (with no Station Manager),
select the access point for the CP card in the programming device.

STEP 7 Project

PG “nT
STEP 7 P Station 1 P Station 2
— PraTool
Access Paint = = =TER ¥
{CP Card) : =
] —| P Internal
P Internal
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STEP 7 on the same computer or on a
PC station within the same STEP 7 project

Set the STONLINE access point to PC Internal.

STEP 7 on a different computer and not part of

the STEP 7 project

Set the STONLINE access point to the CP card that

is used for S7 communications.

Access Path ] ! Access Path ] !
Aceass Poink of the Appicaion , Bezass ot of the Appication ,
TOMLINE [STEP 7] -5 PC intemad [hocal : STOMLINE [STEP 7] -» CPaE13 5614[PROFIELS) :
[Standard for STEP 7] é [For SIMATIC MET) 5
Inteeface Pasameter Assagnment Lsed Intesface Paameter Assgnment Llzed
|PE inkemal (loc=i) | [cFeE13 51 dFROFBLUS Factive: Plopeities. . | |
=150 Ind. Ethemet -» 3Com 30520 Ir | i [ CPSE13_5E14[FWL) | '
B8 P intemal locsl) [ I8 CPSE13_5614MF1)

B TCPAP -+ Com 30320 Integrated Copy. ¥ CP5E13 561 AFROFIBUS kActiver__| Copy..
B TCPAP - Mdidwanlp = Delete | BR150 Ind. Ethemet -» 3Com 3CR0Ir 5 PRt |
1] | d | [ [t | _--I_I |
[Communication with SIMATIC components : [Configuration of wour Commurscations |
in thig PG/PC] | Fioceseor CFS613 / CRSE14icr &
| PROFIBLIS Netwak)
|rkeifaces 1 I Irkeifaces 1
Add/Hemave Select I ' Add/Hemave Select I
o |
i
e L ok | Cocel | Hep |

WinLC can also use the S7 communication protocols (MPI, TCP/IP, Industrial Ethernet, or PROFIBUS) for
peer-to-peer communication with other controllers.

Configuring Communications between WinLC and the DP I/O

To configure WinLC for communicating with the DP I/O, you must designate one or more of the CP cards
as submodules of WinLC. Configuring a CP card as a submodule of WinLC allows WinLC to use the
CP card for communicating over both MPI and PROFIBUS-DP subnets.

Notice

Do not assign a submodule CP card for direct use by applications other than WinLC. For
example: if you designated a CP card as a WinLC submodule, do not assign S7TONLINE
to any parameter setting for that CP card.

Failure to observe this restriction may result in an inability to configure the CP card when

WinLC is downloaded.
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Use Case: Hardware Configuration in STEP 7

Goal: To configure the PC station in STEP 7 and to create the system blocks for WinLC.
Prerequisite: You must have installed both WinLC and STEP 7.
Software Tool: You use STEP 7 to create and download the configuration and the system blocks.

Next Step: You have finished with the configuration tasks and are ready to design and test your
control program.

You configure the WinLC project in STEP 7 as you would for any S7 hardware controller. Refer to the
STEP 7 help system and documentation for detailed information.

[1] Using SIMATIC Manager w45 PROFIBUS DP

Create the project and PC station: g8 PROFIBLS-PA

=-Fl SIMATIC 300

1. Select the File > New menu command to create .. SIWMATIC 400
a new project. w-fll SIMATIC PC Based Contral 300,400
2. Select the Insert > Station > SIMATIC =B, SIMATIC PC Station
PC Station to insert a PC station into the project. = Contraller
_ #-{] CPU 412-2 PLCI
3. Change the name of the PC station to match the w3 CPU 4162 FCI
name of the target PC station defined in the EICI \WinLL
Station Configuration Editor on the target .[8 6ES7 B11-1PY00-0VET
computer. To find the station name, open the El 8 BES7 611-4PY00OVET
Station Configuration Editor and click the @ crEeT
Station Name button. » P 5613
4. Open the PC Station folder and double-click the - WinLC PN
Configuration icon to invoke the Hardware -0 WinlC BT
Configuration application. -2 CP Industrial Ethermet

#-_] CFPROFIBUS

@ Using the Hardware Configuration application

Drag components from the Hardware Catalog to specify
the hardware and software configuration for the PC

station.
Insert the WinLC controller (part number 6ES7 611- -4 (0] PC
4PY00-0YB7 in the same index as for the target —
PC station that you configured with the Station :1 . =
Configuration Editor on the target computer. 5”2:1 [ Win T
Verify that the name of the WinLC controller matches the IF2
name of the WinLC controller that you configured in the IF3
target PC station. IF4
Insert the submodule CP cards for the WinLC controller. 3 j
The WinLC folder in the Hardware Catalog lists the CP 4

card types that are available.

If you use a CP 5611 card as a submodule of WinLC, note that you can insert only one CP 5611 in
the PC Station.

The submodule CP cards do not have to have the same name as in the PC Station configuration.
However, this is recommended. They must have the same type and interface (IF) number as
specified in the PC Station.
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S0 PC

1 - FROFIBIS[1]): DP master spstem [1]

2 WinlLC
I CF 5611

i [

Configure the distributed (DP) I/O for each of the submodule DP networks.

(5]

Optional: Insert any CP cards that are not used as submodules for the WinLC controller. These
are the CP cards installed in the virtual rack of the PC station.

(5]

Optional: Insert any HMI devices.

[

Optional: Configure WinLC for peer-to-peer communications:

[

1. Select the controller name in the SIMATIC Manager.
2. Double-click the Connections icon in the right-hand pane.
3. Use NET-PRO to describe the network.

After you have configured WinLC, you can use SIMATIC Manager to develop and to download your control
program.

Caution

Downloading a control program that is too large for the memory of the computer can lock
up the computer or cause the operation of WinLC to become unstable. Non-responsive
or non-deterministic operations can cause damage to equipment and/or injury to
personnel.

Although STEP 7 and WinLC do not limit the number of blocks or the size of the control
program, your computer does have a limit, based on the available disk space and

RAM memory. The limit for the size of the control program and number of blocks for your
computer can only be determined by testing a configured system against the
requirements of your control application.

After you have downloaded your program to WinLC, you can start the controller and use STEP 7 to monitor
and modify the process variables.

Notice

Any change to the configuration of a submodule causes WinLC to delete the control
program. You must then download a new control program and configuration.

For example: Moving the submodule CP card to a different slot, WinLC recognizes that
the hardware configuration has changed and deletes the control program, even if you had
reconfigured the CP card for the same IF slot in the configuration of the PC station. You
must still reload the control program from STEP 7.
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Invalid Characters

You can use STEP 7 to create a name for the WinLC controller and download the configuration with the
new name to the controller in the Station Manager. However, you cannot use invalid characters for the
name of the controller.

Caution

Using an invalid character in the WinLC name creates an instance of the controller that
cannot be restarted.

Downloading a configuration that uses an invalid character in the WinLC name creates an
invalid instance of the controller. This invalid instance will continue to run and will remain
connected to STEP 7 until you shut down the controller. However, the desktop icon and
the Start menu command will be removed. Without the desktop icon or Start menu
command, you cannot restart the controller after it has been shut down.

Avoid the use of the invalid characters in controller names.

If you inadvertently downloaded a name that contains an invalid character:

1. Using STEP 7 HW-Config, rename the WinLC RTX controller to the previous valid name (the name
prior to downloading the invalid name).

2. Download the configuration with the previous valid name to the PC station (even if the controller is
not running).

After downloading the valid name for the controller, the desktop icon and the Start menu command
reappear. You can now rename the controller to a new name that does not use invalid characters.

Character Name

/ Forward slash

- Hyphen (also called a dash or a minus sign)

You cannot create a name that begins with a hyphen (-). You can, however, use a
hyphen within the name of the controller.

Name Valid? Explanation

Pump-1 Valid Using a hyphen in the middle of the name is valid.

Pump1- Valid Using a hyphen at the end of the name is valid.

-Pump1 Invalid Starting a name with a hyphen is not allowed.

- Invalid Using a hyphen as a one-character name is not
allowed.
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Starting and Shutting Down the Controller

The controller operates independently from the control panel:
e Closing the panel does not shut down WinLC.
e Shutting down WinLC does not close the panel.
The following settings affect the starting or shutting down of the controller:

e Selecting the Autostart option

e Configuring the controller for start at PC boot

Starting WinLC
If the control panel is not open, use one of the following methods to start the control panel and WinLC:

e Select the Start > Simatic > PC Based Control menu command. Then select the name of your
WiInLC controller. (After you have downloaded the control program to your WinLC, the name in the
menu matches the name in STEP 7.)

e Double-click the desktop icon for WinLC:

If the control panel is open, but WinLC is shut down, select the CPU > Start Controller menu command.

Shutting Down WinLC

Select the CPU > Shut Down Controller menu command to shut down the WinLC controller. This action
does not close the control panel. This command is only available from the control panel when the controller
is operating. After you shut down the controller, you can still change customization options.

An icon - is displayed in the Windows taskbar whenever the controller is operating. When the controller is
operating and the control panel is closed, you can double-click this icon to open the control panel.

Closing the Control Panel
Select the File > Exit menu command to close the control panel.

Note: Closing the control panel does not shut down the controller.
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Changing the Operating Mode of the Controller

The control panel provides mode buttons that allow you to change the operating mode of WinLC
between RUN mode and STOP mode. Like the other S7 controllers, WinLC also provides a RUN-P
option that allows STEP 7 to interact with the controller in RUN mode. By clicking the appropriate
mode button (or selecting the appropriate command from the CPU menu), you change the operating
mode of the controller either to RUN mode (choosing either the RUN or RUN-P options) or to STOP
mode.

The mode buttons correspond to the keyswitch positions of an S7 hardware controller:

e RUN-P: The controller executes the control program. You can use STEP 7 to interact with
the control program and to change the operating mode of the controller.

¢ RUN: The controller executes the control program. You can use STEP 7 to monitor the
control program, but you cannot use STEP 7 to change the variables, reset the memory
(MRES), or change the operating mode of the controller.

e STOP: The controller does not execute the control program. Outputs are set to their safe
states. You can use STEP 7 to modify the control program and to reset the memory
(MRES), but you cannot use STEP 7 to change the operating mode of the controller.

Relating the Mode Buttons and Status Indicators to the Operating Mode of the
Controller

The mode buttons on the control panel function like the manual keyswitch on a hardware S7 controller.

For a hardware controller: The keyswitch
does not change position if you use STEP 7
to change the operating mode, or if the
controller automatically changes mode (for
example, encounters an error condition that

Physical kewswitch on an S7 controller causes the controller to change from RUN
selects: mode to STOP mode).

+ BUMN rmode (BUM or BUN-FY

+ STOP mode

For WinLC: The mode buttons (RUN-P,
RUN, STOP) do not change if you use
STEP 7 to change the operating mode, or if
the controller automatically changes mode.

Mode sweitch on panel selects:
+« BUM rode FUM or BUN-F
« STOP mode

For both a hardware controller and WinLC, the RUN and STOP status indicators show the current
operating mode of the controller. If the status indicator shows a different operating mode than the selected
mode button, the controller has changed operating mode, possibly due to some error in the program or
because you used STEP 7 to change the operating mode.
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Using the Mode Buttons to Control Access to the Controller

You can use the mode button to allow or to prohibit access to the controller. As shown in the following
table, the setting of the mode button limits the type of actions that can be performed.

Mode Button Description

RUN-P Allowed:
e Uploading a program from the controller to your computer
e Downloading a program to the controller
e Downloading individual blocks to the controller

e Using STEP 7 to modify program variables and to change the operating
mode of the controller

e Performing a memory reset from either WinLC or STEP 7

The controller automatically goes to STOP mode when you reset the
memory from WinLC. To perform a memory reset from STEP 7, you must
first change the controller to STOP mode.

Not Allowed:

e Archiving and restoring a control program

RUN Allowed:
e Uploading a program from the controller to your computer

e Using STEP 7 programming software to monitor but not to modify
variables

e Using STEP 7 to change the operating mode
e Performing a memory reset from WinLC

The controller automatically goes to STOP mode when you reset the
memory from WinLC.

Not Allowed:
¢ Downloading a control program or individual blocks to the controller
e Using STEP 7 to modify variables in the program
e Archiving and restoring a control program

e Performing a memory reset from STEP 7

STOP Allowed:

o Uploading a program from the controller to your computer or
programming device

e Downloading a program or individual blocks to the controller
e Performing a memory reset from either WinLC or STEP 7
e Archiving and restoring a control program
Not Allowed:
e Using STEP 7 to change the operating mode
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Resetting the Memory Areas: MRES Command (CPU Menu)

The MRES (memory reset) command functions like a master reset of the controller by resetting the
controller to its initial (default) state. The MRES command deletes the control program and the
system data (configuration), and also disconnects any online communications (such as STEP 7,
WinCC, PROFIBUS, or peer-to-peer).

Use one of the following methods to reset the memory:
e Click the MRES button on the control panel
e Select the CPU > MRES menu command
o Press the ALT+C+M keys

You can also use STEP 7 to perform a memory reset. However, you must use the mode buttons to
change the controller to STOP or RUN-P mode before you can reset the memory from STEP 7.

The MRES command changes the controller to STOP mode, if necessary, and then performs the following
tasks:

e Deletes the entire control program from both the work memory area and the load memory area.
This includes OBs, DBs, FCs, FBs, and the system data.

o Resets the memory areas (I, Q, M, T, and C) to 0.

¢ Restores the default system configuration (for example, the size of the process-image areas, and
the size of the diagnostic buffer).

e Deletes all active communications jobs (such as TIS) and all open communications.

The MRES command does not affect the submodule network addresses and does not affect the contents
of the diagnostic buffer.

The STOP indicator flashes while the memory reset is in progress. After the memory has been reset, the
diagnostics buffer is resized to its default size. Input (1) and output (Q) memory areas are also resized to
their default sizes. After a memory reset, you may need to reconfigure these values to your own
specifications.

You typically perform an MRES before downloading a new program to the controller. You must perform an
MRES if the STOP indicator on the control panel is flashing slowly to alert you to one of the following
conditions:

o Errors were detected in the work memory area, such as the size of the user program exceeds the
work memory area

o A power cycle followed a defective state of the controller
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Using the Status Indicators

You can use status indicators on the control panel to determine the current operating mode or to
troubleshoot an error condition. These indicators correspond to the LED indicators on a hardware

S7 PLC.

You cannot change the status of the controller by clicking the status indicators.

If the control program reaches a break point set by the STEP 7 Program Editor, both the RUN and STOP
indicators turn on while the breakpoint is active: the RUN indicator flashes, and the STOP indicator is on.

During a change from STOP mode to RUN mode, the RUN indicator flashes, and the STOP indicator is on.
When the STOP indicator turns off, the outputs are enabled.

The table below describes the different status indicators for the control panel:

Indicator

ON

BATF

INTF

EXTF

BUSF1
BUSF2
BUSF3
BUSF4

RUN
STOP

Description

Power supply. Lights up (solid) when you start the controller. Turns off when you shut
the controller down.

Battery fault. Always off for the controller.

This indicator lights up (solid) to show error conditions within the controller, such as
programming errors, arithmetic errors, timer errors, and counter errors.

If the control program handles the error by executing OB80, OB121, or OB122, the
INTF indicator goes off after 3 seconds if there is no subsequent error condition.

This indicator lights up (solid) to show error conditions that exist outside of the
controller, such as hardware faults, parameter assignment errors, communication
errors, and |/O fault errors.

These indicators light up (flashing) to identify fault conditions in the communication
with the distributed I/O.

The number of the BUSF indicator corresponds to the IF number of the submodule
that has a fault condition.

Lights up (solid) to show the operating mode (RUN or STOP).

When RUN is flashing and STOP is lighted (solid), the control program has reached
a breakpoint. (RUN light blinks with 0.5 Hz.)

Note: The RUN and STOP indicators show the actual operating mode of the
controller. The RUN, RUN-P, and STOP mode buttons show the selected mode
(similar to the keyswitch position on a hardware PLC), which can differ from the
operating mode. For example: Changing the operating mode with STEP 7 causes the
status indicators to change, but the mode buttons do not change.
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Corrective Action If the STOP Indicator is Flashing Slowly

If the STOP indicator flashes slowly, the controller is requesting that you perform a memory reset (MRES).
To recover from this condition, you must use the MRES command to reset the controller.

Corrective Action If All Status Indicators Are Flashing

If all of the status indicators are flashing at the same time, the controller is in a defective state and has
encountered an error condition that cannot be fixed by resetting the memory with the MRES command. To
recover from this condition, you must perform the following tasks:

1.

2.
3.
4

Shut down the controller.
Restart the controller. The STOP indicator flashes with the RUN indicator off.
Use the MRES command to reset the memory.

Use STEP 7 to download the control program and system configuration, or to restore an archived
control program.

If either shutting down or restarting the controller does not resolve the problem, you may need to reboot
your computer.
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Using the Tuning Panel

You can use the tuning panel to view and adjust the current performance of the controller. The
tuning panel displays information about the scan cycle, such as the execution time and the sleep
time. By adjusting these values, you can tune the performance of the controller.

Note: The tuning panel is designed for adjusting the parameters and verifying the
performance for WinLC. Because the tuning panel causes an additional load on the computer
resources, do not leave the tuning panel open during normal operation of WinLC.

To open or close the tuning panel, select the CPU > Tuning Panel menu command. WinLC opens the
tuning panel, as shown below. Click a region on the tuning panel picture for more information about its

functionality.

Mlin Cycle Time

— Cucle Time [ma] — Timing [m=] —CPU Uszage
1003 Execution Time: 100
Last: 0
Aug: 0
Min: 0
Mlax: 0
Sleep Time: 0
% Last: 0 WinLC FC CPUs
1] 20 40 E
I'_ — P[iD[it-lrl
0 EQ00 f Current: 25
Mlin: 0 Mlax: 0 ) Mew: 25
Last: 0 I A
Aurg: 0 ﬂl - Mormal + Siet
— Timing Adjustrment
Execution Time + Sleep Time . . —
| kin Sleep Time [msl | 10 Set
I I kin Cycle Time [me]: ] B estore

— 0B E=ecution kaonitar

St I Default I

Execution Time Linnit [us]l 9000

Max. Execution Load [Z]:I a0

Forced Execution Sleep Time [us]l 1000

Forced Execution Sleep Enunterl i

Values other than the minimum cycle time are unique to WinLC and are not stored in the system
configuration. Using the tuning panel to enter a value for minimum cycle time does not change the

configuration of the controller.

Changing the controller from STOP mode to RUN mode resets the minimum scan cycle time parameter to
the value that you configured in STEP 7. To make any changes made with the tuning panel permanent, you
must use the STEP 7 Hardware Configuration tool.
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The tuning
Area

Cycle Time

Timing

CPU
Usage

Priority

Timing
Adjustment
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Warning

Variation in the execution time or response time of the control program could potentially
create a situation where the equipment or application being controlled can operate
erratically and possibly cause damage to equipment or injury to personnel.

If the controller does not provide sufficient sleep time for the other applications to run,
the computer can become unresponsive to operator input, or the controller and other
applications can operate erratically. In addition, the execution of the control program can
experience non-deterministic behavior (jitter) such that execution times can vary and
start events can be delayed.

Always provide an external emergency stop circuit. In addition, always tune the sleep
time and manage the performance of the controller so that your control program
executes consistently.

panel contains the following functional areas:
Description

This area provides a histogram of execution times of the scan cycle over a 60-ms
range. This histogram tracks minimum (shortest) and maximum (longest) scan times,
as well as the percentage of scans that fall in various ranges of scan times. To delete
the historical data and start a new histogram, click Clear. A STOP-to-RUN transition
also resets the Cycle Time display, as does closing and reopening the tuning panel.

This read-only field displays the following information about the scan cycle:

Execution Time displays the execution time for the last (most current) scan, the
average scan cycle time, the shortest (minimum) scan cycle time, and the longest
(maximum) scan cycle time.

Sleep Time displays the amount of sleep time for the last (most current) scan.

These read-only bar graphs show the percentage of the CPU used by WinLC and by
the computer (PC). For a dual-processor system, there is a bar graph for each CPU.

Use this slider to set the priority level for the execution of WinLC relative to other
applications running on your computer.

Setting the priority higher means that the operating system responds to WinLC
before executing lower-priority tasks. This results in less jitter in the start times and
execution time of the OBs in your program.

Use these fields to tune the scan cycle by entering values for the minimum sleep time
and the minimum cycle time. These parameters determine the amount of sleep time
that is added at the end of the free cycle.

Click the Set button to apply these values. Click the Restore button to reset the
values to those currently being used by the controller. After you apply new values,
the panel stores these values for the controller and you can monitor the effect on the
execution of your control program.

To ensure that the minimum cycle time controls the sleep time for the controller, you
must configure the scan cycle monitoring time and minimum scan cycle time
parameters on the Cycle/Clock Memory tab of the Properties dialog box in STEP 7.
Set the minimum scan cycle time to a value less than the value for scan cycle
monitoring time. (The default scan cycle time is 6 seconds.)
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Using the Diagnostic Buffer
Select the CPU > Diagnostic Buffer menu command to display the SIMATIC Diagnostic Buffer.

The Diagnostic Buffer

allows you to view Mo | Time | Date | Ewvent IA
system diagnostic 1 101022295 am 08/29/02  Mew startup information in STOP mode —
information without using| | 2 10:10:22:231 am  08/23/02  STOP caused by stop switch being activated
the SIMATIC STEP 7 ﬁ :Ilg:ll 31 E;gi & ggggigg I;?u:ude tr?r;mtlnn fru:urr ST.ﬁ.HTI_tIF'ttD RUM

: 10:16: 784 am equest far manual warm restar
zﬁggms'?sgff;wféﬁer 5 1010:16769am  08/29/02  Mode ransition from STOP to STARTUP

X B 10101676 am 08/29/02  Mew startup information in STOP mode

panel thatdisplaysan | |3 4012741 am  08/29/02  New startup information in 5TOP mads
eventlist, alowerpanel | |5 01012737 am  08/29/02  STOP caused by stop switch being activated
that displays specific 9 101005944 am  08/29/02  Mode tansition from STARTUP to RUN
event details, and 10 1070055944 am  08/29/02  Fequest for manual warm restart
controls for using the 11 101005923 am  08/29/02  Mode transition from STOP to STARTUP ;I

Diagnostic Buffer. Details on Event: 3 of 120 Event ID: [xd302

The diagnostic bufferis | e e TARTUP to RUN -
implemented as a ring Startup information:

bIUffer that Contailns - Time for time stamp at the last backed up power on
single event entries. The| |- Single processor operation
events are displayed in | |Current/last startup type:

descending order by - Warm restart tiggered by switch zetting; last power on backed up
time. with the most Permizsibility of certain startup types:
’ - b anwal warm restart permitted
recent event at the top. If |

the ring buffer is full, a - .
new event overwrites the Forma: Text Hex Help on Event

oldest entry in the buffer.

Ilpdate Save Help

The Diagnostic Buffer
displays the following
information:

Event List (upper panel): A list of all the events in the diagnostic buffer. The following information is shown
for each diagnostic event:

e The number of the entry
e The date and time of the diagnostic event
e A brief description of the event
Event ID (between the upper and the lower panels): Displays the ID number of a selected event.
Event Details (lower panel): Displays the event details in either text or hexadecimal format.
If you have chosen Text format, the following details about a selected event appear in the lower panel:
e A brief description

e Additional information, depending on the event, such as the address of the instruction that caused
the diagnostic event and the mode transition that was caused by the event

e The event state (incoming or outgoing)

If a single parameter of text cannot be identified, the diagnostic buffer displays the string "###". If no text
exists for new modules or new events, the event numbers and the single parameters are displayed as
hexadecimal values.

If you have chosen Hexadecimal format, the hexadecimal values of the selected event appear in the lower
panel.
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Sorting Events (upper panel)
You can sort the events listed in the upper panel by clicking the specific column:
¢ Number (determined by time and date)

o Event description

Choosing Format (lower panel)

You can display the diagnostic information in the lower panel in text or hexadecimal (Hex) format. In Hex
format, the hexadecimal values of the 20 bytes of the selected event are displayed. To select the format:

e Click Text to display the event details in text format.

¢ Click Hex to display the hexadecimal values of the event.

Saving the Diagnostic Buffer
To save a text file containing the event list and the detailed information for every event, click the Save
button. The text file contains the information either in text or in hexadecimal format.
Displaying Help
To display help on the diagnostic buffer, click the Help button. To display help on a specific event:
e Select the event in the upper panel.

e Click the Help on Event button.
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Archiving and Restoring Control Programs

You can save the configuration and control program to an archive file (*.wld). You can use this
archive file like the removable memory cartridge of a hardware PLC. The archive file allows you to
easily restore the configuration and control program for the controller.

Note: A project or program from a release of WinLC V3 or earlier must be updated to a
WinLC V4 project. Use STEP 7 to create a new project and to create a new configuration
for the WinLC V4 controller and any submodules.

You can only archive or restore a control program when the controller is in STOP mode. You cannot
archive or restore a control program when the controller is in RUN mode or is shut down.

Saving the configuration of the controller and the control program to an archive file makes it easy to restore
the controller after a memory reset. However, the archive file does not function like the EEPROM cartridge
of the hardware PLC in that the controller does not automatically restore the archive file after a memory
reset (MRES). You must manually restore the archive file.

Creating an Archive File

An Archive file stores the current control program, the current system configuration, and the current values
of the DBs. The Archive file does not store the configuration of the PC station.

To create an Archive file, select the File > Archive menu command. This command displays the Archive
Active File dialog, which allows you to give a name to the file. The controller then creates the archive file
with the extension .wld.

You can also use the SIMATIC Manager of STEP 7 to create an Archive file. Select the File > Memory
Card File > New menu command.
Restoring an Archive File

When you restore an archive file, you reload the configuration and the control program for the controller.
You can only restore archive files of extension .wid.

Before you can restore an archive file, you must set the controller to STOP mode. Use the following
procedure to load an archived configuration and control program:

1. Click the STOP button to place the controller in STOP mode.
2. Select the File > Restore menu command.

3. Select the specific archive file to restore and click OK.
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Storing Retentive Data

Storing Information About the Controller

WinLC stores the following operational information in the active file on your hard disk:

o Load memory stores the system data (configuration of the controller) and the initial values
of the blocks of the control program.

¢ WinLC stores the state of the controller, which includes the last transition of the operating
mode (STOP, RUN, or STARTUP) for the controller and the setting for the mode button
(STOP, RUN, or RUN-P).

e As part of the shutdown process, WinLC creates the power-down state of the controller. The
power-down state includes the contents of the diagnostic buffer, the current values for the
retentive memory areas of the controller (such as timers, counters and bit memory), and the
current values for the data blocks (Work memory).

WinLC updates these areas during operation and uses this information when starting up the
controller.

Load Memory

When you download the control program from STEP 7, WinLC saves the blocks of the control program
(program blocks and system data) in the Load memory area. These blocks include the initial values for the
process variables used by the control program.

SFC82 (CREA_DBL) allows you to create new blocks in Load memory during the execution of the control
program. You can use SFC84 (WRIT_DBL) to modify these blocks. The blocks created by these SFC82
are stored in the Load memory at the time that SFC82 runs.

Note: Data blocks (DBs) created by SFC22 (CREAT_DB) and SFC85 (CREA_DB) are not saved in
the Load memory These DBs are stored only in the Work memory.
Retentive Data

When you configure WinLC in STEP 7, you can determine the ranges of retentive data for the timers
(T memory), counters (C memory), bit memory (M memory), and data blocks (DBs).

WinLC saves the retentive memory areas as part of the power-down state. If the power-down state was
saved and the controller performs a warm restart (OB100), WinLC restores the retentive memory areas,
including the values of the DBs stored in Work memory.

State of the Controller

WinLC stores the current operational status of the controller and updates the status on the following
events:

¢ Whenever the controller changes operating mode (RUN to STOP, STOP to STARTUP, or
STARTUP to RUN), WinLC updates the state of the controller to show the latest transition.

o Whenever the mode button on the control panel changes (STOP, RUN or RUN-P), WinLC updates
the state of the mode button to show the latest action.
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Power-Down State

Under normal circumstances, WinLC saves the current state of the controller and the retentive data,
including the DBs from Work memory, when you shut down the controller. (The shutdown process can be
initiated by the CPU > Shut Down Controller menu command or by shutting down the Windows operating
system, either by user action or by UPS signal.) WinLC stores the following information from the Work
memory:

e Values for the retentive data in the S7 memory areas (such as T, C, M, and DB)
e Diagnostic buffer

Note: The power-down state (which includes the diagnostic buffer) is not saved in cases when
WinLC terminates abnormally, such as when the computer loses power (either by turning off the
power or by power failure), or when WinLC is not able to write to the hard disk, such as following a
Windows crash ("Blue Screen").

The power-down state is saved at the time WinLC shuts down. After WinLC starts up, the power-down
state is loaded into WinLC and then is deleted (to avoid problems in case of an abnormal termination of the
controller).

Shutting Down the Controller Saves the Retentive Data

The following table shows the actions that cause WinLC to save the retentive data.
Retentive Data Action That Causes WinLC to Save This Data

Load memory (blocks and initial values of Downloading the control program from STEP 7
the control program, DBs, and system data)

State of the controller Changing the operating mode (RUN to STOP, or
STOP to RUN), either from STEP 7 or from the
control panel

Successfully shutting down WinLC
Power-down state Successfully shutting down WinLC
Work memory Successfully shutting down WinLC
Retentive memory areas (T, C, M, and DBs)  Successfully shutting down WinLC

Diagnostics buffer Successfully shutting down WinLC
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Restoring Memory Areas on Start Up

When starting the controller, WinLC searches the active file for the power-down state to determine
whether the controller had been shut down correctly and performs the following tasks:

If WinLC cannot read some element of the Load memory, state of the controller, or the power-down
state), WinLC starts an unconfigured (empty) controller.

WiInLC restores the downloaded blocks of the control program from the Load memory.

If WinLC finds the power-down state (showing that the controller had been shut down
properly and successfully), WinLC updates the Work memory from the power-down state
and loads the current values (at the time that the controller was shut down) for the retentive
data.

If WinLC does not find the power-down state (showing that the controller had not been shut
down correctly), WinLC restores the Work memory to its initial state from Load memory (as
downloaded from STEP 7).

WinLC restores state of the controller, based on the saved operating mode and the
Autostart configuration, and resets the mode button setting on the control panel.

Restoring Memory Following a Successful Shutdown of the Controller

If the power-down status was successfully saved when shutting down the controller, WinLC restores the
operational data for the controller:

WiInLC uses the data stored in the power-down state to restore the controller. This includes the
retentive S7 memory areas, the current values of the process blocks (Work memory), and the
contents of the diagnostic buffer.

Note: If you configured the controller for a cold restart (OB102), WinLC resets the process
variables and S7 memory areas to the initial values from the Load memory.

Based on the Autostart settings, WinLC restores the state of the controller to either STOP mode or
RUN mode.

Note: If the controller was configured for Autostart, WinLC generates a startup event that

identifies the type of startup: buffered or unbuffered. (An unbuffered startup is like reloading
the control program from an EPROM file.) You can program OB100 to read this start event.
For an unbuffered startup, the variable OB100_STOP at address LW6 is set to W#16#43009.

WinLC restores the mode button to the setting when the state of the controller was last saved.

After restoring and starting the controller, WinLC deletes the Power-Down Status from the retentive
memory area.
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Restoring Memory if the Controller Was Not Shut Down Properly
If the controller was not shut down properly, WinLC does not create the power-down state.

Note: If the power-down state was not created, the diagnostic buffer is not saved. When you restart
the controller, the diagnostic buffer will be empty.

If the power-down state was not saved when shutting down the controller, WinLC performs the following
tasks when restarting the controller:

e WinLC reads the Load memory and restores the system configuration, the process variables and
S7 memory areas to the initial values configured in STEP 7.

o WinLC reads the state of the controller and performs an unbuffered startup. (An unbuffered startup
is like reloading the control program from an EPROM file. WinLC generates a startup event that
you can program the OB100 to read.) Based on the Autostart settings, WinLC sets the controller to
either STOP mode or RUN mode.

¢ WinLC restores the mode button to the setting when the controller was shut down.

Encountering Problems When Starting the Controller

If WinLC cannot read (or encounters an error) some element of the retentive memory area (Load memory,
state of the controller, or power-down state), WinLC starts with an unconfigured (empty) controller. In this
case, the controller is set to STOP mode with the mode button set to STOP, and the system data and
control program are deleted.

Possible causes for this problem include a hardware error in your computer, or a partial block in the Load
memory area caused by an error that occurred when WinLC was writing a block to the Load memory.

To recover from this condition, you must reload your control program and system data from STEP 7.

Note: The mode button of the controller is set to STOP mode. You can download the control
program and system data from a remote computer, but you cannot use the remote computer to set
the controller to RUN mode. You must go to the local computer for WinLC and set the mode button
to RUN or RUN-P in order to place the controller in RUN mode.

43



Controller Operations

Using SFCs to Retain Data

You can use SFC82 (CREA _DBL), SFC83 (READ_DBL), and SFC84 (WRIT_DBL) to save data at
significant events in your process. For example, you may want to store the recipe values into Load
memory when changing a recipe without downloading new blocks for the control program.

SFC82 and SFC84 modify the data for the control program that is stored in the Load memory.
Saving the blocks to Load memory (instead of keeping the values in Work memory) ensures that
these blocks are available even if WinLC cannot save the power-down state when shutting down the
controller.

SFC82 (CREA_DBL), SFC83 (READ_DBL), and SFC84 (WRIT_DBL) create and update blocks that are
stored as part of your control program in Load memory. The blocks are created or modified in Load
memory when your control program executes these SFCs.

SFC82, SFC83, and SFC84 are asynchronous SFCs that run in the background.

Note: If you call SFC82, SFC83, or SFC84 from the startup OB (OB100 or OB102), WinLC executes
these SFCs synchronously. This differs from the operation of a hardware PLC.

Like the other asynchronous SFCs, SFC82, SFC83, and SFC84 are typically long-running SFCs that can
require a relatively long time to complete. (The time for the SFC call itself will be short, but the actual
operation for the SFC will be executing in the background.) In order to use asynchronous SFCs, you must
allow sufficient sleep time to allow WinLC to process the SFCs without encountering jitter.

Note: Do not use a polling loop that looks for the completion of an asynchronous SFC, especially for
SFC82, SFC83, or SFC84. Because the asynchronous SFC is being executed in the background,
having your control program loop until the SFC finishes will extend the execution of the OB that is
performing the polling loop and can cause jitter.

Caution

Whenever your control program calls SFC82, SFC83, or SFC84, the SFC reads or writes
data to the disk. If you call these SFCs every scan (such as from OB1) or from a cyclical
OB that is executing rapidly, the constant reading or writing to the disk can cause the disk
to fail or can add jitter.

You should only call SFC82, SFC83, or SFC84 to record a significant process event,
such as a change of recipe.

Uninterruptible Power Supply (UPS)

You can use a UPS system to provide emergency power for your computer. The UPS system can
help ensure that WinLC shuts down correctly and saves the power-down state in case of a power
failure.

Refer to the manufacturer's documentation for your computer and your UPS system.

Microsoft Windows provides a dialog for configuring the UPS for your computer:
1. Select the Start > Settings > Control Panel menu command to display the control panel.
2. Double-click the Power Options icon to display the Power Options Properties dialog.
3. Click the UPS tab and configure the parameters for your UPS system.
4. Click Apply or OK to set the UPS properties.
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Customizing and Security Options

Customizing Options

To open the Customize dialog box, select the CPU > Options > Customize menu command. The tabs of
the dialog box allow you to customize the control panel as follows:

General

Select Always On Top to display the control panel on top of all other open windows.

Language
The language field displays the current display language for the control panel.

The language select list displays the installed languages for the control panel. Click a language selection to
change the control panel display language.

Note: To install the languages that are available for the control panel, run the setup program and
select the languages from the dialog.
AutoStart

Select Autostart CPU to set the autostart feature. The autostart feature allows the controller to start
automatically in RUN mode under the conditions described in Selecting the Autostart Feature.

Selecting the Language
You can change the display language for the control panel menus and online help.
To change the display language, follow these steps:
1. Select the CPU > Options > Customize menu command to display the Customize dialog.
2. In the Customize dialog, select the Language tab.
3. Select the language for the control panel.
4. Click Apply to change the language.
5. Click OK to close the Customize dialog.

The control panel automatically changes to the selected language.

Selecting the Autostart Feature

The panel provides an Autostart feature that restarts the controller in the same operating mode as
when previously shut down. With the Autostart feature enabled:

e |f the controller was in RUN mode when shut down, the controller restarts in RUN mode.
e |f the controller was in STOP mode when shut down, the controller restarts in STOP mode.

If the Autostart feature is not enabled, the controller always starts in STOP mode.

Use the following procedure to enable the Autostart feature:
1. Select the CPU > Options > Customize menu command to display the Customize dialog.
2. In the Customize dialog, select the Autostart tab.
3. Select the Autostart CPU option for the Startup Mode.
4. Click Apply to enable the Autostart feature and click OK to close the Customize dialog.
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Setting the Security Options

Select the CPU > Options > Security menu command to change security options. The control panel
displays the Access Verification dialog. You must enter your password in this dialog in order to make any
changes to the security settings for the controller.

Note: The default password is an empty field containing no characters. To enter the default
password, press the Enter key.

Security Level

The Security dialog allows you to set levels of password security that limit access to the controller. The
following security access options are provided:

o Password: When you select Password, certain control panel operations, such as changing the
operating mode, archiving and restoring a control program, and opening the tuning panel, require
that the user enter a password.

e Confirmation: When you select Confirmation, operating mode changes require that the user
acknowledge a confirmation dialog box.

o None: When you select None, no confirmation or password is required.

Password Prompt Interval

You can set the Password Prompt Interval to a time interval of your choice, from 0 to a maximum of 23
hours, 59 minutes. After you have entered your password, you are not prompted for it again until this time
interval has expired. The default setting of 0 means that you must enter a password for each protected
operation.

Shutting down and starting the controller does not affect the expiration of the Password Prompt Interval;
however, it is reset whenever you shut down the control panel. The next time you start the control panel
and access a password-protected function, you will be prompted for password entry.

Change Password
Click the Change Password button to display the Change Password dialog.

Note: If you create a password, but set the security level to None (disabling the password), you still
need to enter the configured password in the Access Verification dialog before you can access the
Security dialog box again.

Warning

Running the controller without confirmation or password protection increases the risk
that an operator may change the controller mode inadvertently, which could cause the
process or equipment to operate unpredictably, resulting in potential damage to
equipment and/or death or serious injury to personnel.

Exercise caution to ensure that you do not inadvertently change the operating mode, or
permit unauthorized persons to access the machine or process. Always install a physical
emergency stop circuit for your machine or process.

46



Controller Operations

Changing the Password
The Change Password dialog allows you to change the current password.

Note: The default password is an empty field containing no characters. To enter the default
password, press the Enter key.

Use the following procedure to change the password:
1. In the Old Password field, enter the old password.
2. In the New Password field, enter the new password (maximum length 12 characters).
3. Inthe Confirm New Password field, enter the new password again.
4. Click OK to apply all the changes made in this dialog, or click Cancel to reject all changes.

To subsequently access the security options, you must enter the password at the Access Verification
dialog.
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Startup Options for the Controller

Starting the Controller at PC Boot

By default, you must start the controller manually after the computer reboots. You can, however, register
the controller to start automatically after a reboot.

Note: To configure the controller for starting in the same operating mode (STOP or RUN) as when
previously shut down, use the Autostart feature.
Registering the Controller for Start at PC Boot
To register the controller to start automatically, follow these steps:
1. Shut down the controller.
2. Select the CPU > Register Controller for Start at PC Boot menu command.

WinLC will now start automatically whenever you start your computer.

Unregistering the Controller for Start at PC Boot
To unregister the controller for starting automatically, follow these steps:
1. Shut down the controller.
2. Select the CPU > Unregister Controller for Start at PC Boot menu command.

WinLC will now not start automatically whenever you start your computer. To start WinLC, you must
manually start the controller.
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Setting the Restart Method

The restart method determines which startup OB is executed whenever the controller changes from
STOP mode to RUN mode. The startup OB allows you to initialize your control program and
variables. WinLC supports two restart methods:

e Warm restart: The controller executes OB100 before starting the free cycle (OB1). A warm
restart resets the peripheral inputs (P1) and changes the peripheral outputs (PQ) to a pre-
defined safe state (default is 0). The warm restart also saves the current value for the
retentive memory areas for the memory bits (M), timers (T), counters (C), and data blocks
(DBs).

e Cold restart: The controller executes OB102 before starting the free cycle (OB1). Like a
warm restart, a cold restart resets the peripheral inputs (Pl) and changes the peripheral
outputs (PQ) to a pre-defined safe state (default is 0). However, a cold restart does not
save the retentive memory (M, T, C, or DB), but sets these areas to their default (initial)
values.

You use STEP 7 to configure the default restart method for the controller. The default restart
method is stored in the configuration (system data) for the controller that you download with your
control program. WinLC uses this restart method when WinLC is configured for Autostart and
returns to RUN mode following a power cycle.

Whenever you click (using the left mouse button) the RUN or RUN-P mode button on the panel to change
from STOP mode to RUN mode, WinLC performs a warm restart, executing OB100.

To select a specific restart method, choose one of the following options for changing WinLC from STOP
mode to RUN mode:

e Select either the CPU > RUN or CPU > RUN-P menu command to change the controller from
STOP to RUN mode.

¢ Right-click (using the right mouse button) the RUN or RUN-P mode button.

Both of these actions display the Restart Method dialog that allows you to select either a warm or cold
restart.

Note: If you have configured the confirmation security option, you must acknowledge a confirmation
dialog before the control panel displays the Restart Method dialog.

If you have configured the password security option and the password prompt interval is either 0 or
has expired, the control panel displays the Access Verification dialog for you to enter the password.
After verifying successful password entry, the control panel displays the Restart Method dialog.

After executing OB100 (warm restart) or OB102 (cold restart) according to your selection, WinLC executes
the free cycle (OB1).
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Using STEP 7 with the Controller

STEP 7 provides programming and configuration tools for working with WinLC. You define the WinLC
configuration through the Hardware Configuration tool of STEP 7, as well as in the Station Configuration
Editor. You can develop a control program using any of the STEP 7 control programming languages, and
download it to WinLC once you have established a connection. You also use STEP 7 to configure
operational parameters and I/O addresses for the controller.

Accessing WIinLC from STEP 7
To access WinLC from the STEP 7 programming software, follow these steps:
1. Using the SIMATIC Manager, open the project for WinLC.
2. Select the View > Online menu command to change to the "Standard Hierarchy, Online" view.

STEP 7 establishes an online connection to WinLC.
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Configuring the Operational Parameters

Configuring the Operational Parameters for WinLC

STEP 7 provides a Hardware Configuration tool for configuring the operational characteristics for WinLC.
This configuration is then stored in various SDBs in the System Data container.

After you download the System Data, WinLC uses the configured parameters for the following events:
o Whenever you start the controller

e On the transition to RUN mode (if you modified the hardware configuration online while WinLC was
in STOP mode)

You use the Properties dialog to configure the operational parameters.

Properties - WinLC - (RO;/S2) x|
Interupts I Time-of-Day Interupts I Cychc |nterupts I Diagnostice/Clock, I
General I Startup I Cycle/Clock Memaony I Fietentive Memory I b ernomy

Shart Description: WinLC

inLC 4.1 windows Logic Controller far ‘Windows 2000/5=F; DF ;I
connector [DF mazter]; DY ; routing; 57 Communication; PROFInet;
firrmare 4.1

]

Order Mo,/ firmware BEST B171-4PY00-0vE T /W41

M arne:

Plant degignation: I

Comment:

Cancel | Help |
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Parameter
General

Startup

Cycle/Clock
Memory

Time-of-Day
Interrupt

Interrupts

Retentive
Memory

Cyclic Interrupt

Diagnostics/Clock

Memory

Description
Provides information about WinLC

Defines the operational characteristics of WinLC for powering on or going to
RUN mode

Cycle: defines any constraints on the scan cycle (such as the minimum and
maximum scan cycle time, the size of the process image, and program
requirements relating to I/O access error reporting.)

Clock Memory: defines a memory byte to function as a "clock memory"—each
bit of this byte toggles on and off at a different frequency

Configures the operation of the time-of-day interrupts (OB10)

Defines the priority class for the hardware interrupts (OB40), the time-delay
interrupts (OB20), the DPV1 interrupts (OB55 to OB57), and the asynchronous
error interrupts (OB82, OB83, OB85, and OB86)

Defines the memory areas (M, T, and C) to be retained following a power
failure or a transition from STOP mode to RUN mode

Defines the operation of the cyclic interrupts (OB32 to OB36)

Defines the reporting of diagnostic errors and the synchronization and the
correction factor for the WinLC clock

Defines the amount of local data (L memory) for each priority class and the
maximum number of communication jobs that can be outstanding at one time.

Accessing Operational Parameters

To configure any of these operational parameters in STEP 7, open the SIMATIC Manager and follow these

steps:

1. In the SIMATIC Manager, select the PC station.

Click the Configuration icon.

2
3. Right-click the WinLC icon in the Hardware Configuration rack and select Object Properties.
4

Click the tab with the name of the parameter that you want to configure (such as Cyclic Interrupt)
and enter the appropriate values in the dialog.

5. Click OK to confirm your configuration.
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Configuring the Startup Characteristics

You can use the Startup tab of the STEP 7 Hardware Configuration tool to configure WinLC to perform
certain tasks before going to RUN mode. The following table lists the parameters for configuring the startup
characteristics.

Parameter Description Range Default

Startup when expected / Startup is allowed even if I/O is not Yes/No Yes
actual configuration differ configured properly

Startup after Power On Specifies what type of restart to Warm restart Warm
perform if you have selected the Cold restart restart
Autostart feature

Finished message by Specifies how long WinLC waits for 1 to 650 650

modules configured S7 I/0O modules to (100 ms intervals) (65)
respond with a ready message

Transfer of parameters to Specifies how long WinLC waits for 1 to 650 100

modules transfer of parameters to S7 1/10 (100 ms intervals) (10's)

modules following a ready message

You can also change the restart method from the WinLC panel for a particular change to RUN mode.
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Configuring the Clock Memory

You can use the Cycle/Clock Memory tab of the STEP 7 Hardware Configuration to configure a byte of the

bit memory (M) area to function as a "clock memory." The following table lists the parameters and ranges
for configuring a clock memory.

Parameter Description Range Default
Clock Enables the clock memory (if enabled, you Yes or No No
Memory must enter a memory byte address)

Memory Byte  Defines a memory byte (MB) to functionasa 0 to MB2047 Disabled

clock memory

When this byte has been configured as clock memory,
the bits turn on and off (with a duty cycle of 1:1) at
fixed frequencies. (The eight bits in the byte yield eight S O R R

different, fixed frequencies.) Fraou ency
0.1 sec. (10HZ)

The figure shows the frequencies of the different bits 0.2 sec. (5 HZ)

for the byte used as clock memory. 0.4 sec. (2.5 HZ)
0.5 sec. (2 HZ)

0.8 sec.[1.25 Ha)
1.0 sec. (1 HzZ)

1.6 sec. 0.625 HzZ)
2 s, (0.5 HZ)

Bt ¥ & & 4 3 2 1 10
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Configuring the Scan Cycle

You can use the Cycle/Clock Memory tab in the Hardware Configuration tool of STEP 7 to configure certain
aspects of the scan cycle. The table below lists the parameters for configuring the scan cycle.

Note: The minimum cycle time of WIinLC includes both the time required for executing the control
program and the sleep time (which allows your computer to perform other tasks).

WinLC monitors the execution time of the scan cycle. If the scan cycle (execution time of the control
program plus the sleep time) exceeds the scan cycle monitoring time (watchdog), WinLC starts an error
OB. The scan cycle monitoring time must be greater than the maximum execution time for the scan cycle
plus the configured sleep time.
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Parameter

Update OB1
process image
cyclically

Scan cycle
monitoring time

Minimum scan
cycle time

Size of process
image input
area

Size of process
image output
area

OB85 Call Up

Description

Indicates whether to update the process images as part of execution of OB1.

Range: Selected / Unselected
Default: Selected

Defines the maximum time for the scan cycle. (The value for the scan cycle
includes both the execution time of the control program and the sleep time of the
controller.)

This value must be larger than the value for the minimum scan cycle time.

The following list gives a few examples of events that could cause the controller
to exceed the limit on maximum cycle time:

e Starting other PC applications

e Processing an increasing number of interrupts in the program

e PC blocked by high-priority drivers or by continuous hardware activities
e Processing an error in the control program

Range: 1 to 6000 ms
Default: 6000 ms

Defines the minimum time for the scan cycle. (This value includes both the
execution time of the control program and the sleep time of the controller.)

The minimum scan time allows you to determine the percentage of processing
time of your computer to dedicate to the controller. For example: if you entered a
minimum scan time that is twice as long as the actual execution time of the user
program, 50% of the processing time would be dedicated to WinLC and 50%
could be used by another application (based on process priority).

Range: 0 to 5999 ms
Default:0 ms

Defines the overall size of the process image input area

Range: 0 to 8192 bytes
Default: 512 bytes

Defines the overall size of the process image output area

Range: 0 to 8192 bytes
Default: 512 bytes

Specifies handling of 1/0 access errors during process image reading or writing.
The choices are:

e Do not call OB85 (Never)

e Call OB85 when module first fails and again when module returns to
normal operation (Coming/Going)

e Call OB85 on every access while the module is failed (Always)

Range: Never, Coming/Going, Always
Default: Always
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Configuring Retentive Memory Areas

You can use the Retentive Memory tab of the STEP 7 Hardware Configuration tool to configure the
following areas of memory to be retained in the event of loss of power or on a transition from STOP mode
to RUN mode:

e Number of Memory bytes: up to 2048 bytes (from MBO to MB2047)
e Number of S7 timers: up to 512 timers (from TO0to T 511)
e Number of S7 counters: up to 512 counters (from C 0 to C 511)

In the event of an abnormal shutdown while the controller is running, the current values for these areas, as
well as the DBs, are lost. Otherwise, the values are retained according to the configured parameters shown
in the table below.

Note: DBs that were created by SFC22 (CREATE_DB) or SFC85 (CREA_DB) are not retained
following a cold restart. All other DBs are retentive following a normal shutdown.

The following table lists the parameters for configuring the retentive memory areas:

Parameter Description Range Default

Memory Bytes Enters the number of memory bytes to be retained 0 to 2048 16
(starting from MBO)

S7 Timers Enters the number of S7 timers to be retained 0to 512 0
(starting from T 0)

S7 Counters Enters the number of S7 counters to be retained 0to 512 8
(starting from C 0)
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Configuring the Time-of-Day Interrupt

WinLC supports one time-of-day interrupt (OB10). To configure OB10, use the Time-of-Day tab in the
Hardware Configuration tool of STEP 7. The following table lists the parameters for the time-of-day
interrupt.

Parameter Description Range Default

Active Determines whether OB10 is automatically Yes/No No
activated following a warm restart

Execution Selects the frequency for executing OB10 None None
Once
Once per minute
Hourly
Daily
Weekly
Monthly
End of the month
Yearly

Start Determines the starting date and time for Any valid time 01.01.94
Date/Time executing OB10 and date 00:00-00

Date: day.month.year

Time: hours:minutes:seconds (24-hour format)
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Configuring the Interrupts

Use the Interrupts tab in the Hardware Configuration tool of STEP 7 to configure the priority class for the
interrupt OBs supported by WinLC. You deselect an OB by configuring it with a priority class of 0. The
following table lists the parameters for the different interrupts:

Parameter Description Range Default
Hardware Defines the priority class Priority class: 2 to 24 Priority Class: 16
Interrupts: and process image Pl partition: None, 1 to Pl partition: None

segment for the hardware 15
Ll interrupt OB
Time-Delay Defines the priority class Priority class: 2 to 24 Priority Class: 3
Interrupt: and process image Pl partition: None, 1 to Pl partition: None
segment for the time-delay 15
Ll interrupt OB
DPV1 Interrupts: Defines the priority class for  Priority class: 2 to 24 Priority Class: 2
OB55, OB56, the DPV1 interrupt OBs
OB57
Asynchronous Defines the priority class for  Priority class: 24 to 26 Priority Class: 25
Error Interrupts: the asynchronous error
0B82, OBS3, interrupts

0B85, and OB86
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Configuring a Cyclic Interrupt

WinLC supports cyclic interrupts OB32 to OB36. You can use the Cyclic Interrupts tab in the Hardware
Configuration tool of STEP 7 to configure a time interval for executing a cyclic interrupt OB. The following
table lists the parameters for the cyclic interrupt. To deselect a cyclic OB, configure the priority class to 0.

Parameter Description Range Default
Priority Determines the priority class of the cyclic Priority class: 0OB32: 9
interrupt 21024 OB33: 10
OB34: 11
OB35: 12
OB36: 13
Execution Determines the time interval (in milliseconds) 0 to 60000 0OB32: 1000
for executing the cyclic interrupt OB33: 500
0OB34: 200
OB35: 100
OB36: 50
Phase Offset  Defines an amount of time (in milliseconds) 0 to 59999 0

that the start of a cyclic interrupt can be
delayed in order to allow another cyclic
interrupt to finish

Process Defines the process image segment to be None, or None
Image updated automatically when the OB runs. 1to 15

Based on the time interval that you configure, WinLC starts the execution of the cyclic interrupt OB at the
appropriate time. The optimum time interval for your application depends on the processing speed of your
computer and the execution time of the cyclic OB. Jitter can cause an occasional overrun in the start event
for a cyclic OB, which might cause WinLC to go to STOP mode. Other factors that affect the execution of
the OB include the following situations:

e The program in the OB takes longer to execute than the interval allows. If the execution of the
program consistently overruns the start event of the cyclic OB, WinLC can go to STOP mode
(unless OB8O is loaded).

e Programs in other priority classes frequently interrupt or take longer to execute, which causes the
controller to not execute the cyclic OB at the scheduled time. If this occasionally causes an
overrun, WinLC starts the cyclic OB as soon as the first OB finishes.

e STEP 7 performs some task or function that causes the controller not to execute the cyclic OB at
the scheduled time.

The sleep time of the WinLC scan cycle does not affect the execution of a cyclic interrupt OB: WinLC
attempts to execute the OB at the appropriate interval regardless of the amount of sleep time that you
configure for the scan. WinLC provides several types of free cycle sleep management for managing sleep
time. If a cyclic interrupt OB runs too frequently or requires too much of the time allotted for the total scan, it
could cause the watchdog timer to time out (calling OB80 or going to STOP mode).
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Configuring the I/O Addresses

Assigning Addresses for the DP 1/O

You use the Hardware Configuration tool of the STEP 7 programming software to specify elements
and addresses for the PROFIBUS-DP configuration. You configure the following addresses for each
DP slave device on the network:

o Node address and diagnostic address for each node of the network
e Logical address range for the data of the I/O modules on each node

You must download the PROFIBUS-DP configuration to WinLC before you attempt to operate the
PROFIBUS network.

Each node of the DP network has a unique node address. The DP master uses this node address to
communicate with its DP slaves. The control program generally does not use the node address to
reference a data for the slave device. Your control program uses the logical address of the 1/0 and the
diagnostic address for the DP slave that you configured in STEP 7.

Like the other S7 controllers, WinLC provides memory areas for accessing the inputs and outputs

Peripheral Input Area (Pl) and Peripheral Output Area (PQ)

When you configure the DP I/O in STEP 7, you assign a range of the Pl or PQ memory for each 1/O
module. You also assign a diagnostic address for the 1/O modules in the PI memory. The amount of the PlI
and PQ memory is determined by your DP I/O configuration, but the maximum amount of peripheral I/O
memory (Pl + PQ) is 16 Kbytes (16384 bytes).

Process-image Input Area () and Process-image Output Area (Q)

When you configure the operational parameters for WinLC in STEP 7, you determine the size of the | and
Q memory areas. You can configure a maximum of 8 Kbytes (8192 bytes) for both | and Q memory (up to
8 Kbytes for | memory, and up to 8 Kbytes for Q memory). As part of the scan cycle, WinLC reads the

Pl memory into the corresponding | memory locations and writes the Q memory to the corresponding

PQ memory locations.
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Control program

Reading the
proGess ifmage:

A 114
O [E100

Feading directy
frarn the O

L FIEEOD
L PIE10D

for SFC14)

Writing to the
process image:

= 01.4
= GE100

Writing directy to
the [A0:

T PQBEOD
T PQEB100

[or SFC14)

Process Image
| rernory

B0 1o [B512
{default)

Carfigurahle
up to [BS191

& mernaky
QB0 to QBS12
(defaut)

Configurahle
up to QES131

Peripheral I/D

Fetipheral Input: Pl mernary
FIED

Ewery scan the contraller
updates | mermory by loading
corespanding bytes of

Pl rnermory

Pl mermary is hased on the
corfiquration of the input
rnodulas and the disghostic
addrasses

FPetipheral Qutput: PO rmemory
FQED

Ewery scah, the cortrollar
writes G memory to the
corespanding bytes of
P& mermaky

P& mermary is based on the
corfigurstion of the output
rriod ule s

Mlazirnumm petpheral 11O mermory

(Pl +PEI: 16354 bytes

Your control program can access the process image (reading from | memory and writing to Q memory).
These values are updated every scan.

You can also access the peripheral I/O directly (reading from Pl memory and writing to PQ memory) by
using the Load (L) and Transfer (T) commands or by using SFC14 (DPRD_DAT) and SFC15
(DPWR_DAT).
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The following table provides an overview of the addresses that can be assigned to the DP 1/0.

Address Areas

Process-image areas
land Q

Total amount for the
distributed 1/0

(accessed by Load and
Transfer instructions)

Accessing consistent data

Maximum Input/Output
data for one node

64

Size

Inputs: 0 to 8192 bytes (configurable)
Addressed as IBO through IBn, where n is the configured input
process image size minus 1.

Outputs: 0 to 8192 bytes (configurable)
Addressed as QB0 through QBm, where m is the configured output
process image size minus 1

16384 bytes

This memory can be any mixture of peripheral inputs (PI) and
peripheral outputs (PQ), based on the configuration of the
distributed I/O (for both digital and analog I/0O). However, the Pl and
PQ areas together cannot exceed the 16384-byte maximum size.

Note: The diagnostic address for a slave device is configured in
the Pl memory.

Addressed as:
Inputs: PIBO to PIBn, where n is the configured input size minus 1.

Outputs: PQBO0 to PQBm, where m is the configured output size
minus 1

Load (L) and Transfer (T) instructions access up to 4 bytes of
consistent data

SFC14 and SFC15 access up to 244 bytes of consistent data

Up to 244 bytes
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Accessing the Data in the DP 1/O Modules

During the configuration of WinLC, you allocate a logical address in the Input (1) or Output (Q) area for the
data of each 1/0 module of the DP network. You use these addresses to access the data for the 1/0
module. WinLC also uses the lowest logical base address for a module for reporting the module events to
the control program.

The following table lists the methods for accessing the distributed I/O:

e To access data as bytes, words, or double words (that is, as 1 byte, 2 bytes, or 4 bytes), use the
Load (L) and Transfer (T) instructions (for statement list) or the Assign Value (MOVE) instruction
(for ladder logic) to read and write the distributed inputs and outputs. You can access the I/O data
either from the process image (l) area or from the peripheral image (PI) area.

e To access data that has consistency of 3 bytes or more than 4 bytes (up to 244 bytes), use SFC14
(DPRD_DAT) and SFC15 (DPWR_DAT). SFC14 and SFC15 always access the peripheral image
of the /0 module. Both SFC14 and SFC15 also allow you to access 1 byte, 2 bytes, and 4 bytes of

data.
Type of Access Method
Accessing data in byte, word (2- Use the following instructions:

byte), or double-word (4-byte) units The Load instruction reads 1, 2, or 4 bytes of inputs

Data integrity is 2 bytes for from the | or Pl area.
accessing words, and 4 bytes for

accessing double words. e The Transfer instruction writes 1, 2, or 4 bytes of

outputs to the Q or PQ area.

Accessing consistent data from a Use the following SFCs:
single /O module in units other than

1 byte, 2 bytes and 4 bytes SFC14 copies all bytes from the inputs of a module

tothe |, Q, M, D or L area.

e SFC15 writes all bytes from the |, Q, M, D, or L
area to the outputs of a module.

As shown in the following figures, your control program can access up to 16384 bytes (each) of inputs and
outputs by using the Load (L) and Transfer (T) instructions (for statement list) or the Assign Value (MOVE)
instruction (for ladder logic).

Note: You may access any byte of the Process Image (I or Q) area, whether the byte is assigned to
physical I/0O or not; however, you may only access addresses actually assigned to physical /O when
accessing the Peripheral Image (Pl or PQ) or when using SFC14 or SFC15.

SFC14 and SFC15 can access blocks of data up to 244 bytes:

e SFC14 copies the complete block of data from the module's inputs to any of the specified memory
areas.

e SFC15 writes the complete block of data from any of the specified memory areas to the module's
outputs.
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Input Address Area

Process-lmage Ihputs ()

Configurakle from
1kyte to $192 bytes

Inputs (P

l:-:-nfigurahle Fram
1hyte o §192 bytes

Diagriostic  addrasses | ——
(1 byte for each DF slawe) — 1

Allocated addresses

Output Address Area

Process-lmeage  Outpauts (50

Cl:lﬂfigl.lﬁhle From
1hyte b 5192 bytes

Distributed 170
I puts
.-'f-
- g
& .-"- .
- bocessible
|~ by Loawd
| instructions
]
o 1
[ - Consistent data | Accessed
e | Uptozddbytes | bw FCH
W
kY T
\\ Consistent data | Accessed
o | Up tozddbytes | by SFC

Distributed 170

Cutp uts

Outputs FE)

l:-:-nfigurahle Fram
1hyte b 5192 bytes

- Consistent data
| - Up to 244 bytes

[ Consistent data

o |Up b Edd Bgtes

Allocated adresses

Cross-Module Access Errors

Unlike hardware PLCs, WinLC does not allow a Load (L) or Transfer (T) instruction to access bytes of more
than one module. Consider a configuration of two output modules, each containing five bytes. Module 1 is
addressed from 10 to 14, and Module 2 is addressed from 15 to 19. OB1 contains the instructions shown

below:

L5
T PAW 14

In this example, OB122 is called because of an attempt to access bytes across a module boundary. A word
instruction at address 14 attempts to access address 14 and 15, which is prevented because the

addresses are not in the same module.
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Additional Information

For information about the Load (L) and Transfer (T) instructions, see the online help for the STEP 7
programming software and the Statement List (STL) for S7-300 and S7-400 Programming Reference
Manual. If you are programming in ladder logic, see the Assign Value instruction (MOVE) in the Ladder
Logic (LAD) for S7-300 and S7-400 Programming Reference Manual.

For information about SFC14 (DPRD_DAT) and SFC15 (DPWR_DAT), see the online help for STEP 7 or
the System Software for S7-300/400 System and Standard Functions Reference Manual. To view this
manual from a computer where STEP 7 is installed, select the Start > Simatic > Documentation >

English menu command and then double-click "STEP 7 - System and Standard Functions for S7-300 and
S7-400".
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Specifying the Diagnostic Addresses for the DP I/O Modules

During the configuration of WinLC, you allocate a diagnostic address in the peripheral input (PI) area for
each node of the DP network. You use the diagnostic address as a parameter for an SFC that accesses
the diagnostic data for a node (for example, the LADDR parameter of SFC13). Additionally, this address is
used by WinLC to report node state changes (in OB86) to the control program.

Note: STEP 7 documentation sometimes refers to the diagnostic address for a node as the logical
base address of the slave or station, as opposed to the logical base address of a module.

As you use the STEP 7 Hardware

Configuration tool to configure WinLC L e Distributed 10
and the PROFIBUS-DP network, these Frocess|mage BYted

. . ; Inputs (71 DPF Slave 2
diagnostic addresses are assigned I

above the process-image input (1)
memory area. See the figure below.

[ DF Slave 1
- It (PO

If you do not enter a specific address,

STEP 7 allocates 1B16383 for the first T T Bye i e Disgnostic addresses

DP slave, PIB16382 for the second, T T T T T By T e £1 biyte for each DF slawe)

and so forth. T E}.lﬁ 16555 [ Diagrostic addrass for OF Master

For more information about configuring the DP diagnostic addresses, see the online help for the STEP 7
programming software.
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STEP 7 Components

Logic Blocks Supported by WinLC

Like the other S7 PLCs, WinLC provides several types of logic blocks for processing the user program:
organization blocks (OBs), system functions (SFCs), and system function blocks (SFBs). These blocks are
an integral part of WinLC.

Organization Block (OB) System Function (SFC) System Function Block
(SFB)

OB1 SFCO0 to SFC6 SFBO to SFB5

OB10 SFC11 to SFC15 SFB8 and SFB9

0B20 SFC17 to SFC24 SFB12 to SFB15

OB32 to OB36 SFC26 to SFC34 SFB22 and SFB23

0OB40 SFC36 to SFC44 SFB32

OB52 to OB57 SFC46 and SFC47 SFB52 to SFB54

OB80, OB82, OB83, SFC49 to SFC52 SFB65001 and SFB65002

OB8S,and OB86 SFC62 and SFC64

OB100 and OB102 SFEC78 to SEC80

OB121 and OB122 SFC82 to SEC84

SFC85 and SFC87

Notes for SFC82, SFC83, and SFC84

In contrast to the S7-300, WinLC supports a synchronous interface for SFC82, SFC83, and SFC84 in
STARTUP. WiInLC allows both the first call (with REQ = 1) and the second call (with REQ = 0) in STARTUP
so the action can be completed in STARTUP.

The normal STEP 7 error codes apply for SFC82, SFC83, and SFC84. In addition, WinLC has a limit of 32
outstanding SFC82, SFC83, and SFCB84 jobs. If this limit is exceeded, these SFCs return error code 80C3.
Additional S7 Blocks

In addition to these system blocks, you can use these other S7 blocks to create the control program:

e Function (FC): WIinLC supports up to 65,536 FCs (FCO to FC65535). Each FC can contain up to
65,570 bytes.

e Function block (FB): WinLC supports up to 65,536 FBs (FBO to FB65535). Each FB can contain up
to 65,570 bytes.

e Data block (DB): WIinLC supports up to 65,535 DBs (DB1 to DB65535). (DBO is reserved.) Each
DB can contain up to 65,534 bytes.

The number and size of FCs, FBs, and DBs are also limited by the amount of available system memory.
For more information about the instruction list supported by WinLC, see the following topics:

Technical data System functions (SFCs) Execution times of DP instructions

Organization blocks (OBs)  System function blocks (SFBs) Execution times of instructions.
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Peer-to-Peer Communication Functions

Like other S7 controllers, WinLC provides peer-to-peer communications between controllers on the
network. The controllers can be either hardware or software logic controllers.

SFB or SFC

SFB8
SFB9

SFB12
SFB13

SFB14
SFB15

SFB22
SFB23

SFC62

70

Name

USEND
URCV

BSEND
BRCV

GET
PUT

STATUS
USTATUS

CONTROL

Description

Exchange data using a send and a receive SFB

Exchange blocks of data of variable length between a send SFB
and a receive SFB

Read data from a remote device
Write data to a remote device

Specific query of the status of a remote device
Receive status messages from a remote devices

Query the status of a connection
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PROFIBUS DPV1

DPV1 extensions to PROFIBUS-DP allow the enhanced communication required by complex slave
devices. This enhanced communication includes acyclic data exchange, alarm and status messaging, and
the transmission of complex data types. WinLC provides support for the following DPV1 functionality:

e DP-Norm, DP-S7, DPV1, and DPV1 S7-compliant slaves

Alarm and status OBs for processing DPV1-defined events, including:
o OB40 (process alarm)
o OB55 (status alarm)
o OB56 (update alarm)
o OB57 (manufacturer-specified alarm)
o OB82 (diagnostic alarm)
o0 OB83 (module pull/plug alarm)
o New data set read and write function blocks:
o SFB52 (RDREC), Read Data Set
o SFB53 (WRREC), Write Data Set
o Execution of SFB54 (RALRM), read alarm data, in the context of the triggering alarm
o Station and interface address
o Buffering of alarms received in DP mode CLEAR

For WinLC to support DPV1, configure the CP card to be a DP Master. To select DP Master, follow these
steps from the SIMATIC Manager:

1. Open the Hardware Configuration for your PC Station.

2. Double-click your CP card in the corresponding submodule slot of your WinLC.
3. Select the Operating Mode tab of the CP card Properties dialog.
4

Select DP Master and set the DP mode to DPV1. (DPV1 is the default setting for the CP 5613
card.)
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Organization Blocks (OBs)

Organization blocks (OBs) are the interface between the operating system of the controller and the control
program. You can use OBs to execute specific components of the user program for the following events:

e When the controller starts and restarts
e Cyclically or at a specific time interval
e At certain times or on certain days
o After running for a specified period of time
e When errors occur
o When a hardware interrupt occurs
The control program in an OB can contain up to 65,570 bytes.

OBs are processed according to the priority assigned to them.

OB Description Priority Class
OB1 Main program cycle 1 (lowest)
0OB10 Time-of-day interrupt 2to 24
0B20 Time-delay interrupt 2to 24
OB32 to OB36 Cyclic interrupt 2to 24
OB40 Hardware (process alarm) interrupt 2to 24
OB52 to OB54 ODK interrupt 15
OB55 Status alarm interrupt 2to24
OB56 Update alarm interrupt 2t0 24
OB57 Manufacturer-specific alarm interrupt 21024
0OB80 Time error 26
0OB82 Diagnostic alarm interrupt 24 to 26 (or 28)*
OB83 Module pull/plug alarm interrupt 24 to 26 (or 28)*
OB85 Priority class error 24 to 26 (or 28)*
OB86 Rack (DP slave) failure 24 to 26 (or 28)*
OB100 Warm restart 27
0OB102 Cold restart 27
OB121 Programming error Priority class of the OB where

the error occurred
OB122 I/O access error

* Priority class 28 during STARTUP, user-configurable priority class (from 24 to 26) in RUN mode.
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OBs for the Main Program Cycle, Cold Restart, and Warm Restart

The following table shows OBs for the main program cycle and cold and warm restarts. WinLC provides
OB1 (main program cycle) for continuously executing the control program. On the transition from STOP
mode to RUN mode, WinLC executes OB100 (warm restart) or OB102 (cold restart), based either on the
hardware configuration for WinLC or which restart option was selected from a dialog displayed by the
WiInLC panel. After OB100 (or OB102) has been successfully executed, WinLC executes OB1.

Organization Block (OB) Start Event (in Hex) Priority Class
Main program cycle OB1 1101, 1103, 1104 1
Warm restart OB100 1381, 1382 27
Cold restart OB102 1385, 1386 27
Interrupt OBs

WinLC provides a variety of OBs that interrupt the execution of OB1. The following table lists the different
interrupt OBs that are supported by WinLC. These interrupts occur according to the type and configuration
of the OB.

The priority class determines whether the controller suspends the execution of the control program (or
other OB) and executes the interrupting OB. You can change the priority class for the interrupt OBs.

Interrupts Start Event (in Hex)  Default Priority Class
Time-of-Day Interrupt OB10 1111 (OB10) 2
Time-Delay Interrupt 0B20 1101 (OB20) 3
Range: 1 ms to 60000 ms
Cyclic Interrupt 0OB32 1133 9
Range: 1 ms to 60000 ms OB33 1134 10
Recommended: > 10 ms OB34 1135 11

OB35 1136 12

OB36 1137 13
Hardware interrupt OB40 1141 (channel1) 16
Status Alarm interrupt OB55 1155 2
Update Alarm interrupt OB56 1156 2
Manufacturer-Specific Alarm OoB57 1157 2
interrupt

If WinLC has been configured to execute a particular interrupt OB, but that OB has not been downloaded,
WinLC reacts in the following manner:

o [fOB10, OB20, OB40, OB55, OB56, or OB57 is missing and OB85 has not been downloaded,
WinLC changes operating mode (from RUN to STOP).

e  WinLC remains in RUN mode if a cyclic interrupt OB (OB32 to OB36) is missing. If these OBs
cannot be executed at the specified time and OB80 has not been downloaded, WinLC changes
from RUN mode to STOP mode.

Note: If you schedule a cyclic interrupt OB (OB32 to OB36) to be executed at a specific interval,
make certain that the program can be executed within the time frame and also that your control
program can process the OB within the allotted time.
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Error OBs

WiInLC provides a variety of error OBs. Some of these error OBs have the configured (the user-assigned)
priority class, while others (OB121 and OB122) inherit the priority class of the block where the error
occurred.

The local variables for OB121 and OB122 contain the following information that can be used by the control
program to respond to the error:

e The type of block (byte 4) and the number (bytes 8 and 9) where the error occurred
e The address within the block (bytes 10 and 11) where the error occurred

If the start event occurs for a particular error OB that has not been downloaded, WinLC changes operating
mode from RUN to STOP.

Error or Fault Start Event (in Hex) Default
Priority Class

Time error OB80 3501, 3502, 3505, 3507 26
Diagnostic Interrupt OB82 3842, 3942 26
Insert/remove module interrupt OB83 3861, 3863, 3864, 3865, 3961 26
Priority class error: 0B85 26
e Start event occurs for an e 35A1
OB that has not been
downloaded. . 39B1, 39B2.
e During the I/O cycle, 39B3/38B3,
WinLC attempts to access 39B4/38B4 (depending
a module or DP slave that on the OB85 Call Up
is defective or not plugged method)
n- . 35A3

e WinLC attempts to access
a block (such as a DB) that
has not been downloaded
or has been deleted.

Rack failure (distributed 1/0): a OB86 38C4, 38C5, 38C7, 38C8, 26 (or 28)
node in the PROFIBUS-DP subnet 39C4, 39C5
has failed or has been restored.

Programming error OB121 2521, 2522, 2523, 2524, 2525, Same priority

(For example: the user program 2526, 2527, 2528, 2529, 2530, class as the

attempts to address a timer that 2531, 2532, 2533, 2534, 2535, OB in which

does not exist.) 253A; 253C, 253E the error
occurred

I/O access error OB122 2942, 2943

(For example: the user program
attempts to access a module that is
defective or is not plugged in.)
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System Functions (SFCs)

WinLC provides SFCs, which are system functions that perform various tasks. The control program calls
the SFC and passes the required parameters; the SFC performs its task and returns the result.

¢ WinLC allows a maximum of 5 instances of the asynchronous system function SFC51 (index B1,
B3) to be running.

e  WinLC allows a maximum of 20 asynchronous SFCs from the following set to be running: SFC11,
SFC13, SFC55, SFC56, SFC57, SFC58, and SFC59.

e WinLC allows a maximum of 32 asynchronous SFCs in any combination from the following set to
be running: SFC82, SFC83, and SFC84.

For more information on these functions, see the online help for STEP 7 or the System Software for S7-
300/400 System and Standard Functions Reference Manual. To view this manual from a computer where
STEP 7 is installed, select the Start > Simatic > Documentation > English menu command and then
double-click "STEP 7 - System and Standard Functions for S7-300 and S7-400".
SFCs That Can Cause the Scan Cycle to Vary
The following SFCs can cause the scan cycle to vary ("jitter"):

e SFC22 (CREAT_DB)

e SFC23 (DEL_DB)

e SFC52 (WR_USMG)

e SFC85 (CREA_DB)

Execution Times

The following table lists the execution times for the SFCs supported by WinLC. Execution times for
asynchronous SFCs refer to the time for the SFC call, not the time for the job to complete.

Note: The execution times were measured on a SINUMERIK PCU50 computer (with a single

1.2 GHz Celeron processor). Tuning settings: 9000 microsecond execution time limit, 90% maximum
execution load, and 1000 ys forced execution sleep. Actual execution times may vary, depending on
your computer.

SFC Name Description Execution Time
SFCO SET_CLK Sets the system clock. 1.55 us
SFC1 READ_CLK Reads the system clock. 1.46 us
SFC2 SET RTM Sets the run-time meter. 0.53 us
SFC3 CTRL_RTM Starts or stops the run-time meter. 0.53 us
SFC4 READ_RTM Reads the run-time meter. 0.43 ys
SFC5 GADR_LGC Queries the logical address of a channel. 1.95 us
SFC6 RD_SINFO Reads the start information of an OB. 1.67 us
SFC11 DPSYNC_FR  Synchronizes groups of DP slaves. 1.12 us
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SFC

SFC12

SFC13

SFC14

SFC15

SFC17

SFC18

SFC19

SFC20

SFC21

SFC22

SFC23

SFC24
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Name
D_ACT DP

DPNRM_DG

DPRD_DAT
DPWR_DAT

ALARM_SQ

ALARM_S

ALARM_SC

BLKMOVB

FILL

CREAT DB

DEL_DB

TEST DB

Description
Deactivates and activates of DP slaves.

Reads the diagnostic data of a DP slave.

DP configuration tested: one ET 200M slave
with one 8-input/8-output module and one 16-
output module

Reads the consistent data from a DP slave.
Writes the consistent data to a DP slave.

Generates an acknowledgeable block-related
message.

Generates an unacknowledgeable block-related
message.

Queries the status for the last message (SFC17
or SFC18).

Copies variables.

Initializes a memory area:
1 word
50 words
100 words

Creates a retentive data block in Work memory.
The current values of the DB are retained after
a warm restart.

Deletes a data block. WinLC allows an
application to delete a non-sequence-relevant
data block.

Provides information about a data block.

For WinLC, SFC24 can return the DB length
and write-protection flags for non-sequence-
relevant data blocks, although it returns error
code 80B2 for non-sequence-relevant data
blocks.

Execution Time

2.20 us

1.71 ps
1.87 ps

4.64 ys

4.61 us

1.23 ys

1.88 us

1.81 ps
2.82 ps
3.83 ps

14.20 ps

4.73 us

0.63 s
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SFC

SFC26

SFC27

SFC28

SFC29

SFC30

SFC31

SFC32

SFC33

SFC34

SFC36

SFC37

SFC38

SFC39

SFC40

SFC41

SFC42

SFC43

SFC44

SFC46

Name

UPDAT_PI

UPDAT_PO
SET_TINT
CAN_TINT
ACT_TINT
QRY_TINT
SRT_DINT
CAN_DINT
QRY_DINT
MSK_FLT
DMSK_FLT
READ_ERR
DIS_IRT
EN_IRT

DIS_AIRT

EN_AIRT

RE_TRIGR

REPL_VAL

STP

Description

Updates the process-image input table.

DP configuration tested: one ET 200M slave
with one 8-input/8-output module and one 16-
output module

Updates the process-image output table.
Sets the time-of-day interrupt (OB10).
Cancels the time-of-day interrupt (OB10).
Activates the time-of-day interrupt (OB10).
Queries the time-of-day interrupt (OB10).
Starts the time-delay interrupt (OB20).
Cancels the time-delay interrupt (OB20).
Queries the time-delay interrupt (OB20).
Masks synchronous errors.

Unmasks synchronous errors.

Reads the error register.

Disables the processing of all new interrupts.
Enables the processing of new interrupts.

Disables the processing of new interrupts with
higher priority than the current OB.

Enables the processing of new interrupts with
higher priority than the current OB.

Retriggers the watchdog timer (monitoring the
cycle time).

Transfers a value to ACCU1 (accumulator 1).

Changes the operating mode to STOP mode.

Execution Time

0.83 s

16.30 us
2.05 us
0.74 ps
0.63 s
0.80 ps
2.26 us
0.82 s
0.80 s
0.72 us
0.72 us
0.71 us
0.70 us
0.71 ps

0.36 us

0.86 us

4.49 s

15.18 us
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SFC

SFC47

SFC49

SFC50

SFC51

SFC52

SFC54

SFC55

SFC56

SFC57

SFC58

SFC59

SFC62

SFC64

SFC78

SFC79

SFC80

SFC82

SFC83

SFC84
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Name

WAIT

LGC_GADR

RD_LGADR
RDSYSST
WR_UMSG
RD_PARM
WR_PARM
WR_DPARM
PARM_MOD
WR_REC
RD_REC
CONTROL
TIME_TCK

OB_RT

SET
RESET
CREA_DBL
READ_DBL

WRIT_DBL

Description

Delays the execution of the control program by
the specified number of microseconds, rounded
up to the nearest millisecond.

Queries the module slot belonging to a logical
address.

Queries all of the logical addresses of a module
Reads all or part of a system status list.

Writes a user element to the diagnostics buffer.
Reads the defined parameter.

Writes the defined parameter.

Writes the default parameter.

Assigns the parameters to a module.

Writes a data record.

Reads a data record.

Checks the status of an SFB instance.

Reads the time from the system clock.

Reports OB run-time information, with
resolution to the nearest millisecond.

Sets a range of outputs.

Resets a range of outputs.

Creates a data block in Load memory.

Copies data data from a block in Load memory.

Writes to a Load Memory block so that the data
is saved immediately.

Load memory blocks that are used to recover
from an abnormal termination can be updated
while the program is running. Use SFC84 only
for larger segments of a database, not for
frequent variable processing.

Execution Time

1.40 ps

3.08 s
7.81 us
4.74 ps
2.02 ys
2.35 us
1.44 ps
1.24 ps
2.66 us

2.61 s

0.42 us

0.86 ps

0.81 us
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SFC

SFC85

SFC87

Name

CREA_DB

C_DIAG

Description Execution Time

Creates a DB that can be either retentive or —
non-retentive, depending on the input
parameter:

e If retentive, the current values of the
DB are retained after a warm restart
(OB100).

¢ |f non-retentive, the current values of
the DB are not retained after a warm
restart (OB100).

Determines the current status of all S7 —
connections.
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System Function Blocks (SFBs)

System Function Blocks are logic blocks (similar to SFCs) that perform basic tasks when called by the
control program. The following table lists the execution times of the SFBs that are supported by WinLC.
You must provide a data block (DB) when you call an SFB.

For more information on these functions, see the online help for STEP 7 or the System Software for S7-
300/400 System and Standard Functions Reference Manual. To view this manual from a computer where
STEP 7 is installed, select the Start > Simatic > Documentation > English menu command and then
double-click "STEP 7 - System and Standard Functions for S7-300 and S7-400".

Note: The execution times were measured on a SINUMERIK PCU50 computer (with a single

1.2 GHz Celeron processor). Tuning settings: 9000 microsecond execution time limit, 90% maximum
execution load, and 1000 ps forced execution sleep. Actual execution times may vary, depending on
your computer.

SFB Name Description Execution Time

SFBO CTuU Provides a count-up counter 0.03 us

SFB1 CTD Provides a count-down counter 0.03 us

SFB2 CTUD Provides a count-up/down counter 0.04 us

SFB3 TP Generates a pulse 0.04 us

SFB4 TON Generates an on-delay timer 0.04 ys

SFB5 TOF Generates an off-delay timer 0.04 us

SFB8 USEND Sends a data packet of CPU-specific length —
(two-way)

SFB9 URCV Receives a data packet of CPU-specific length —
(two-way)

SFB12 BSEND Sends a data block up to 64 Kbytes (two-way) —

SFB13 BRCV Receives a data block up to 64 Kbytes (two- —
way)

SFB14 GET Reads data up to a CPU-specific maximum —

length (one-way)

SFB15 PUT Writes data up to a CPU-specific maximum —
length (one-way)

SFB22 STATUS Query the status of a remote device —

SFB23 USTATUS Receive the status of a remote device —
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SFB Name Description Execution Time
SFB32 DRUM Implements a sequencer 0.15 us
SFB52 RDREC Read data set =
SFB53 WRREC Write data set —
SFB54 RALRM Read alarm data for a DP slave —

SFB65001 CREA_COM  (WinAC ODK) —

SFB65002 EXEC_COM (WinAC ODK) —
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System Clock and Run-Time Meter

Like a hardware S7 controller, WinLC has a "real-time" system clock (based on the hardware clock of your
computer).

Note: Setting the time for WinLC does not affect the time setting for your computer.

To adjust and read the system clock, use the following SFCs. For more information on these functions, see
the online help for STEP 7 or the System Software for S7-300/400 System and Standard Functions
Reference Manual. To view this manual from a computer where STEP 7 is installed, select the Start >
Simatic > Documentation > English menu command and then double-click "STEP 7 - System and
Standard Functions for S7-300 and S7-400".

SFC Name Description

SFCO SET_CLK Allows you to set the time and the date of the system clock. The clock then
runs starting from the set time and set date.

Format: DT#1995-01-15-10:30:30

SFC1 READ_CLK Allows you to read the current date or current time of the system clock of
the controller.

SFC64 TIME_TCK Allows you to read the system time of the controller. The system time is a
"time counter" counting cyclically from 0 to a maximum of 2147483647 ms.
In case of an overflow, the system time is counted again, starting at O.

The time base (and therefore the accuracy) is 1 ms.

The system time is only influenced by the operating modes of the controller.
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Scan Cycle for a PC-Based Controller

During one scan cycle, the controller updates the outputs, reads the inputs, executes the control
program, performs communication tasks, and provides time for other applications to run. The
following parameters affect the scan cycle:

e Execution Time (in milliseconds) is the actual amount of time used by the controller to
update the 1/0 and to execute the control program.

e Scan Cycle Time (in milliseconds) is the number of milliseconds from the start of one cycle
to the start of the next cycle. This value must be greater than the execution time of the scan
to provide execution time for any application that has a lower priority than WinLC.

e Sleep Time (in milliseconds) determines how much time is available during the free cycle
(execution cycle for OB1) to allow higher priority OBs and other applications to use the
resources of the computer.

The Priority for the controller application also affects the scan cycle by determining when the
controller runs or is interrupted by other Windows applications. If the priority for the controller is set
to the Normal priority (priority level 8) or above, you must ensure that the sleep time occurs every
50 milliseconds or less in order for other Windows applications, such as moving the mouse, to
operate smoothly.

The tuning panel allows you to tune and test the performance of the controller by adjusting the parameters
that affect the scan cycle (minimum cycle time, minimum sleep time, and priority) without affecting the
system configuration for the controller. After testing tuning parameters, you use STEP 7 to configure the
minimum scan cycle time for the controller when you create the system (hardware) configuration.

Tasks Performed during the Scan Cycle

After you have used STEP 7 to create and download your control program to the controller, the controller
starts executing the control program when you set the controller to RUN or RUN-P mode. Like any other S7
PLC, the controller executes your control program in a continuously repeated scan cycle.

In one scan, the controller performs the following tasks:

1. The controller writes the status of the OB1-assigned process-image output
table (the Q memory area) to the I/O module outputs. For the first scan, the
controller does not perform this task.

2. The controller reads the states of the I/O module inputs into the OB1-
assigned process-image input table (the | memory area).

3. The controller executes the control program in OB1.

(

4. OB1 waits until the minimum sleep time requirement is met before starting
another scan. Other OBs can execute at this time.
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Because the PC-based controller shares the resources of your computer with other programs (including the
operating system), you must ensure that the controller provides sufficient time for other Windows
applications to be processed. If the actual execution time for the scan cycle is less than the minimum scan
cycle time that you configured with STEP 7, the controller suspends the free cycle (OB1) until the minimum
scan cycle time is reached before starting the next scan. This waiting period, or sleep time, allows other
applications to use the resources of the computer.

The following figure provides an overview of the tasks that are performed by the controller during different
scan cycles.

Startup First Zcan Mew Scan hlew =can
Intertupt O |I| Iz‘ OE40 E OB 40
PrOKLY Class | | | |
Cyclic OF I I | I
printity class : : el |
:E;ﬁ&"cﬁis OE100 |Fead | OB | Sleep | __J::wme Fead | OE Sleep [wWrite Fead | OEA
lue e e
™ Fean Cpcle o Sean Cycle T zean cycle
[1] On a transition from STOP mode to RUN mode, the controller loads the system
Startup configuration, sets the 1/O to the default states, and executes the startup OB (OB100 or
0B102).
The startup cycle is not affected by the minimum cycle time and minimum sleep time or
watchdog parameters; however, it is affected by the execution time limit.
[2] The first scan following the startup OB does not write to the outputs, but starts by
First reading the inputs. An OB with a higher priority class can interrupt the free cycle at any
Scan time, even during the sleep time.
In the example above, the controller handles a hardware (I/0O) interrupt that occurs
during the sleep time by executing OB40. After OB40 has finished, the controller waits
for the minimum cycle time to start the next scan.
Note: It is possible for the controller to use all of the sleep time for processing
higher-priority OBs. In this case, other Windows applications may not have
sufficient time to run. Refer to the techniques for managing sleep time listed
below.
@ The new scan starts by writing to the outputs. In the example above, the controller
New suspends the execution of OB1 to execute a cyclic OB (OB35), which has a higher S7
Scan priority than OB1. The controller also suspends the execution of OB35 to handle

another I/O interrupt (OB40).

After OB40 finishes, the controller resumes the execution of OB35, and after OB35
finishes, the controller resumes the execution of OB1.
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The length of the scan cycle is determined by the execution time of all OBs executed during the scan, the
minimum cycle time, and the minimum sleep time. If the execution time is less than the minimum cycle time
that was configured in the system configuration, the controller suspends the free cycle until the minimum
sleep time is met. During the sleep time, the computer runs any interrupt OBs and other Windows
applications.

Warning

Variation in the execution time or response time of the control program could potentially
create a situation where the equipment or application being controlled can operate
erratically and possibly cause damage to equipment or injury to personnel.

If the controller does not provide sufficient sleep time for the other applications to run,
the computer can become unresponsive to operator input, or the controller and other
applications can operate erratically. In addition, the execution of the control program can
experience non-deterministic behavior (jitter) such that execution times can vary and
start events can be delayed.

Always provide an external emergency stop circuit. In addition, always tune the sleep
time and manage the performance of the controller so that your control program
executes consistently.

Methods for Managing the Performance of WinLC

While executing the control program, WinLC can experience a variation in the process execution time or
response time that causes the scan times to vary or to exhibit non-deterministic behavior ("jitter"). You can
use the following methods to manage the performance of WinLC:

o Adjusting the priority for the controller: Affects when the operating system runs or interrupts the
controller

e Adjusting the minimum sleep time and minimum cycle time parameters: Affects the execution of the
free cycle or OB1 (OB priority class 1)

e Inserting sleep time into the control program (SFC47 “WAIT”): Affects the execution for the priority
class of the OB that calls SFC47 (and any lower priority class)

¢ Adjusting the sleep-monitoring algorithm of the execution monitor: Affects the execution of all OB
priority classes (if the other mechanisms do not meet the requirements for sleep time)

WinLC provides a tuning panel for monitoring the performance and for modifying the parameters that affect
the scan cycle.
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What Causes Jitter?

Because the PC-based controller must share the computer with other running processes, the
execution of the control program can experience "jitter" when a higher-priority or active process
uses the CPU or system resources of the computer. Jitter is a variation in the process execution
time or response time that causes the scan times to vary or to exhibit non-deterministic behavior.

Jitter occurs when there is a delay in either the start or the finish of an OB. For example: the
execution time can deviate by a few milliseconds between scans, or the start of an interrupt OB can
be delayed. For some control applications, such time lapses do not disturb the proper operation of
the controller, but in a highly time-sensitive process, a jitter of even 1 ms can be significant.

The following settings for WinLC can cause jitter in the execution of the control programs:
o Priority settings for different applications
e Priorities among the WinLC threads
e Execution Monitor (that measures the CPU usage)
The tuning panel of WinLC provides several tools for reducing jitter in the control program.
Jitter can also be caused by other sources than WinLC:

e itter can be caused by the design of your control program. For example, different branches
in the logic of the control program might cause the execution time to vary.

o Jitter can be caused by the computer hardware. For example, jitter can be caused by an
operation with a long DMA cycle, such as a video card using the PCI bus. Jitter can also be
caused by a driver, such as for a CD drive or a diskette drive. Hardware-induced jitter
cannot be managed by software.

e Jitter can be caused by an application that was created with the WinAC Open Development
Kit (ODK), such as when a synchronous process takes too long to execute. Refer to the
documentation for WinAC ODK for more information.

Priority Settings for Different Applications Can Cause Jitter

Every application that is running on your computer has one or more threads (or tasks), and each thread

has a priority. The Windows operating system executes the threads with the highest priority first and

executes a lower-priority thread only when all of the higher priority threads are finished or suspended (for
example, to wait for some other activity to complete or to “sleep” for a specified time). Threads with higher

priorities interrupt and suspend the operations of threads with lower priorities. After the higher-priority
thread finishes, the lower-priority thread resumes its operation.

| The higher-priokity thread interripts the execution of the ather applications

ﬂ?g’;ﬁ'pmm Sleep Fun Sleep Fun Sleep Fun Zleep

Marmal- priarity Fun |uspended | Fun [Sleep | Fun |Suspended | Fun | Suspended | Fun
thiread

Lamser-pr vty

tread Eleep Lﬁun | Eleep

[

The lower-priotity thread mins only when all
of the theeads with higher prorties sleep
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Jitter can occur when a process of an application with a higher priority interrupts and suspends the
execution of the controller. As shown in the following figure, jitter typically appears in two forms.

This irterupt delays the This irtertapt increases the
start of the next scan exacution ime of the scan
migegir-pﬁnmy Sleep Fun Zleep Fun Sleep
Thread for the
conitral prograr Fun | Elewp | Run |Sleep Suspended Fun Suspended :I Eleep

[1]| Jiter [2]] Jiter |
:Scan Cycle T

| o |
! ! Extecution Time

T

=

|

Pacan Cycle
|

| |

e
Wscan Cycle
|

Execution Time ERecution Time

[1] The higher priority threads can cause jitter by delaying the start of an OB. This could delay
the start of the free cycle (OB1) or of an interrupt OB (such as OB35 or OB40).

@ The higher priority application can cause jitter by extending the execution time for an
individual scan.

You can use the tuning panel to increase or decrease the priority for the WinLC threads. The higher you set
the priority for the WinLC threads in relation to the threads of the other applications, the less jitter you
typically encounter. However, you must also ensure that WinLC provides enough sleep time for the other
applications to run.

The tuning panel also provides information that allows you to monitor the amount of jitter in the scan cycle.
For more information about priorities, refer to the following topics:
e Adjusting the Priority

e \Windows Priorities
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Priorities among the WinLC Threads Can Cause Jitter

In addition to the thread that executes the OBs of the control program, WinLC uses other threads, including
some with higher priority than the OB Execution thread. Some examples of higher-priority threads are the
execution monitor, the start event for an OB, the watchdog events, the timers, the PROFIBUS-DP driver,
and the events for the DP 1/0. Any of these higher-priority threads can induce jitter in the execution of the
control program.

The relative priorities (priority classes) of the OBs in the control program itself can also cause jitter. For
example, an error OB delays or interrupts the execution of all lower-priority OBs.

WinLC Includes threads such as the execution rmonitor, OF 100 events
Irterrupt Everts (process alanns), trmears, O driver, and watchdoy timer
WinLC J L

Control Pragram OB priotity” class 26 Etror Intetrupts (such as OB§Z or OE&6)

(OB Execution)
Startup (such as OBA00 or OB10Z)

Pracess Intettrupts (such as OE40)
Cyclic Intertupts (such as OB35 or OE36)

OB prioity class 2 Time Intertupts (such as OBA0 or QB0

| OB priotity class 1 | Free Cycle (0BT

1L

Includes threads such as for communicating with other
applications

WinLC
Backyround Tasks

|I| The threads of the interrupt events have a higher priority than the thread for execution the
control program. These threads can cause jitter by interrupting the execution of the control
program.

[2] The OB Execution thread includes the different priority classes for the OBs of the control
program. The interrupt OBs can cause jitter not only by interrupting the free cycle (OB1), but
also by interrupting another interrupt OB with a lower priority class.

|E| The background tasks for WinLC includes the threads used for communicating with other
applications, such as STEP 7. The OB Execution thread and the higher-priority threads affect
the execution of these tasks.
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The Sleep Interval Forced by the Execution Monitor Can Cause Jitter

WiInLC must sleep (release the CPU) periodically in
order for the other applications to run. The free
cycle includes a sleep interval that follows the
execution of OB1. However, this sleep interval can
be interrupted by higher-priority OBs. Also, a scan
cycle with a relatively long execution time could
cause other applications to wait too long to access
the CPU.

To ensure that the controller does not exceed a
specified percentage of CPU usage, an execution
monitor measures the sleep time within a fixed
execution time limit. If the controller does not sleep
for the specified amount of time within the execution
time limit, the execution monitor forces a sleep
interval.

hdax Execution Load (%%CPUY: g0

The execution monitor forces a sleep interval to ensure that the
cantroller does not etceed the CPU usage

in

Execution Time Limit Execution Time Linit

T
b 3

3

. Controller does not Forced | slaep time is suFficient far
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Moritor | SR Within Eime limit . Eleep | CPU usage ...
OE1 Run Fun | Zleep

Because the execution monitor runs in a higher priority class than any OB, the controller cannot interrupt
the forced sleep interval. This could delay the start of an interrupt OB, such as OB35, until the end of the
forced sleep interval. This delay in handling an interrupt OB results in jitter.

As a general rule for decreasing jitter, always design your control program to keep the execution time of the

higher-priority OBs as short as possible.

If the start event of
ah interrupt OB is received
during the forced sleep interval. ..

Execution Time Limit Execution Time Limit Execution Time Limit
Evacution | COntreller does not Forced | Zleep time is sufficient for | Execution meniter
Monitor | SR Withintime fimit .. [Sleep | CPU vsage .. measures the sleep time
OE1 Fun Fun | Slegp Fun
T
| = |
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Fcan Cycle . .
d I |-]I Possible Jitter

o the start of the interrupt OB is delayed
until the end of the forced sleep interval

WinLC provides several options for managing the sleep time to avoid the uninterruptible forced sleep

interval:

e You can increase the minimum sleep time parameter for managing the sleep time for the free cycle

(priority class 1, or OB1).

e You can call SFC47 (“WAIT”) to insert an extra, interruptible sleep interval into the control program
for managing the sleep time for an application-defined priority class (priority classes 2 to 24).

e You can adjust the sleep-monitoring algorithm for the execution monitor for managing sleep time at

a higher priority class than any OB.
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Adjusting the Priority of the Controller

The priority of the controller determines how WinLC runs in relation to other Windows applications
that are running on the computer.

Adjusting the priority of the controller can reduce or increase the amount of jitter in the scan time.

The tuning panel allows you to change the priority for the controller application. When you use the
tuning panel to change the priority, the controller automatically ensures that its interrupt activities,

such as those which schedule interrupt OBs, are also set to an appropriate priority.

WinLC does not control priorities in customer software, such as asynchronous threads in custom
software or other applications in the same environment.

Note: The CCX interface of the WinAC Open Development Kit (ODK) provides an
ODK_CreateThread function. Calling the ODK_CreateThread function creates asynchronous
threads with priorities that are adjusted when you change the priority of the controller.

If you do not use the ODK_CreateThread function to create threads (for example, if you use
a Windows AP call to create a thread), changing the priority of the controller does not adjust
the priority of those threads.

Refer to the documentation of the WinAC Open Development Kit (ODK) for more information.

While a PC-based controller must maintain the essential features of a SIMATIC S7 PLC, the PC-based
controller must also allow the other applications to run on the computer. The operating system of the
computer uses a concept of execution threads (or tasks) to run or execute the applications. Each
application has one or more threads, and each thread has a priority. The operating system executes the
threads with the highest priority first and executes a lower-priority thread only when all of the higher priority
threads are suspended (for example, to wait for some other activity to complete or to “sleep” for a specified
time). Threads with higher priorities interrupt and suspend the operations of other threads that have lower
priorities. After the higher-priority thread finishes, the lower-priority thread resumes its operation.

To change the priority, follow these steps:

1. Use the Priority slider to choose a priority based on the priority levels for your operating system.
The new priority is displayed as you move the slider.

2. Click Set to set the priority to the new value.
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Windows Priorities

The Windows operating system groups priorities into four groups: Normal, Above Normal, Real-Time, or
Background. Adjusting the priority of the WinLC application determines whether the other applications
running on the computer can interrupt WinLC.

Priority of the Controller Effect on the Scan Cycle

Same or lower priority to other ~ The operating system of the computer determines the scheduling
Windows applications: of actual start and completion time for the scan cycle. The scan
cycle and the execution of the control program can become non-
* Normal (8) deterministic (and can increase the amount of jitter).
e Background (1 to 7)

Because the controller runs only when other applications have
finished, the lower priority allows the controller access more of the
functions of the CPU (such as for mathematical processing).
However, waiting for other applications to finish can lead to scan
times that vary greatly.

Higher priority than other The controller plays a greater role in determining when to allow
Windows applications: time for the other Windows applications to run. This yields a more

« Above Normal (9 to deterministic scan time and reduces jitter.

13) However, there is a possibility that the controller may not allow
i enough time for the other applications to run, which could then
¢ Real-Time (171029) 5,56 the other applications to lock up or become disabled.

To ensure that the other Windows applications have enough time
to run, you must tune the performance of the controller by
adjusting the minimum cycle time and minimum sleep time
parameters.

You use the Priority slider on the tuning panel of WinLC to adjust the priority for the WinLC application. If
you attempt to set the priority to a level that is not supported by WinLC, the tuning panel automatically sets
the priority to the next lowest priority that is supported by WinLC.

Normal Priority (8)

The default priority for the controller is Normal (8), which is the default priority for all Windows
applications. For a control project that is not time-critical and includes intensive calculations that
require extensive use of the CPU resources of the computer, consider using the Normal priority.

Do not use the Normal priority for a control application that is time-critical.

Because most Windows applications run at the Normal priority, executing the controller at the Normal
priority helps to ensure that the other applications have sufficient access to the resources of the computer.

However, the Normal setting also gives the operating system more control of when the scan cycle starts
and finishes. Shifting the control for starting and stopping the scan cycle to the operating system induces
the potential of more non-deterministic behavior, or jitter, for the scan cycle.
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Background Priority (1 to 7)

For a control project that is not time-critical and includes intensive calculations that require extensive
use of the CPU resources of the computer, consider using a Background priority. Background
priority applications are at a lower priority than Normal priority applications.

Do not use a Background priority for a control application that is time-critical.

Setting the priority from 1 to 7 configures the controller as a background task that executes whenever the
higher-priority applications are not using the resources of the computer. The applications with higher
priority operate smoothly, even if you have not configured the controller for a minimum sleep time.

Setting the priority to 1 defines an idle process that executes only when the computer has no other task to
execute.

Selecting a background priority allows the controller to maximize the use of the CPU resources of the
computer. Setting the minimum sleep times to 0 ensures that the controller maximum access to the CPU
resources. However, a scan cycle for a controller set to a background priority may vary considerably (have
jitter, or be non-deterministic), depending on how much execution time the other applications require.

Above-Normal Priority (9 to 13)

For a control project that is less time-critical but requires a more deterministic scan cycle, consider
using an Above-Normal priority. This level of priority reduces the amount of jitter in the scan cycle.

You should provide sleep time that allows other application to run. (For more information about
managing sleep time, see the topic on Sleep Management Techniques.) Use the tuning panel to
monitor the variation in scan times that occurs as the controller executes your control program.

Setting the priority from 9 to 13 configures the controller to run with a higher priority than typical Windows
applications. (However, other Windows applications often compete in this level of priority.) The Above-
Normal priority allows the controller to maintain a more deterministic scan, but the operating system still
interrupts the controller operations periodically.

For a controller set to run at Above-Normal priority, you must be more careful about the CPU usage for the
computer. If the controller does not sleep periodically (giving access to the CPU), other Windows
applications can be severely affected.

Be aware that the Windows operating system also periodically increases the priority for any lower-priority
applications to ensure that these applications get some amount of CPU time. This could allow some lower-
priority applications, in addition to higher-priority applications, to create jitter in the scan cycle.

Windows "Real-Time" Priority (17 to 29)

For control projects that are very time-critical, consider using a Real-Time priority. With this level of
priority, the scan cycle is very deterministic, with a minimal amount of jitter in the scan cycle. Even
at this level of priority, there are still some Windows events that can interrupt the execution of the
controller.

You should provide sleep time that allows other application to run. (For more information about
managing sleep time, see the topic on Sleep Management Techniques.) Use the tuning panel to
monitor the variation in scan times that occurs as the controller executes your control program.

With a Real-Time priority, the controller typically competes only with high-priority applications (such as
those that control the mouse), drivers, special Windows features (such as delayed procedure calls or
DPCs), and some features of the hardware.

This priority range allows WinLC to have a much more deterministic scan cycle. Typical jitter of less than 10
milliseconds is possible, depending on the hardware platform and other software installed.
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Managing the Sleep Time

Sleep Management Techniques

During a sleep interval, the controller allows other applications to use the resources of the computer.
By managing the sleep time, you can tune the performance of the controller in order to allow all
applications on the computer to run with acceptable performance. You can use a variety of
techniques for managing the sleep intervals for the controller:

Contents of this topic:

Adjusting the minimum sleep time parameter. The minimum sleep time determines the
amount of sleep time that is added during the execution of the free cycle (OB1). This sleep
time affects only OB priority class 1.

Calling SFC47 from your control program. SFC47 inserts a sleep interval into the execution
of your control program. This sleep time affects OB priority classes 2 to 24.

Adjusting the execution monitor. The execution monitor uses a sleep-monitoring algorithm
(based on the execution time limit and the maximum execution load parameters) to force a
sleep interval. The execution monitor runs asynchronously to the scan cycle. This sleep
time affects all OB priority classes.

Managing the Sleep Time of the Controller
Tuning Strategy

Sample Interaction of the Execution Monitor and the Minimum Sleep Time

Managing the Sleep Time of the Controller

Because the controller shares the resources of your computer with other applications, you must ensure that
the controller sleeps for a sufficient interval to allow the other applications to run.

Notice

The most effective method for granting time to other applications is to set the minimum sleep time
parameter to the largest value that your control application allows. The other methods for managing
the sleep time provide sufficient sleep time for the other applications to run, but may degrade the
performance of the controller.

The controller provides the following techniques for managing the sleep time:

The controller provides an execution monitor that enforces the maximum execution load on the
resources of the computer. The execution monitor measures the amount of sleep time taken by the
controller within an execution time limit, which is independent from the execution time of the scan
cycle. If necessary, the execution monitor forces a sleep interval to achieve the specified execution
load. This forced sleep interval suspends the execution of any OB and can also delay the start of
an interrupt OB.

The controller provides a minimum sleep time parameter that adds sleep time for the free cycle.
This sleep interval occurs after the execution of OB1. The minimum sleep time affects only priority
class 1. An OB in a higher priority class can interrupt this sleep interval. The controller does not
adjust the minimum sleep time to compensate for the execution time of interrupt OB. However, any
forced sleep interval (generated by the execution monitor) is subtracted from the sleep interval
generated by the minimum sleep time.

The controller supports SFC47 ("WAIT"), which inserts a specified sleep interval for the priority
class of the OB that calls SFC47. This sleep interval the OBs at the same or lower priority class as
the OB that calls SFC47, but an OB in a higher priority class can interrupt this sleep interval. You
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can use SFC47 to create sleep time that can be interrupted so that the controller can avoid jitter
when handling any interrupts that are critical for the application.
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Tuning Strategy

As you test the performance of the controller during the development phase of your project, consider the
following strategy for adjusting the sleep time:

1.

Set the minimum sleep time parameter to 0 and run the control program. This allows you to
determine whether there is unacceptable jitter in the scan cycle.

To reduce any unacceptable jitter, first use the tuning panel to increase the minimum sleep time
and observe the effect on cycle time and CPU usage.

If the amount of jitter is still unacceptable, review the sections of the control program that are being
affected by the jitter. If possible, have your control program call SFC47 to add sleep time.

To further reduce any jitter, increase the execution time limit to the maximum possible execution
time for your control program.

If the sleep management techniques do not provide adequate improvement in reducing jitter, consider
increasing the priority for the controller. (The priority of the controller is not the same as the priority class of

an OB.)

Sample Interaction of the Execution Monitor and the Minimum Sleep Time

To help explain the tools for managing the sleep time of the controller, the following example shows how
the execution monitor and the minimum sleep time can interact:
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with no minimum sleep time added to the free cycle.

The second sample shows how the execution of the free cycle is affected by adding a minimum
sleep time to the scan cycle.
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The following example describes the execution of a control program that uses OB1 to start a 1-second
timer, and then check the timer after an elapsed time of 1 second (1000 ms). The controller has been
configured with the following parameters:

Parameter Value

Execution Time OB1 takes 900 ms to execute.

Minimum Sleep Time 0 ms

Minimum Cycle Time 0ms

Maximum Execution Load 90% (uses the default wake/sleep algorithm)
Execution Time Limit 9 ms (uses the default value)

Forced Execution Sleep 1 ms (uses the default value)

Sleep Time Generated by the Execution Monitor (Minimum Scan Time = 0)

If you set the minimum sleep time parameter to 0, the controller uses the execution monitor alone to
provide sleep time. The figure shows the operation of the execution monitor, using the default values.

The execution monitor suspends the execution of OB1 for 1 ms after every 9 ms of execution by default in
order to enforce a limit of 90% execution load (CPU usage). For every 1 second of elapsed clock time, the
default execution time for OB1 is 900 ms, with forced sleep intervals totaling 100 ms.

Notice that the sleep time occurs at intervals within the execution of OB1.

Execution Time Limit = 9ms ." ."I P
Forced Execution £leep = 1ms — Tirring (rre ]
el sl ] }H ,_,1 —sfl—f| | Execution Time:
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Adding a Minimum Sleep Time for the Free Cycle

This figure shows how changing the minimum sleep time from 0 to 200 affects the execution of OB1. The
execution monitor still forces 100 ms of sleep time to occur during the execution of OB1. With the minimum
scan time parameter set to 200 ms, the controller then sleeps for only another 100 ms, for a combined total
of 200 ms, before starting the next free cycle.

The total scan time increases to approximately 1100 ms: the execution time (900 ms) for OB1, the forced
sleep time (100 ms), and the sleep time at the end of the scan cycle (100 ms).
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Adjusting the Minimum Sleep Time and Cycle Time

The tuning panel provides the following parameters that allow you to manage the sleep time of the
free cycle (priority class 1, or OB1):

e Minimum Cycle Time (in milliseconds) sets the minimum number of milliseconds from the
start of one free cycle to the start of the next free cycle. This value must be greater than the
execution time before it causes any sleep time to occur within the free cycle. You use
STEP 7 to configure the minimum cycle time for the controller when you create the system
(hardware) configuration. You can use the tuning panel to adjust the minimum cycle time,
but any changes are discarded when you shut down the controller. However, you must use
STEP 7 to make the changes permanent.

e Minimum Sleep Time (in milliseconds) determines how much sleep time is available during
the free cycle (OB1) for allowing higher priority OBs and other applications to use the
resources of the computer. The controller automatically saves any changes to the minimum
sleep time made with the tuning panel. You do not use STEP 7 to make any change to the
minimum sleep time permanent.

Contents of this topic:
e Parameters That Affect the Sleep Time for the Free Cycle

e Hints

The execution of the free cycle is affected by both the minimum sleep time and the minimum cycle time
values.

e The minimum cycle time by itself results in a fixed scan cycle time with a variable sleep time (if the
minimum cycle time is large enough to accommodate the execution time plus the sleep time).

e The minimum sleep time by itself results in a fixed sleep time with a variable scan time, depending
on the length of the execution time.

The minimum sleep time value guarantees that a configured amount of sleep time occurs within each free
cycle, even if the value for the minimum cycle time is too small. The controller releases control of the CPU
for a sleep interval, This sleep interval is the larger of either the configured minimum sleep time value or a
sleep time that is computed from the minimum cycle time parameter.

Warning
If you set the minimum scan time to a value larger than the watchdog time, WinLC goes
to STOP mode during the first scan at the end of the watchdog time interval.

Causing the controller to go to STOP mode unexpectedly can cause process equipment
to function erratically and possibly cause damage to equipment or injury to personnel.

Do not set the minimum scan cycle time to be longer than the scan cycle monitoring time
(the watchdog time) configured in the STEP 7 Hardware Configuration Editor.

97



STEP 7 Operations

Parameters That Affect the Sleep Time for the Free Cycle

The following figures explain the interaction between the execution time, the minimum sleep time, and the

minimum cycle time

parameters.
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For the first sample scan shown in the example above, the execution time plus minimum
sleep time is less than the minimum cycle time. In this case, the controller increases the
sleep time until the minimum cycle time is achieved.

For the second sample scan shown in the example above, the execution of OB35 increases
the execution time, and the execution time plus the minimum sleep time is greater than the
minimum cycle time. In this case, the controller waits the minimum sleep time before starting
the next scan.
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For the third sample scan shown in the example above, the controller executes both a cyclic
interrupt (OB35) and an 1/O interrupt (OB40). The execution time exceeds the minimum cycle
time, and the controller waits the minimum sleep time before executing the next scan.

For the fourth sample scan shown in the example above, the controller executes OB40
during the sleep time after OB1 has finished. In this case, the controller waits until the
minimum cycle time before starting the next scan.

Because the execution of OB40 does not reset the minimum sleep time counter, it is possible
that the controller does not provide sufficient sleep time to allow other Windows applications
to be processed. You must then use other methods for ensuring that the controller provides a
sufficient amount of sleep time.
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Hints

You can use the following techniques to adjust controller performance using the minimum sleep time and
minimum cycle time parameters:

e Use the tuning panel to test values for the minimum cycle time. After you have determined the
optimum value for the minimum cycle time, use STEP 7 to update and download the system
configuration for the controller.

Changing the operating mode from STOP to RUN deletes any value entered by the tuning panel and
resets the minimum cycle time to the value stored in the system configuration.

e To ensure that the controller executes the scan cycle on a fixed schedule, use the minimum cycle
time parameter.

o To ensure that there is always a sleep interval even if the execution time changes, set the minimum
cycle time to O (the default value) and modify the minimum sleep time as needed. Modifying the
minimum sleep time is especially useful during the development of your control program.

When you are tuning the operation of the controller, be aware that the following situations can increase the
time required to complete the scan cycle:

e The controller executes other OBs (such as OB20 and OB35) with higher priorities than OB1.
e You use STEP 7 to monitor and debug the control program.

e You use a variable table (VAT) with STEP 7 to display the status of the control program.

¢ An application with a higher priority is running on your computer.

e The controller interacts with an HMI interface, such as WinCC.

Additional Methods for Managing the Sleep Time
e Using SFC47 to add sleep time in the control program

e Adjusting the sleep-monitoring algorithm of the execution monitor
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Using SFC47 to Add Sleep Time in the Control Program

SFC47 (WAIT) inserts sleep time into the execution of the control program, allowing you to manage
the sleep time for a control program by inserting the sleep time in a specific priority class. When you
call SFC47 from your control program, the controller suspends the execution of the OB for a
specified number of microseconds and sleeps. During this sleep period, the controller can interrupt
this sleep period to execute an interrupt OB. Because an OB with a higher priority class can
interrupt the sleep time, your control program to handle higher priority OBs with less chance of jitter.

Typically, you call SFC47 from a cyclic OB (such as OB35) that starts within the execution time limit
of the execution monitor.

For more information, refer to the example: Avoiding Jitter in the Start Time of an OB

To provide greater control over when the sleep time occurs, you can use SFC47 to insert sleep time into
your control program. Calling SFC47 in the control program also allows you to define which OBs are
affected by setting the priority class of the OB that calls SFC47.

As shown in the following figure, you can use SFC47 to insert a sleep interval that can satisfy the execution
monitor and still allow the controller to handle an interrupt OB. By using a cyclic OB (such as OB35) to call
SFC47, you can ensure that the sleep interval occurs within the execution time limit of the execution
monitor.

The sleep time parameter is rounded up to the nearest millisecond.

Euxecution Tine Limik I Euecution Tine Limit I Euecution Time Limit I
= T T i L
Interrupt OB
priority class Rl
Cyclic OF i
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OB3S calls SFCAT to insert The controller can execute a

a sleep |nt|=._'r'.fa.lldl.1r|ng the highet-priority OB (such as OB40

execution time limit during the sleep interval of SFCAF

Additional Methods for Managing the Sleep Time
e Adjusting the Minimum Sleep Time and Cycle Time

¢ Adjusting the Sleep-Monitoring Algorithm of the Execution Monitor
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Adjusting the Sleep-Monitoring Algorithm of the Execution Monitor

The execution monitor uses a sleep-monitoring algorithm to ensure that the controller does not
exceed a configurable maximum execution load for the CPU usage within a monitor interval.

The monitor interval is calculated as the amount of time such that the maximum load percentage of
the monitor interval equals the entered execution time limit. The execution monitor calculates the
forced execution sleep time as the difference between the monitor interval and the execution time
limit.

The execution monitor determinines whether to insert a forced execution sleep time if the OB
execution exceeds the execution time limit.

If there is sufficient sleep time within the monitor interval, the execution monitor does not affect the
execution of the program. Otherwise, the execution monitor forces a sleep interval. The default
execution load is 90%, and the default execution time limit is 9 ms. For the default settings, the
execution monitor calculates a monitor interval of 10 ms and a forced sleep interval of 1 ms.

The execution monitor runs asynchronous to the scan cycle and measures the amount of sleep time
that occurs within the monitor interval and enforces a minimum sleep interval.

o If the scan cycle (execution time plus sleep time) is shorter than the monitor interval and the
sleep time is greater than or equal to the forced sleep value: The execution monitor does
not force a sleep interval.

e |f the scan cycle is longer than the monitor interval: The execution monitor forces the
controller to sleep for the required amount of time. Because the execution monitor runs in a
higher priority class than any OB, the controller cannot interrupt the forced sleep interval.
This could delay the start of an interrupt OB, such as OB35 or OB40.

Use the tuning panel to configure the parameters for the sleep-monitoring algorithm of the execution
monitor.

For more information, see the example: Avoiding Jitter in the Start Time of an OB
Contents of this topic:

e Operation of the Execution Monitor

e Parameters of the Sleep-monitoring Algorithm

e Configuring the Parameters of the Sleep-Monitoring Algorithm

e Situations that Cause the Execution Monitor to Force a Sleep Interval

e Situations that Prevent the Execution Monitor from Providing Sufficient Sleep Time

In addition to the sleep time that is added to the scan cycle (based on the minimum sleep time and
minimum cycle time parameters), the execution monitor uses a sleep-monitoring algorithm that is based on
a maximum execution load (percentage of CPU usage). For the default execution load (90% CPU usage),
the execution monitor measures the length of time that the controller sleeps during the monitor interval of
10 ms and ensures that the controller sleeps for at least 1 ms.

By measuring the sleep time, the execution monitor ensures that the controller allows the other applications
to access the computer resources while the controller sleeps. The execution monitor also provides the
safety net in cases where there are programming errors (for example, an infinite loop in OB100) that are
not handled with other mechanisms.

The difference between the forced sleep intervals and the minimum sleep time is that the controller can
interrupt the minimum sleep time to handle interrupts (such as OB35 or OB40), but cannot interrupt the
forced execution sleep time.
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When the execution monitor forces a sleep interval, the following actions occur:

o The controller immediately suspends the execution of the OB for the forced sleep interval. By
forcing a sleep interval, the execution monitor increases the actual time between starting and
finishing the OB being executed.

o The controller cannot respond to the start event for any interrupt OB until the end of the forced
sleep interval. Delaying the start of the OB (for example, OB35 or OB40) until the end of the forced
sleep interval creates jitter or latency in the actual start time for the OB.

Operation of the Execution Monitor

The following figure shows how the execution monitor might affect a control program. Because the
execution time for OB1 in this example is greater than the execution time limit, the execution monitor
inserts a 1-ms sleep interval after the first two monitor intervals. However, the execution monitor does not
insert a forced sleep interval in the third monitor interval because the controller sleeps longer than the
required forced sleep interval as required by the configured minimum sleep time.

CPU Usage = 90% Execution Tine Limit = 4 ms

Forced Execution Sleep = 1ms Execution tine for 061 Ilms

Monitar_Inberval 1 Momitor Inberval @ Monitar Inberval Minimum  Fheep Tinng 0 ms
Maximum Execution Load 0%
: : Execution Time Linit 1 ms
I I Fobced Execution Sleep  1ms
| Farced gleep | Forced gleep
| 1ms | 1ms

0B 10 ms Ij 4 ms Ij Tms | Eleep Time = §ms
' Er——
I Execution Time for OB1 = tims Eleep Time =

Wms -ims = &§ms

(2 ms of forced sleep interals) (Minimum sleep time minus Forced sleep)

Note

The execution monitor runs asynchronous to the scan cycle. The example above shows the
execution monitor measuring time from the beginning of the scan cycle, but because the execution
monitor runs asynchronous to the control program, the beginning of the execution time limit of the
execution monitor does not necessarily coincide with the beginning of the scan cycle.
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Parameters of the Sleep-Monitoring Algorithm

The sleep-monitoring algorithm of the execution monitor uses the following parameters:

Parameter Description
Execution Time This value defines the maximum time (in microseconds) that the execution
Limit monitor allows for OB execution before exceeding the configured maximum

execution load (CPU usage) of the monitor interval.

To determine the CPU load caused by the execution of the control program,
the execution monitor measures the time that the controller sleeps during the
monitor interval. If the controller does not use a sufficient amount of sleep time
(indicating that the CPU load exceeds the maximum execution load), the
execution monitor forces the controller to sleep for the remainder of the
required forced execution sleep time.

The default value is 9000 microseconds (9 ms).

Note: If you set this value greater than approximately 50000 (50 ms), you may
observe jitter in Windows applications and in response to the mouse or
keyboard. Test that the execution time limit you choose is appropriate for your

application.
Maximum This value defines the maximum percentage of CPU usage that is allowed for
Execution Load the controller to execute OBs during each monitor interval.

The default value is 90%.

Forced Execution  This read-only field shows how much sleep time (in microseconds) the

Sleep execution monitor requires during the monitor interval to satisfy the
requirement for the maximum execution load. The execution monitor subtracts
any controller sleep time that occurs during a monitor interval from the forced
execution sleep time to determine how much sleep time (if any) to force.

The forced execution sleep time is a calculated number based on the
execution time limit and the maximum execution load. The execution monitor
corrects this value as required, depending on the capability of the operating
system configuration to have timers operate at the specified intervals.

The default value is 1000 microseconds (or 1 ms).

The execution monitor uses the execution time limit and the maximum execution load to calculate the
forced execution sleep. For example, the execution monitor uses the 90% usage rate and the 9-ms
execution time limit to calculate a 1-ms sleep interval. In this case, the monitor interval is 10 ms such that
90% of the monitor interval corresponds to the entered execution time limit (9 ms).
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During the monitor interval, the execution monitor measures the actual amount of time that no OBs are
executing (the sleep time).

o |f the controller sleeps longer than the sleep interval (forced execution sleep time), then the
execution monitor restarts another monitor interval and does not affect the control program.

o |If the controller sleeps less than the sleep interval (forced execution sleep time), then the execution
monitor blocks the execution of any OBs for the remainder of the sleep interval.

Any control program sleep time imposed because of the sleep-monitoring algorithm is subtracted from the
sleep time configured for the end of the free cycle as defined by the minimum sleep time parameter.

The default value for the “Execution Time Limit” interval is 9000 microseconds (or 9 milliseconds) and the
default value for the “Forced Execution Sleep” interval is 1000 microseconds (or 1 millisecond). This ratio
ensures that the control program execution cannot use more than 90% of the CPU time in any of the worst
case situations described above.

Configuring the Parameters of the Sleep-Monitoring Algorithm

The parameters of the sleep-monitoring algorithm of the execution monitor are configurable from the tuning
panel:

B E=ecution Monitar

E=ecution Tirme Limnit [us]i 9000 Forced Execution Sleep Time [us]i 1000
Max. Execution Load [%]: I o5 Forced Execution Sleep Enunteri i

lzeris chanoing default
Set | _ Defaut | |yajue 90% to 85%

To change the sleep-monitoring parameters, follow these steps:

1. Enter values in the Execution Time Limit and the Max. Execution Load fields. You can change one
of the fields or both.

2. Click Set to set the parameters.

To restore the default sleep-monitoring parameters, follow these steps:
1. Click Default to display the default parameters.
2. Click Set to set the default parameters.

Changes to the sleep-monitoring parameter take effect when the controller is in RUN/RUN-P mode.
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Situations that Cause the Execution Monitor to Force a Sleep Interval

The controller must relinquish control of the CPU long enough to satisfy the maximum execution load.
Typically, the sleep time that is added to the end of the scan cycle allows sufficient time for the operating
system to process the other Windows applications. However, some situations may require that the
execution monitor force a sleep interval.

Condition

Execution time for the
control program exceeds
the execution time limit

Minimum sleep time is
insufficient for the
maximum execution load

Interrupt OBs reduce the
sleep time

Description

The configured minimum sleep time for the free cycle occurs after
OB1 finishes. If the execution time is longer than the execution time
limit, the execution monitor forces a sleep interval because the
controller did not sleep for the required amount within the monitor
interval.

Even when the scan cycle is less than the execution time, the
minimum sleep time may not provide enough sleep time. In this case,
the controller would exceed the maximum execution load. The
execution monitor forces an additional sleep interval to ensure that the
operating system can run the other applications.

To process an interrupt OB (such as OB35, OB40, or OB85), the
controller can interrupt the sleep time for the scan cycle. This reduces
the time that the controller actually sleeps and can cause the controller
to exceed the maximum execution load, which affects the performance
of the other Windows applications.

By forcing a sleep interval, the execution monitor ensures that the
other Windows application can be processed.
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Situations that Prevent the Execution Monitor from Providing Sufficient Sleep Time

In some cases, a high execution time limit can prevent the execution monitor from managing the sleep time
of the control program adequately. Under the following conditions, the control program utilizes too much
CPU time, which can result in jitter in Windows response time to the mouse, keyboard, or other
applications. For either case, the problem can be resolved by lowering the execution time limit.

Condition Description

Execution time for the During startup, the controller turns the watchdog timer off and cannot
startup OB (OB100 or handle a program error, such as a loop in the logic of the OB or an
0OB102) and the excessively long initialization routine.

configured execution time

limit exceed ~50 ms Because the scan cycle does not provide any sleep time for the

startup OB (such as OB100), the execution monitor cannot relinquish
CPU time for other applications. If the startup OB executes for more
than ~50 ms, jitter can occur in Windows response time to the mouse,
keyboard, or other applications.

Execution time for the Whenever the operating system has to wait more than ~50 ms to
control program and the process the other Windows applications, the performance of those
configured execution time  applications can be noticeably affected. This can be a problem for an
limit exceed ~50 ms OB1 with a long execution time, especially if other OBs (such as OB35

or OB40) extend the execution of OB1.

Because the sleep time is added at the end of the scan cycle, and the
execution time limit is set to a high value, the sleep intervals are then
spaced too far apart for the other Windows applications to perform
naturally.

Additional Methods for Managing Sleep Time
¢ Adjusting the minimum sleep time and minimum cycle time parameters

¢ Inserting sleep time into the control program (SFC47 “WAIT”)
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Example: Avoiding Jitter in the Start Time of an OB

The following example discusses two possible solutions for a program that experiences jitter in the
start of a cyclic interrupt (OB32 to OB36).

e Inserting a sleep interval into the execution of your control program. For this solution, you
call SFC47 (“WAIT”) and specify the length of time to sleep. The controller can interrupt this
sleep interval to process other OBs.

e Changing the sleep-monitoring algorithm of the execution monitor. For this solution, you use
the tuning panel to change the execution time limit.

Scenario

The following example describes the execution of a control program that consists of OB1 and OB35. OB1
takes 20 ms to execute, and OB35 starts every 100 ms and takes 1 ms to execute. The controller has been
configured with the following parameters:

Parameter Value

Execution Time for the Control Program OB1: 20 ms, and OB35: 1 ms

Minimum Sleep Time 10 ms (uses the default value)

Minimum Cycle Time 0 ms (uses the default value)

Maximum Execution Load 90% (uses the default wake/sleep algorithm)
Execution Time Limit 9 ms (uses the default value)

Forced Execution Sleep 1 ms (uses the default value)

The sleep time (10 ms) is added to the scan cycle after OB1 has finished. However, because the execution
time for OB1 (20 ms) exceeds the execution time limit (9 ms), the controller exceeds the configured
maximum execution load (90%) by not sleeping during the execution time limit. Therefore, the sleep-
monitoring algorithm forces the controller to sleep for 1 ms after every 9 ms that OB1 executes. As shown
in the following figure, this forced sleep can cause a variance or jitter of up to 1 ms between time that the
start event and the time that the controller starts to execute OB35. This jitter happens because all controller
operations are suspended during a forced sleep interval. Similarly, OB35 could be suspended for 1
millisecond if the end of the execution time limit interval occurs while OB35 is executing.

4ms Execution Time Limit | 4ms Execution Time Limikt I ams Execution Time Linit I
- T T i
Farced SlEEFI [1ms) Farced Sleep [1ms)
0B 35 DB3S is not allowed bo start _..ﬁ
OE1 ams [ D Eleap

1
I
The start event for OBSS is received A |

during a Forced sleep interval.. Ay but the start of DB35 is delayed UNLil the end of the Farced sleep interval (1 ms)
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For many applications, a 1-ms jitter might be acceptable. However, you have several options for removing
this jitter:
e You can modify the control program to call SFC47 and insert sleep time that can be interrupted by
OB35.
e You can adjust the parameters for the sleep-monitoring algorithm to avoid the jitter caused by the
execution monitor.
Solution 1: Insert a sleep interval into the execution of your control program

You could avoid the forced sleep interval by using SFC47 to add a periodic sleep interval that occurs within
the execution time limit (for this example, 9 ms). This sleep interval not only ensures that the sleep-
monitoring algorithm does not force the controller to sleep, but also allows the controller to suspend this
sleep interval and execute any OB that has a higher priority than the OB that called SFC47.

For this example, you can use SFC47 to remove the jitter in OB35:
e By ensuring that SFC47 executes at a specified time. The control program calls SFC47 from an OB
(such as OB36) that has a priority greater than OB1.

e By ensuring that OB35 executes as scheduled. You configure OB36 to have a lower priority than
OB35.

e By ensuring a sufficient sleep interval during the execution time limit. You configure SFC47 to wait
for 3 ms, which ensures a sleep interval of at least 2 ms.

To maintain a 50% ratio for CPU usage (20 ms execution time for OB1 with a 10 ms minimum sleep time),
configure OB36 to run every 6 ms (so that OB1 executes for 6 ms, then sleeps for 3 ms). You can then
change the minimum sleep time to 0 ms, unless you want to decrease the ratio for CPU usage.

To create an OB36 that calls SFC47 to create a 3 ms sleep interval:

1. Using the STEP 7 Program Editor: Create an OB36 for your control program, and enter the
following program:

CALL “WAIT” // SFC47 wait function
WT: 3000 // 3000 microseconds or 3 milliseconds

2. Using the STEP 7 Hardware Configuration tool, configure the priority level and execution time for
OB36:
e Open the WinLC Properties dialog box and select the Cyclic Interrupt tab.
e Set the priority for OB36 to 2 (or any other priority lower than the priority for OB35).
e Configure OB36 to execute every 6 ms (by entering 6 in the Execution field).
The following figure shows how SFC47 affects the execution of the control program. Because OB36

ensures that the controller sleeps at least 1 ms within the 90% wake interval, the execution monitor does
not insert a forced sleep interval. Therefore, OB35 executes without any delay or jitter.
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Solution 2: Change the sleep-monitoring algorithm to eliminate the forced sleep interval

The following figure shows the jitter in the start time of OB35 and also shows the values displayed by the
tuning panel. Notice that the tuning panel shows only the information about OB1. The tuning panel does not
display information about OB35. For this example, the execution time for OB1 is 20 ms. With the minimum
sleep time of 10 ms, the total free cycle time is 30 ms. OB35 and other interrupt OBs can make the total
scan time more than this, depending on how fast the interrupt OBs execute.
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hdin Sleep Tirme {r‘rs}:l 10
kdin Cycle Time (ms): | ]

By changing the parameters of the sleep-monitoring algorithm, you can configure the execution monitor to
use the minimum sleep time in the free cycle. For example: if the longest total scan time for this example is
less than 45 ms, change the execution time limit to 45000 microseconds (45 ms):

1. Open the tuning panel.

2. Change the execution time limit to 45000 (microseconds). For this example, do not change the

value for the maximum execution load.

3. Apply the new value.

The following figure shows the effect of the changed execution time limit.
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Advanced Topics
Connecting WinLC to the SIMATIC NET OPC Server

WinLC can use the SIMATIC NET OPC server to read and write data over the network. You use the
following tools to configure the OPC connection for WinLC:

e OPC Scout for configuring the connection to the SIMATIC NET OPC server
e STEP 7 (HW Config and NetPro) for configuring the WinLC controller

e Station Configuration Editor for configuring the PC station

[H" The critical step most frequently overlooked is configuring the S7 connection for the OPC server
in NetPro. After adding the connection for the OPC server, you must set the connection type to "S7
connection" and enter a Local ID for the connection.

Task Overview

EEL Step 1: Station Configuration Editor (SIMATIC NET)
Add the OPC server to the PC station.

Step 2: HW-Config (STEP 7)
Add the OPC server to the configuration of WinLC.

Step 3: NetPro (STEP 7)

Add an S7 connection for the OPC server to the configuration of WinLC.

[#] Step 4: SIMATIC Manager (STEP 7)

Download the configuration to the WinLC controller.

|'i| Step 5: OPC Scout (SIMATIC NET)
Connect WinLC to the OPC server.
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Step 1: Add the OPC Server to the PC Station
AStation Configuration Editor (SIMATIC NET)

¢ Configure the OPC server for an index of the PC station.

1. Open the Station Configuration Editor and select any index in the Station Configuration Editor.

2. Right-click the mouse to display the Add button. Click the Add button to display the
Add Component dialog.

3. Select the following component type from the drop-down list:
OPC Server

Add Component x|
Tupe:

[ndes:

I arne; |EIF'I: Server

Parameter assig.: I j

Cancel Help
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Click OK to add the OPC server to the station configuration. The Station Configuration Editor

displays the OPC Server in the index selected. (For this example
Index 1.)

, the OPC server is configured for

Click OK to save the PC station configuration and to close the Station Configuration Editor dialog.

[Statiun Configuration Editor - [ONLINE]

Components | Diagnusticsl

Station:  |PCStation Mode: RUN_P
Index | M ame | Type | Ring | Status | Hun;"StDp| Conn =
OFC Server OPC Server & Ol B
2 WinLC WinLC ] 5107
3
4
i
G
? —
a
9
10
11
12
13
14
15
N 1E | LIJ
Add. | Edit.. | Delete... Aing ol |
Station Mame. .. | Irpart Station... | Digzable Station |
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Step 2: Configure WinLC for Using the OPC Server

EIHW Config (STEP 7)

e Create a STEP 7 project for a PC station with WinLC.
e Insert the OPC server into the hardware configuration.

e Configure the OPC server.

1. Open STEP 7 and create a project (for example, OPCProject).

2. Insert a SIMATIC PC Station with the same name as entered in the Station Configuration Editor.
Open HW Config by double-clicking the Configuration icon for the PC Station.

3. Insert the WinLC controller in the same index as configured in the Station Configuration Editor. (For
this example, a WinLC Basis controller is configured for Index 2.)

[ Hw Config - [PCStation {Configuration) -|al x|
E“] Skation  Edit Imsert PLC  View ©Options ‘Window Help =2 x|

D|2[2-® % & e skl @l 28 sl

= (0] FC Hardware Catalog x|
Find | n:h= 1f|=
Profile; I Standard j

®-Fl SIMATIC PC Based Control 300/400 a |
=8, SIMATIC PC Station
=1-{_7] Cantraller
#-{] CPU 412-2 PCI
#-{1] CPU 416-2 PCI
= WinLC
- [8 BES7E111PYO0-OVET
=] BES7 611-4PY0O0-0vE7
- [B w40
= (8] wai —
: CP 5611
3

CP 5613

-0 WinLC PM

=
BEST B11-4F00-0vE T - E
WAinLC W1 Windows Logic Controller =
for Windows 200054P; DP connechor

[OF mazter]; DFY; routing; 57 ;I

3 | [ [ [ =~

Press F1 to get Help. | E
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4. Expand the User Application folder in the catalog.

5. Expand the OPC Server folder and select the following component:

SW V6.1

6. Drag and drop the SW V6.1 component to in the same index as configured in the Station
Configuration Editor. (For this example, the OPC server is configured for Index 1.)

7. Double-click the OPC Server entry (Index 1) to open the Properties dialog.

E@HW Config - [PCStation {Configuration) —-

Eﬂ] Station  Edit  Imsert PLC  View Options ‘Window Help

=10l x|
=18 x|

D[2(3-(@ (% S| Bl bl e %28 sl

= (0] PC

1 OFC Sel &
2 WinlLC

Find | nﬂ n .|
Erofile: I Standard

..

..
EE SIMATIC PC Station
-] Controller

- CP Industrial E themet

SIMATIC 400

- &ipplication

= OPC Server

: ] ... 5w vE.DSPY
4 swvEOSPS ..
{ swvel ..

SIMATIC PC Based Contral 2004400

OPC Server

OPC Server for the DP, FOL, FrS, 57

[between different subnets], ISO/TCP,
SHMF, DF master class 2, PROFInet

C

[

=
2l

|24

=

Insertion possible

N
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8. Click the S7 tab and select the Activate option (under Access Protection).

9. To use the STEP 7 symbols when configuring the connections in OPC Scout, select the option for
All (or for Selected, to specify specific entries in the symbol table) under the Use Symbols field.

10. Click OK to close the Properties dialog.

11. Click the Save and Compile icon to create the hardware configuration for the PC station.

Properties - OPLC Server il

General | DP | DP masterclass 2| FOL | FMS 57 |ISD/TCP | SNMP | PROFInet|

Cycle time: |1 aa mz

—Access Pratechion
v activate
Drefault rights: R j

I Rights specific to OPC item Edit.. |

— Use Symbols
i Mone
Lo |

" Selected Selech.. |

Time after which an unfonwardable protocaol alam is remoyed: IEEIEIEIEI Mz

b axiriurm number of pending alarmes; RO0

Cancel | Help |

After you have compiled the configuration into the STEP 7 project, you can close HW Config and return to
SIMATIC Manager.
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Step 3: Add the OPC Connection to the WinLC Configuration
EINetPro (STEP 7)

e Add a connection for the OPC server to the WinLC configuration.

e Configure the OPC server connection as an S7 connection.

e Assign a Local ID for the OPC server connection.

1. In SIMATIC Manager, browse to the OPC server and double-click the Connections icon to open
NetPro.

QSIMATIE Manager - [DOPCProject -- C:% Program Files' Siem ; - IEIlEl
£ File Edt Insert PLC View Options ‘Window Help == =]

D] 22le=] &= s _| |__| my [ g [« o Fiter >
% OPCProject

=- I@, PCStation
! WinLC
b OPC Server

Press F1 to get Help, 4
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2. Select the OPC Server in the PC station.

{2&NetPro - [OPCProject (Network) -- C:\Program Files',...\s7proj! =10l x|
B8 yebwork Edit Insert PLC Wiew Options “Window  Help =151 x|

=8 (| g e dldl $ o8] Bz e

MPI(1) iI
WP

FCStation

-
1 | b
Local I Partner [T Partrier Type ﬂ

-
1 | b
Ready |0 Fram 0 selected |Insert [Chg 2

3. Right-click the OPC server to display the context menu. Select the Insert New Connection menu
command to open the Insert New Connection dialog.
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Insert Mew Connection : El

— Connection Partner

EI--{E] [ the cument project
=-&p OPCProject
- PCStation
N inlC
............ (Unzpecified)
All broadcast stations
All rulticast stations
% [h unknown project

Project: |OPCProject =

Station: IF'EStatin:-n

Application: IWinLE

— Connechion

Type: I 57 connection j

¥ Display properties befare inserting

] I Apply Cancel | Help |

Set the connection type to S7 connection and click OK to add the S7 connection for the
OPC server. The Properties dialog for the S7 connection opens automatically.

Enter the Local ID for the S7 connection (such as OPC_1).
Click OK to add the S7 connection to NetPro.

Click the Save and Compile icon to save and compile your changes into the STEP 7 project.

119



Advanced Topics

i—'.i%HetPru - [OPCProject (Metwork) -- C:' Program Files', ... \s7p - |EI|5|
B8 nebwork Edit Insert PLC Wiew Options “Window Help =151 x|

=8 % S| =2 daldl S| &S] B[]

MPI(1) j
WP

FCStation

w
1| | 5

Local IT Partner T
Pic 1 ] PCStation MWinLC 57 connection
-
« | | | _>|_I
Ready 1 From 1 selected [Insert [Chg 2

After you have compiled the S7 connection for the OPC server into the STEP 7 project, you can close
NetPro and return to SIMATIC Manager.
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Step 4: Download the configuration to the controller

FISIMATIC Manager (STEP 7)

e Start the WinLC controller.

o Download the configuration.

To download the configuration, the WinLC controller must be running. To start the controller, select the
Start > SIMATIC > PC Based Control > WinLC menu command or double-click the WinLC icon on the

desktop.
After you have started the WinLC controller, you can download the configuration:
1. In SIMATIC Manager, select the SIMATIC PC Station icon.

2. Select the PLC > Download menu command or click the Download icon on the toolbar.

HSIM#TIE Manager - [DPCProject -- C: Program Files',Siemens - |EI|5|
% File Edit Insert PLC ‘Wiew Options Window Help _|5’|£|
| 282)7| &|B=|@ gl [o 2s| %ot & [<Na Fiter >

=& OFCPoject [l Configuration . WinLC

- [ OPC Server
- [§] WinLC
o OPC Server

Press F1 to get Help, S
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Step 5: Connect WinLC to the OPC Server

#OPC Scout

e Create an OPC Project.
e Add the connection to the SIMATIC NET OPC server.

o Define the items to be accessed through the OPC sever.

Opening an OPC Project

Select the Start > SIMATIC >SIMATIC NET > PROFIBUS > SOFTNET PROFIBUS > OPC SCOUT menu
command to open a new project in OPC Scout.

Adding a Connection (Group) for the OPC Server
1. Expand the Local Server(s) directory in the Servers and Groups for the project.

2. Double-click the OPC.SimaticNet element to add a connection (or group) for the SIMATIC NET
OPC server.

E oPC Scout - New Project1
File Yiew Server 7

=| 6| 5| &fE

{Servers and groups fltems incl. status mnformation

= glg Serverls) ltem Names Value | Format  Type | Access Quality Time Stamp (L
= 1B Local Server(s) 1
i &% OPC. SimaticHMIPTF
% OPC.SmasticHET
& OPC SmaticMET.DP
i £ OPC SimaticHET.FD
= g&_l, Remate Servet(s]
gy Add Remote Servers|

—ioj x|

| | Mo, [ Mo, 4
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3. Inthe Add Group dialog, enter the Group Name for the connection (for example, Group1).

x|
— Group Properties:
Enter a IEru:uup M ame"
IErDup'I
Create new group active [+
Requested update rate in mz IEDD j
[~ Extended oK. Cancel | ipply |

4. Click OK to add the group to the OPC server. OPC Scout adds the connection (Group1) to the
OPC server.

[EJ0PC Scout - New Project1 f =101 ]

File Wiew Server Group 7

= |l & &2l ¢

{Servers and groups {ltems incl. status nformation
= ﬁ Serverls) .tﬂl‘l‘l Hamas{\falual Format |Tyr|m] Access |Quality iTime Stamp
F Sﬁ_‘.{', Local Server(s) 1

&F OPC.SinaticHiMIPTF
| B OPC SimalicNET
f ;
% [Mew group]

& OPC SimaticNET DP
- & OPCSmaticNET PD
= % Remote Serveils)

Sy Add Remote Servers(

1] |

| Successhully connected to: '0PC.SimatichET | Mo, | Mo, i
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Configuring the Items to be Accessed (Using Absolute Addressing)

Note: This procedure describes how to use absolute addressing when configuring the OPC server.
You can also use the STEP 7 symbol table for connecting the OPC server.

Use the following procedure to configure the OPC server to use an absolute address for accessing data in
the controller.

1. Open the OPC Navigator by double-clicking the connection (Group1) for the OPC server.

Qv OPC-Mavigaktor il
Modes Leames I iz Wemizs The ligted ltem(z] will be added to Group:

- Connections

o R
My DP2:

..

s

- \DP:
- SFOL:
s
..
..
..
-

R FMS: .
A A5 =
B \SNMP:
'SP

- NS

(B

5] Eilter | ok I Carnicel |
| »

| Connections is selected 341772004 | 221 PM

2. To add an item to be accessed, expand the \S7: folder and select OPC_1.

Qv OPC-Mavigaktor il
Modes Leames I iz Wemizs The ligted ltem(z] will be added to Group:

=] Connections
H O
- \DPZ:
- \DP:
- SFOL:
- AFMS: 3
13 AT

5143 OPC_1
- objects
ﬂ blocks
ﬂ FCah
- aliases

-y SSMEP

By SR

- NS Eilter | Ok I Cancel |
| | *

|OPC_1 i selectsd |3417/2004 | 224PM

(B
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3. To configure access to M 0.0, expand the Objects folder and expand the M folder (for the bit

memory area).

,'F;} OPC-Mavigator

Modes

I The ligted Item(z] wil be added ta

=] Connections
ﬂ [
- \DPZ:
@ \DP:
- WFOL:
- WFMS:
- WS T

=23 OPC_1
=424 ohjects
=g

- L%, [Mew Definitio

1

| v

Leaves I Item Mames

il
iI

Eilter | Ok I Cancel |

I &

| b iz zelected

341772004 | 233PM

4. Double-click the New Definition icon to open the Define New ltem dialog.

5. To define a connection for M0.0, select X (for bit) field from the drop-down list in the Data Type and
enter the byte address (0) and bit number (0). (You can also enter an alias for the item.)

DEﬁI‘IE New Item x|
—OBJECTTYPE_S7
Datatype Adress Bit Mo Mo, Walues
I n
] 1]
{a} {a}
E5535 7
[temnalias:; IMD—E‘
ok | Cancel | Apply |
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6. Click OK to define an item for MO0.0.

Qr OPC-Mavigator
Modes

=-#8 Connections
e
- SDPZ:
-y SDF:
-y “FDL:
-y FS:
2 MET:

Bl
Bl
Bl
Bl
il

=424 OPC_1
Ea objects
A M

EXZXX

\:} [Mew Definition] =

Ly

=l

Leaves Item Mames

il

x|

The lizted [tarm[z] will be added tao

Filer | ok | Cancel |

| [Mew Definition] iz zelected

|2/25/2004 | 2ZE5PM

7. Select the M0.0,1 entry and click the Add arrow (-->) to enter the following syntax that defines a
connection for M0.0:

S7:[OPC_1]M0.0,1
8. Select the entry (S7:[OPC_1]M0.0,1) and click OK to add the connection for M0.0 to Group1.

Qr OPC-Mavigator
Modes

=-#8 Connections
e
-y SDFZ:
-y SOF:
-y SFDL:
-y WFRS:
2 MET:

E
E
E
E

EXZXX

-
-
-
-
-

=424 OPC_1
Ea objects
=AM

-, [New Defirition] —

Ly

Leaves I Item Mames

< M00T SER[OPC_1]M0.01
o MO_0 S¥[0OPC_1]MO_0

d| |

The lizted [tarm[z] will be added tao
S7-[0PC_1]M0.01

]9 | Cancel |

| [Mew Definition] iz zelected

|2/25/2004 | 2Z56PM
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After adding the item to Group1, OPC Scout displays name and other parameters for the item. You can
now use any of the methods supported by SIMATIC NET OPC server.

EEJOPC Scout - New Project1 : e =10] x|
File W¥iew Server Group Ihem 7

_I_IQI [ 30 [ 0] +|-—|

ewersand oLpE fltems incl. staluz information

= glg Serverls) ltem Names | Walue | Format | Type | Access
= 1B Local Server(s) 1 |S7[0PC_1]M0.01 Falze Onginal bool Riw
i dm OPC.SematicHMILPTE 2

F‘ @ OPC. Smaln:NET
{
[Ne.w gruup]
,‘Er OPC.SenaticMET.DP
i edy OPC.SmaticMNET.PD
= Jﬁ Remate Servels)
-y, Add Remote Servers(

| | ]

| Itemis) successhully added [Mo. [ o

Configuring the Items to be Accessed (Using the STEP 7 Symbol Table)

If you created a symbol table for the STEP 7 program that you downloaded, you can use the symbols for
connecting the OPC server to the data in the controller.

1. Open the OPC Navigator by double-clicking the connection (Group1) for the OPC server.

2. Browse to the folder for the controller to display the symbols that have been downloaded to the
controller.

,'FE} OPC-Navigator

Mes Iz Memss The listed Item(z] will be added to
=% Connections f

[ D
+ - \DPZ:
- A\DF:
+- @y AFOL:

2 Pump2  PCStationwinLC.
o O Pumpd  PCStation winLC.
: O Walvel PCStation ywinLC.
EEI---H VM O Walve?  PCStationwinLC.
[
£
[

-y ST [
-y SSNMP: .
+- [y SR =
=123 ASTM:

=143 PCStatian

‘ ) Fier | ok | Cancel |

|'winLC is selected |3/417/2004 | 2:302M
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3. After selecting the symbols for the data to be connected to the OPC server, click the Add button (--

>).
,ﬁr OPC-Mavigator il
Modes L l Item Mames The Iist_ed Ite_m[s] will be added Lo
=& Co nnechuns > Pumpl  PCStation WinLC. PCStation. WinLC. Pump1
- D O Pump2  PCStation WinLC,
g ﬁ tggz O Pump3  PCStationwinlC.
@8 VDL 2 Walvel PCStation \WinLC.
- AFMS: 0 Walve?  PCStationwinLC.
- A5
[y SSMMP: ‘-
-y \SR: -
=- a WS
=k a PCStation
..... a Wwinl
Bt | ok | Concel |
EN i
|WinLC i selected |317/2004 | 3:364M

4. Click the OK button to add the symbol to Group1.

After adding the item to the group, OPC Scout displays symbol name and other parameters for the STEP 7
symbol.

EZ oPc scout - New Project1 =101 ]

File “iew Serwer Group Ikem 7

= || 8l &8 [v o] +-|

|Sewers and groups |Items incl. ztatuz information
=-glg Serverls) ltem Names | Value | Format | Type | Access

EI Local Server(s) 1 57 [OPC_1]M0.01 Falze Original bl R
- B DPC.SimaticMET PCStation winlC.Pump False Original bool Rw
Groupl 3
[Mew graup]
L& OPC.SimatichNET.DR
. ody DPCSimaticNET.FD
E| Remote Server(s)

- \% Add Remate Servers(s]

P

| Iternfs] successully added [ M. [2 A
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Technical Data

Order Number
WiInLC is a component of the WinAC package: 6ES7 671-0CC03-0YAO

Features
WinLC provides the following features:
e Accumulators: 4 (ACCU 1 to ACCU 4)
¢ Communications: PROFIBUS-DP master device
e  Work memory: equal to the amount of physical memory in the computer

e Load memory: equal to the amount of memory (physical plus virtual) allowed by the Windows
operating system

e Distributed I/0 only, no local I/O: You can configure the size of the process-image 1/O areas (I and
Q memory areas) to be up to 8192 bytes. These memory areas can be accessed directly by the
instructions in the control program. Using Load (L) and Transfer (T) instructions (for statement list)
or the Assign Value (MOVE) instruction (for ladder logic) to the peripheral I/O (Pl and PQ memory
areas), you can access up to 16384 bytes of inputs and 16384 bytes of outputs.

WinLC communicates with the distributed I1/O as a PROFIBUS-DP master device. As a master device,
WinLC can communicate with up to 125 slave devices (either S7-DP slaves or other DP slaves).
Technical Specifications

The following table lists the technical information about WinLC.

WinLC Description
Work memory Limited to the amount of physical memory in the computer
Load memory Limited to the amount of memory (physical plus virtual)

allowed by the Windows operating system

Accumulators 4 (ACCU 1 to ACCU 4)

Local data 16 Kbytes per priority class (determined by HW Config,
Memory tab)

Clock Real-time system clock, based on the hardware clock of the
computer

I/O (digital and analog) 16384 bytes total I/0, addressable over a range of 0 to 16383

You can freely assign the 1/O between digital and analog
inputs and outputs. For example, you can assign all of
16384 bytes to the inputs or all of the 16384 bytes to the
outputs. However, the total amount allocated to all of the
inputs and outputs cannot exceed the maximum of
16384 bytes.
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WinLC

Process image I/O (user
configurable)

Memory bytes
Retentive range (configurable)

Preset as retentive

Counters
Retentive range (configurable)

Preset as retentive

Timers
Retentive range (configurable)

Preset as retentive

Clock memory

Address ranges for logic blocks
(FB, FC, and DB):

Number of connections

Nesting depth

Total number of blocks that can
be downloaded to WinLC

130

Description

Inputs: 512 bytes (default) or configurable from 0 bytes to
8192 bytes (1 0.0 to | 8191.7)

Outputs: 512 bytes (default) or configurable from 0 bytes to
8192 bytes (Q 0.0 to Q 8191.7)

2 Kbytes
Up to 2048 bytes (MBO to MB2047)
16 bytes (MBO to MB15)

512
CO to C511
8 (CO to C7)

512
TO to T511

None

8 bits of clock memory (1 byte)

8 frequencies within 1 byte of bit memory (M): address is
configurable

FBO to FB65535
FCO to FC65535
DB1 to DB65535 (DBO is reserved)

64

24 per OB in a priority class (sequence layer)

At any one time, a priority class can have one OB and up to
two synchronous OBs (OB121 and OB122). Each OB in the
priority class can have a nesting depth of 24.

No fixed limit: The number of blocks that can be downloaded
is based on the memory requirements and the number of
blocks in the program
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Caution

Downloading a control program that is too large for the memory of the computer can lock
up the computer or cause the operation of WinLC to become unstable. Non-responsive
or non-deterministic operations can cause damage to equipment and/or injury to

personnel.

Although STEP 7 and WinLC do not limit the number of blocks or the size of the control
program, your computer does have a limit, based on the available disk space and

RAM memory. The limit for the size of the control program and number of blocks for your
computer can only be determined by testing a configured system against the
requirements of your control application.

The following table lists specific information about the PROFIBUS-DP interface, as supported by WinLC.

PROFIBUS-DP interface
DP address area

Number of DP slaves supported
for each submodule CP card

Baud rate

Baud rate search (as a DP slave)
Transfer memory (as a DP slave)

Maximum distance

Description
16384 bytes (inputs) and 16384 bytes (outputs)

Dependent on the CP card
e CP5611:32
e CP5613:125

Up to 12 Mbaud:

9.6 KBPS, 19.2 KBPS, 45.45 (31.25) KBaud, 93.75 KBPS,
187.5 KBPS, 500 KBPS, 1.5 MBPS, 3 MBPS, 6 MBPS,
12 MBPS

Not applicable
Not applicable

Dependent on the baud rate
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Execution Times

Execution Times of Instructions

The execution times listed in the two tables below (execution times for math operations and execution
times for instructions) reflect the average execution times for STEP 7 programs running on WinLC. Actual
execution times may vary, depending on your system.

Note: The execution times were measured on a SINUMERIK PCU50 computer (with a single

1.2 GHz Celeron processor). Tuning settings: 9000 microsecond execution time limit, 90% maximum
execution load, and 1000 ps forced execution sleep. Actual execution times may vary, depending on
your computer.

Math Operation Integer Real Double Word
Addition ( +) 0.09 us 0.09 ps 0.09 us
Subtraction ( -) 0.09 us 0.09 us 0.10 us
Multiplication ( * ) 0.08 us 0.09 ps 0.13 us
Division (/) 0.13 us 0.11 s 0.13 us

Instructions Direct Indirect

Addressing Addressing

Boolean Operations: Memory areas: I 0.04 us 0.05 ps

A, AN, O, ON, X, XN
M 0.03 us 0.04 ps
L 0.03 ps 0.05 us
DB 0.03 us 0.05 ps
T 0.13 ps 0.17 s
C 0.05 us 0.05 ps

Boolean operations (on the accumulator): 0.04 ps

==|, <>|, >|, <|, >=|, <=|

Operations on the bits of the status word: 0.04 us

==0, A<>0, A>0, A<0, A>=0, A<=0
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Instructions Direct Indirect
Addressing Addressing

Transitional contacts Edge Positive FP 0.07 ps
Edge Negative FN 0.07 ps
Set/Reset operations Set S 0.06 us 0.04 ps
(bit operands)
Reset R 0.06 s 0.04 us
RLO Operations Negate RLO NOT 0.03 ps
Set RLO SET 0.01 ps
Clear RLO CLR 0.02 ps
Save RLO SAVE 0.03 ps
Operations on Timers Pulse Timer SP 0.17 s 0.17 us
Reset timer R 0.03 us 0.05 ps
Extended pulse SE 0.17 us 0.17 ys
timer
On-delay timer SD 0.17 s 0.17 us
Retentive on-delay SS 0.17 us 0.17 ps
timer
Off-delay timer SF 0.20 us 0.21 ys
Miscellaneous Open DB OPN 0.09 ps
Load L 0.04 us
Transfer T 0.05 us
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Execution Time of DP Instructions
The table below lists the execution times for the SFCs used with the distributed I/O for WinLC.

Note: The execution times were measured on a SINUMERIK PCU50 computer (with a single

1.2 GHz Celeron processor). Tuning settings: 9000 microsecond execution time limit, 90% maximum
execution load, and 1000 ps forced execution sleep. Actual execution times may vary, depending on
your computer.

SFC Name Description CP 5613
SFC11 DPSYNC _FR  Synchronize groups of DP slaves 1.12 ys
SFC13 DPNRM_DG Reads the diagnostic data of a DP slave 2.20 us

DP configuration tested: one ET 200M slave with one 8-
input/8-output module and one 16-output module

SFC14  DPRD_DAT Reads the consistent data from a DP slave 1.71 s
SFC15 DPWR_DAT Writes the consistent data to a DP slave 1.87 us
SFC26 UPDAT _PI Updates the process-image input table 0.83 ps

DP configuration tested: one ET 200M slave with one 8-
input/8-output module and one 16-output module

SFC27 UPDAT_PO Updates the process-image output table 16.30 us
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Performance Test: Scan Time Jitter

To determine a sample of potential jitter in the scan cycle, the performance of WinLC was tested on
a SINUMERIK PCU50 computer (with a single 1.2 GHz Celeron processor). Tuning settings:

9000 microsecond execution time limit, 90% maximum execution load, and 1000 us forced
execution sleep.

The results of this test are provided only as an example of possible jitter. The performance of your
application may vary, based on the configuration of your system and other parameters.

Based on the hardware configuration of your computer, and also the CPU utilization by other software
applications, the scan cycle for WinLC can experience jitter. For example, different video cards and IDE
hard drives can affect the specified performance of WinLC.

Configuration of WinLC for the Performance Text

To allow the maximum load on the CPU resources of the computer, WinLC was configured to run with the
following parameters for the performance test.

Tuning Parameter Value Description
Priority 29 "Real-time/Critical"
Minimum sleep time 10 ms Default settings
Minimum cycle time 0 ms
Execution time limit 9000 ps Default settings
Forced execution sleep 1000 us
Maximum execution load 90%

Control Program Used for the Performance Test

For the performance test, WinLC executed a control program that performed the following operations
during each scan cycle:

e The control program performed 3000 Boolean, 3000 Integer, and 3000 Floating Point operations.

e The control program read and wrote data to ET 200M I/O modules over a PROFIBUS-DP subnet
that consisted of three nodes.

e The control program performed calculations to determine the distribution of performance data.

Other Applications That Were Executed During the Performance Test
While WinLC executed the test program, the computer also executed the following applications:

e STEP 7 monitored WinLC operations by updating 512 double-words of data in the Monitor and
Modify Variables application.

e Two graphics-intensive test programs ran in infinite loops.

e Various Microsoft software applications (such as Word 2000, Excel 2000, Internet Explorer 5, and
Outlook 2000) were opened, used, and closed.
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Results of the Performance Test

As measured by the Windows Task Manager, the performance test produced the following results:
e The CPU utilization ranged between 99% and 100%.
e The average execution time of the WinLC program was 15 ms.

Actual performance may vary, depending on your system. The following figure provides a graphical
summary of the potential jitter that could be experienced in the execution of a control program.
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Troubleshooting

Troubleshooting Network Problems

WinLC helps you diagnose DP network problems. The control panel provides two status indicators (EXT1
and BUSF) that can be used to diagnose problems with the PROFIBUS-DP network. The table below
describes the activity of the EXTF and BUSF indicators to help you determine the type of problem and a
possible solution.

EXTF

Off

BUSF

Off

Flashing

On

Off

Description

No configuration

Normal operation

Station failure

At least one of
the DP slaves
could not be
accessed

Bus fault
(hardware
failure)

Diagnostic error

Action

Ensure that the DP configuration has been entered into
your STEP 7 project. Download the project's System Data
container to WinLC.

The configured DP slaves are responding. No action is
required.

Check to see that the bus cable is connected to WinLC
(the CP card) and that all segments are correctly
terminated at powered nodes.

Check to see that the bus is not interrupted.

Wait for WinLC to complete the power-on cycle. If the
indicator continues to flash, check the DP slaves or
evaluate the diagnostic data for the DP slaves.

Check the bus cable for an electrical short, or a broken
wire or connection.

Indicates that a fault condition has not been cleared or
that a DP module with diagnostic capability has initiated
0OB82.

In addition to these visual indicators, you can use the Diagnose Hardware feature of the STEP 7
programming software to determine which nodes are experiencing problems and to determine the nature of
the problem.
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Responding to Diagnostic Events

If an error is detected by the controller, the error condition is logged in the diagnostic buffer as a diagnostic
event. The diagnostic events that are typically associated with distributed 1/0 can cause the controller to
execute the following OBs:

e OB40 responds to hardware interrupts (process alarms) generated by an /0O module with
configured interrupt capability.

o 0OBB82 responds to diagnostic interrupts generated by an 1/0 module with configured diagnostic
interrupt capability.

e OB83 responds to module removal/insertion at a DP Slave, (for example, ET200M), which has
been configured for module pull/plug support.

e OB85 responds to a priority class error. There are multiple causes for OB85 relating to the DP I/O
system. If the controller attempts to copy a module's inputs to (or outputs from) the process image
during the I/O cycle, and the module is not operational, then an OB85 is executed.

o OBB86 responds to a station failure or some other interruption of the physical network (such as a
short circuit).

e 0OB122 responds to an I/O access error by the user program. If OB122 is not programmed, the
controller goes to STOP mode.

You can use SFC39 to SFC42 to disable, delay, or re-enable any of these OBs. If an OB is requested and
the OB has not been downloaded to WinLC, the controller goes to STOP mode.

The local variables for these OBs contain startup information indicating the cause for executing the OB.
The program for the OB can use this information for responding to the event. You can also use SFC13
(DPNRM_DG) to read the diagnostic information from a DP slave.

For information about using OBs and SFC13, see the online help for STEP 7 or the System Software for
S7-300/400 System and Standard Functions Reference Manual. To view this manual from a computer
where STEP 7 is installed, select the Start > Simatic > Documentation > English menu command and
then double-click "STEP 7 - System and Standard Functions for S7-300 and S7-400".
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System Status List (SSL)
Using SFC51 to Read the SSL

STEP 7 stores read-only information about the controller in the system status list (SSL) as a set of

sublists.

You use SFC51 (RDSYSST) to access the entries in the SSL. You supply the input parameters
SSL_ID and Index to access the records stored in the sublist. SFC51 returns a two-word header
and a sublist or partial sublist. The header provides the following information about the sublist:

e The first word defines the length (size in bytes) of a record for the sublist.

e The second word defines the number of records contained in the sublist.

The requested information follows the header. The size of the sublist in bytes is the record length

times the number of records.

Note: The SSL_ID and Index values are represented as hexadecimal (16#) numbers.

For more information about the system status list, see the online help for STEP 7 or the System
Software for S7-300/400 System and Standard Functions Reference Manual. To view this manual

from a computer where STEP 7 is installed, select the Start > Simatic > Documentation > English

menu command and then double-click "STEP 7 - System and Standard Functions for S7-300 and

S7-400".

WinLC supports the following SSL entries:

SSLID

0000, 0100, 0200, 0300,
0FO00

Module Identification
011, 0111, OF11

CPU Characteristics
0012, 0112, OF12

Memory Areas
0013, 0113, OF13

System Areas
0014, 0114, OF14

Block Types
0015, 0115, OF 15

Local Module LED Status
0019, 0119, OF19

Component Identification
001C, 011C, OF1C

Interrupt and Error Assignment
0021, 0121, 0221, 0921, 0A21,
0F21

Interrupt Status

0222

Priority Class
0023, 0123, 0223, 0F23

CPU Operating Mode
0124, 0424, 0524, 0F24

Process Image Partitions
0025, 0125, 0225, 0F25

Communications Performance
0131

Communications Status
0132, 0232

LED Status
0074, 0174, OF74

OB Start Events
0782

DP Master System
0090, 0190, OF90

Module Status
0A91, 0C91, 0D91, OF91

Rack and Station Status
0092, 0192, 0292, 0692

Expanded DP Master
0195, OF95

Diagnostic Buffer
00AO, 01A0, OFAO0

Module Diagnostics
00B1, 00B3, 00B4
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SSL_ID Descriptions

SSL_ID 0x00 (SSL ID)
0000, 0100, 0200, 0300, OF00 (hexadecimal)

SSL_ID Sublist Index and Contents of the Record
0000 Complete listing of the SSL IDs All of the SSL IDs supported by the module
0100 SSL IDs for a specific SSL ID 00yy, where yy = the SSL ID group: Lists the

group SSL IDs or the specified group of SSL IDs

For example: 0100/0024 lists the indexes for the
SSL ID 0x24 group (CPU Operating Mode) that
were implemented by WinLC (0024, 0124,
0424, 0524, and 0F24)

0200 Valid (available) SSL ID 0zzz, where zzz = the SSL ID to be verified:
e Ifthe SSL ID is valid, returns the index
number

e Ifthe SSL ID is invalid, returns a
negative number

0300 All of the indexes for a specific 0zzz, where zzz = the SSL ID: Lists all of the
SSL ID possible indexes for the specified SSL ID

For example: 0300/0113 lists the indexes for
SSL ID 0113 that were implemented by WinLC
(0001, 0002, 0003, 0004, 0005, and 0006)

OF00 Header information only Displays the number (quantity) of SSL IDs that
were implemented by the module

SSL_ID 0x11 (Module ldentification)
0011, 0111, OF11 (hexadecimal)

Note: SSL_ID 0x11 does not provide information about submodules.

SSL_ID Sublist Index and Contents of the Record
0011 All of the information for a module Order number, module type, version, and firmware
version
0111 Specific information for a module 0001: Order number, module type, and version

0007: Firmware version

OF11 Header information only
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SSL_ID 0x12 (CPU Characteristics)
0012, 0112, 0OF12 (hexadecimal)

SSL_ID Sublist Index and Contents of the Record

0012 All characteristics for a module MC7 processing unit, time system, system response,
and MC7 language description

0112 One specific group of 0000: MC7 processing unit
characteristics 0100: Time system
0200: System response

0300: MC7 language description

0F12 Header information only

SSL_ID 0x13 (Memory Areas)
0013, 0113, OF13 (hexadecimal)

SSL_ID Sublist Index and Contents of the Record
0013 All of the memory areas for a Type, size, and other parameters for each memory
module area
0113 Specific memory area 0001: User memory

0002: Load memory integrated

0003: Load memory inserted

0004: Maximum insertable Load memory
0005: Backup memory

0006: Peer-to-peer memory (shadow memory)

OF13 Header information only
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SSL_ID 0x14 (System Areas)
0014, 0114, OF14 (hexadecimal)

Note: Index 0008 displays the size of the bit memory (M) in bytes (instead of bits, as shown by
index 0003), and index 0009 displays the size of the local memory (L) in Kbytes (instead of bytes, as
shown by index 7). Use index 0008 and index 0009 to display information for controllers that have
large memory capacity.

SSL_ID Sublist Index and Contents of the Record
0014 All system memory areas for ~ Size and other parameters for each area of system memory
a module
0114 Specific area of system 0001: Input (I) memory area (in bytes)
memory

0002: Output (Q) memory area (in bytes)

0003: Bit Memory (M) area (in bits)

0004: Timer (T) memory area (number of timers)
0005: Counter (C) memory area (number of counters)

0006: Peripheral input (P1) and peripheral output (PQ)
memory areas (in bytes)

0007: Local (L) memory area (in bytes)
0008: Bit Memory (M) area (in bytes)
0009: Local (L) memory area (in Kbytes)

OF14 Header information only

SSL_ID 0x15 (Block Types)
0015, 0115, OF15 (hexadecimal)

SSL_ID Sublist Index and Contents of the Record
0015 All block types for a module Maximum number and size for each type of block
0115 Specific block type 0800: OB (number and size)

0AOQ0: DB (number and size)
0B00: SDB (number and size)
0CO00: FC (number and size)
0EO0O0: FB (number and size)

0F15 Header information only
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SSL_ID 0x19 (Local Module LED Status)
0019, 0119, OF19 (hexadecimal)

Note: SSL_ID 0x19 supports local, non-redundant CPUs. You can use SSL_ID 0x19 with a
redundant H CPU only when the H CPU is in a non-redundant operating mode. Use SSL_ID 0x74 to
access information for a redundant H CPU.

SSL_ID Sublist Index and Contents of the Record
0019 All of the LEDs for the local module Status for all of the LEDs
0119 Specific LED for the local module 0002: INTF (Internal failure)

0003: EXTF (External failure)
0004: RUN (Run)

0005: STOP (Stop)

0006: FRCE (Force)

0008: BATF (Battery failure)
000B: BUSF1 (submodule 1 fault)
000C: BUSF2 (submodule 2 fault)
0012: BUSF3 (submodule 3 fault)
0013: BUSF4 (submodule 4 fault)

O0F19 Header information only

SSL_ID 0x1C (Component Identification)

0x1C (hexadecimal)

SSL_ID Sublist Index and Contents of the Record
001C All of the information for a Controller name, module name, module tag, copyright,
component serial number, project ID, module type, and

manufacturer information

011C Specific element for the 0001: Name of the controller
component 0002: Name of the module
0003: Module tag
0004: Copyright entry
0005: Serial number
0007: Module type

0009: Manufacturer and profile identification

OF1C Header information only
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SSL_ID 0x21 (Interrupt and Error Assignment)

0021, 0121, 0221, 0921, 0A21, OF21 (hexadecimal)

SSL_ID)

0021

0121

0221

0921

0A21

OF21

144

Sublist

All of the OBs supported by the
module

All possible OBs for a specific
priority class

Specific OB

All of the OBs for a specific priority
class that have been downloaded to
the module

All of the OBs that have been
downloaded to the module

Header information only

Index and Contents of the Record

Priority class and OB number

00: Free cycle (OB1)

OA (or 10 decimal): Time-of-Day OBs

14 (or 20 decimal): Time-Delay OBs

1E (or 30 decimal): Cyclic OBs

28 (or 40 decimal): Hardware OBs

32 (or 50 decimal): Communication and DP OBs
50 (or 80 decimal): Asynchronous Error OBs

64 (or 100 decimal): Startup OBs
78 (

or 120 decimal): Synchronous error OBs
OB number: Priority class and OB number

00: Free cycle (OB1)

OA (or 10 decimal): Time-of-Day OBs

14 (or 20 decimal): Time-Delay OBs

1E (or 30 decimal): Cyclic OBs

28 (or 40 decimal): Hardware OBs

32 (or 50 decimal): Communication and DP OBs
50 (or 80 decimal): Asynchronous Error OBs

64 (or 100 decimal): Startup OBs
78 (

or 120 decimal): Synchronous error OBs

Priority class and OB number
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SSL_ID 0x22 (Interrupt Status)
0022, 0122, 0222, 0822, 0922, 0F22 (hexadecimal)

SSL_ID
0022

0122

0222

0822

0922

0F22

Sublist
All of the OBs

OBs for a specific priority class

Start event for a specific OB

OBs for a specific priority class
being used by the module

All of the OBs being used by the
module

Header information only

Index and Contents of the Record
All of the OBs that are supported by the module

Priority class: All of the OBs that are supported by the
module for the specified priority class

OB number: Start event and time for the requested OB

Priority class: All of the OBs of the specific priority
class that have been downloaded to the module

All of the OBs that have been downloaded to the
module

Note: For a list of the OBs supported by WinLC, refer to the following topics: Logic Blocks
Supported by WinLC and Organization Blocks (OBs).

SSL_ID 0x23 (Priority Class)
0023, 0123, 0223, 0F23 (hexadecimal)

SSL_ID

0023

0123

0223

0F23

Sublist

All of the priority classes

Specific priority class

Priority classes for the OBs being

used by the module

Header information only

Contents of the Record

Information about all of the priority classes
supported by the module

Priority class: Information about that specific
priority class

Information about the priority classes of the OBs
that have been downloaded to the module
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SSL_ID 0x24 (CPU Operating Mode)
0124, 0424, 0524, OF24 (hexadecimal)

SSL_ID Sublist
0124 Operating mode transition
0424 Current operating mode
0524 Specific operating mode
0F24 Header information only

SSL_ID 0x25 (Process Image Partitions)
0025, 0125, 0225, OF25 (hexadecimal)

SSL_ID Sublist
0025 All process image partitions
0125 Process image partition for a specific
OB
0225 OBs assigned for a specific process
image partition
0F25 Header information only
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Index and Contents of the Record
Last change of operating mode
Current operating mode of the module

4520: Defective mode
5000: STOP mode
5010: STARTUP mode
5020: RUN mode
5030: HALT mode

Index and Contents of the Record

Process image partitions for all of the OBs that
have been downloaded to the module

Partition number: OB configured for that partition

OB number: Partition assigned for that OB
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SSL_ID 0x31 (Communications Performance)
0131 (hexadecimal)

SSL_ID Sublist Index and Contents of the Record

0131 Specific set of parameters ~ 0001: Number of connections and baud rates
0002: Test and startup parameters
0003: Operator interface parameters

0004: Object management system (operating system
function)

0005: Diagnostic functions and diagnostic entries
0006: Peer-to-peer performance parameters

0009: Number of run-time meters

SSL_ID 0x32 (Communications Status)
0132, 0232 (hexadecimal)

SSL_ID Sublist Index and Contents of the Record

0132 Specific set of parameters 0001: Number and type of connections
0002: Connections configured
0003: Operator interface
0004: Protection level and mode switch selection
0005: Diagnostics
0006: Peer-to-peer status data
0008: Time system
000A: Baud rate

0232 Parameters for a redundant 0004: Protection level and mode switch selection
system (H CPU)
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SSL_ID 0x74 (LED Status)
0074, 0174, OF74 (hexadecimal)

Note: Use SSL_ID 0x74 to access information about LEDs for any module, including a redundant

H CPU module. See also SSL_ID 0x19.

Index and Contents of the Record

Status for every LED of the module

0002: INTF (Internal failure)

0003: EXTF (External failure)
0004: RUN (Run)

0005: STOP (Stop)

0006: FRCE (Force)

0008: BATF (Battery failure)
000B: BUSF1 (submodule 1 fault)
000C: BUSF2 (submodule 2 fault)
0012: BUSF3 (submodule 3 fault)
0013: BUSF4 (submodule 4 fault)

SSL_ID Sublist
0074 All of the LEDs
0174 Specific LED
OF74 Header information only

SSL_ID 0x82 (OB Start Events)
0782 (hexadecimal)

SSL_ID Sublist

0782 Start event for each OB of a specific

priority class that have been schedule to
run but have not yet started

SSL_ID 0x90 DP Master System
0090, 0190, OF90 (hexadecimal)

SSL_ID Sublist
0090 All DP masters configured on the
network and downloaded to the module
0190 Specific DP master
0F90 Header information only
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Index and Contents of the Record

Priority class: Event, priority class, and
OB number

Index and Contents of the Record

DP master identifier, address, and attributes
for all DP masters

DP master identifier: Address and attributes
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SSL_ID 0x91 (Module Status)
0A91, 0C91, 0D91, OF91 (hexadecimal)

SSL_ID Sublist

0A91 All of the DP masters

0C91 Specific module, identified by the logical
base address

0D91 Specific station, identified either by
rack/station, by DP master identifier, or
by DP master identifier with station
number

0F91 Header information only

SSL_ID 0x92 (Rack and Station Status)
0092, 0192, 0292, 0692 (hexadecimal)

SSL_ID Sublist

0092 Expected status of the stations of a
DP master

0192 Configuration and activation status for the
stations of a DP master

0292 Actual status for the stations of a
DP master

0692 OK state for the stations of a DP master

0F92 Header information only

Index and Contents of the Record

DP master identifier, address, and module
information for each DP master in the network
configuration that was downloaded to the
module

Logical base address: Features and parameters
of the specified module

Station identifier: Features and parameters for
all the modules of the specified station

Index and Contents of the Record

0: Local DP master

DP master identifier: Specific DP master

0: Local DP master

DP master identifier: Specific DP master

0: Local DP master

DP master identifier: Specific DP master

0: Local DP master

DP master identifier: Specific DP master
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SSL_ID 0x95 (Expanded DP Master System)
0195, OF95 (hexadecimal)

SSL_ID

0195

OF95

Sublist

Specific DP master

Index and Contents of the Record

DP master identifier: Properties for the stations of the specified

DP master (such as DP mode, equidistant mode and cycle,
clock synchronization, and transmission rate)

Header information only

SSL_ID 0xAO0 (Diagnostic Buffer)
00AO0, 01A0, OFAO (hexadecimal)

SSL_ID

00AO

01A0

OFAO

Sublist

All of the entries in the diagnostics buffer

Most recent entries in the diagnostics
buffer

Header information only

Index and Contents of the Record

Event information for every event listed in the
diagnostics buffer

Number: Event information for the specified
number of entries in the diagnostics buffer

SSL_ID 00B1, 00B3, and 00B4 (Module Diagnostics)
00B1, 00B2, 00B4 (hexadecimal)

Note: The information varies according to the type of module specified.

SSL_ID

00B1

00B3

00B4
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Sublist

Diagnostic information (4 bytes) for a specific
module, identified by the logical base
address

All of the diagnostic information for a specific
module, identified by the logical base
address

Specific DP slave, identified by the
configured diagnostic address

Index and Contents of the Record

Logical base address: First 4 bytes of
the diagnostic information

Logical base address: Complete
diagnostic information

Diagnostic address: Standard
diagnostic information for a DP station
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C

Cold Restart: The controller executes OB102 before starting the free cycle (OB1). Like a warm restart, a
cold restart resets the peripheral inputs (Pl) and changes the peripheral outputs (PQ) to a pre-
defined safe state (default is 0). However, a cold restart does not save the retentive memory (M, T,
C, or DB), but sets these areas to their default (initial) values.

Control Program: The control program is the application program created with STEP 7 and downloaded to
the controller for execution. The control program includes all organization blocks (such as OB1 or
OB35) and the other logic blocks that they call, including functions (FCs), system functions (SFCs),
function blocks (FBs), and system function blocks (SFBs).

E

Execution Monitor: The execution monitor of the controller measures the time that the controller sleeps
and ensures that the controller does not exceed the maximum execution load. The execution
monitor uses the maximum execution load and the execution time limit to calculate the forced
execution sleep time.

Execution Time: The execution time is the actual time the controller takes to complete one pass through
the instructions of the control program. This includes executing OB1 and updating the 1/O.

Execution Time Limit: The execution time limit defines the maximum amount of time allowed for the
controller to execute the control program. The execution monitor uses this value and the maximum
execution load to calculate the forced execution sleep time.

F

Forced Execution Sleep Time: This read-only field shows how much sleep time (in microseconds) is
required during the monitor interval to meet the maximum execution load requirement.

Free Cycle: The free cycle consists of the basic tasks for priority class 1: writing to the outputs, reading the
inputs, executing OB1, and completing the sleep time requirement before triggering the next free
cycle. The controller executes these tasks at the base, or lowest, internal priority level for executing
the OBs. (Priority level in this context refers to OB priority classes, not the operating system priority
level.)

J

Jitter: Jitter is the difference in the actual scan cycle time from the configured minimum scan time.

Maximum Execution Load: The maximum execution load is the maximum percentage of CPU usage that
is allocated for the controller. The execution monitor uses this value and the execution time limit to
calculate the forced execution sleep time.

Minimum Cycle Time: The minimum cycle time is the minimum number of milliseconds from the start of
one cycle to the start of the next cycle. You enter a value for the minimum cycle time when you use
STEP 7 to configure the system data for the controller. You can use the tuning panel to adjust this
value as you test the performance of the controller. After you have tuned the performance of the
controller, use STEP 7 to enter the optimum cycle time value and download the new system data.
Any value for the cycle time that you enter with the tuning panel is overwritten by the value in the
system data when the controller changes from STOP mode to RUN mode.
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Minimum Sleep Time: The minimum sleep time is the specific amount of time that the controller must wait
before starting the next scan cycle. You use the tuning panel to configure this parameter. The
controller uses the minimum sleep time and the minimum cycle time parameters to calculate the
start of the next scan cycle.

Monitor Interval: The length of time used by the execution monitor in determining whether to add a forced
sleep time. The monitor interval is the sum of the execution time limit and the forced execution
sleep time that is calculated based on the maximum execution load percentage.

O

Organization Block (OB): The OBs represent the interface between the operating system and the control
program. Called by the operating system, they control cyclic and interrupt-driven program
execution, startup behavior of the controller and error handling.

P

Priority: The priority of an application determines the order in which the operating system executes or
interrupts an application in relation to the other applications that are running on the computer. An
application with a higher priority interrupts and suspends the execution of an application with a
lower priority. After the application with the higher priority finishes, the application with the lower
priority resumes. A higher number indicates a higher priority.

Priority Class: The priority class determines the order in which the controller executes the individual
sections of the control program. Organization blocks (OBs) are ranked by priority class. Higher
priority OBs interrupt lower priority OBs. The free cycle (OB1) has the lowest priority. You can use
STEP 7 to change the priority class for an OB. A higher number indicates a higher priority class.

R

Restart Method: The restart method determines which startup OB is executed whenever the controller
changes from STOP mode to RUN mode. The startup OB allows you to initialize your control
program and variables. The two restart methods are Cold Restart (OB102) and Warm Restart
(OB100).

S

Scan Cycle: The scan cycle includes writing to the outputs, reading the inputs, executing OB1and all other
OBs, and completing the sleep time requirement.

Scan Cycle Time: The scan cycle time is the time required to execute the complete scan cycle, which
includes the execution of OB1 and the minimum sleep time.

Sleep Time: The sleep time is the difference between the execution time of the free cycle and the total
scan time. Sleep time measures the time between the completion of OB1 and the start of the next
scan cycle, and ensures that the next scan cycle does not start until the end of the sleep interval.
However, if the start event for an interrupt OB (such as OB40) occurs during the sleep time, the
controller executes that OB.

System Function (SFC): An SFC is a preprogrammed function that is integrated as a part of the operating
system of the controller and is not downloaded as part of the control program. You can call the
SFC in your control program. Like a function (FC), an SFC is a block "without memory."

System Function Block (SFB): An SFB is a function block that is integrated as a part of the operating
system of the controller and is not downloaded as part of the control program. Like a function block
(FB), an SFB is a block "with memory." You must also create an instance data block (DB) for the
SFB. The instance DB is then downloaded to controller as part of the control program.
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W

Wait Time: The wait time, or sleep time, is the time that the controller is not using the CPU. During this
time, the operating system can run other applications.

Warm Restart: The controller executes OB100 before starting the free cycle (OB1). A warm restart resets
the peripheral inputs (PIl) and changes the peripheral outputs (PQ) to a pre-defined safe state
(default is 0). The warm restart also saves the current value for the retentive memory areas for the
memory bits (M), timers (T), counters (C), and data blocks (DBs).
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A
Above-normal priority,
Access points,
Access verification dialog,
Accessing WinLC from STEP 7,[51]

Adding blocks to Load memory with SFC82 and
SFC84, [44]

Adding sleep time,
Addresses,
diagnostic,
distributed 1/0, [62]
logical addresses,
Adjusting, [97]
minimum scan cycle time,
minimum sleep time,
priority,
sleep-monitoring algorithm,
Advanced tuning,
Alarms,m
All indicators flashing,
Always on top option,
Archiving,
Assigning addresses,

Assigning names, @
Asynchronous threads,

Authorization,
installing,
removing,

AuthorsW program,

Autostart,

Autostart CPU,

Avoiding jitter,[100][101][107]

B
Background priority,
Basic tasks,

BATF status indicator,

Battery fault,

Baud rate,m

Blue Screen, El
BRCV, [70][8q]

BSEND, [70}[80]

BUSF1 status indicator,

BUSF2 status indicator,

C
Change Password dialog,
Changing,

CPU keyswitch position, [30]

mode buttons,

operating mode,

password,

priority,

sleep-monitoring algorithm,|101,{107 |
Characters (invalid) for instance name,

Clock,
Clock memory,

Closing the control panel,
Cold restart,
retentive memory,
Commands
Diagnostic buffer,
MRES (memory reset),
Options
Customize,
Security,

Tuning panel,
Commissioning wizard,g
Communication, ,
commissioning the CP card, @
DPV1 extensions,
getting started tasks,
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peer-to-peer,
with 1/O devices,

Computer requirements, H
Configuration console, @
Configuring,

clock memory,
communications,

controller communications,
CP card as submodule,
CP card in PC station,@
cycle/clock memory,

cyclic interrupt,
diagnostics/clock,

DP addresses,
interrupts,

memory,

operational parameters,

PC station,

project in STEP 7,[26]

retentive memory,

scan cycIe,

startup,

startup characteristics,
submodule,

time-of-day interrupt,
Connecting to the OPC server,m
Context-sensitive help, El
CONTROL, [70][80]
Control panel,

opening and closing,

status indicators,
Control program,

archiving,

changing keyswitch position,

deleting,

downloading,

restoring,
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Controller,
autostart,
configuring communications,

configuring in PC station,
configuring in STEP 7,
invalid characters,
memory reset changes,
naming,

restart method,

scan cycIe,

setting priority,
shutting down,
starting,
startup,

status indicators,
submodule,

system status list (SSL),
Correction factor for clock,

CP 5613 card, [26]

cp care, B [ i) el EO

commissioning, Q
configuring as submodule,
configuring in STEP 7,
PC station component,
CPU indicators,
CPU menu
diagnostic buffer,
MRES (memory reset),
options
customize,
security,
tuning panel,
CPU usage,
jitter,
Creating,
archive file,
password,
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submodule,
Customize command (CPU menu),
Cycle time,
Cycle/clock memory,
Cyclic interrupt,

D

Dashes (in the controller name),
Data retention,
Defective state,
Deterministic scan cycle,
Diagnosing hardware,m
Diagnostic addresses for DP I/O,
Diagnostic buffer,

saving the contents,
Diagnostic events,
Diagnostic interrupts,
Diagnostics/clock,
Display Ianguage,
Distributed 1/0, [1}[129]
Downloading a control program,
DP instructions,m

DP network,

assigning addresses,
troubleshooting,
DPV1 extensions,
E
Edit component dialog,
Eliminating forced sleep interval,|107
English language option,
Error OBs,
Errors,
Events, diagnostic,
Execution,
adjusting priorities,
0B10,
Execution monitor,
Execution time,

134
DP instructions,m
instructions and math operations,m

SFBs, [80]

SFCs,[75]
Execution time limit,{101
External power suppIy,
EXTF status indicator,

F

Features of WinLC,El
File menu

Archive command,

Restore command,
Forced execution sleep time,
Format for diagnostic buffer,
Forward slash (illegal character),
FRCE status indicator, [33]
Free cycle,
French language option,
Full-text search, El

G
German language option,
GET,
Getting started, El

H

Hardware configuration,

clock memory,

cyclic interrupt,
interrupts,
OBs,

operational parameters,
retentive memory,

scan cycle,

startup characteristics,
time-of-day interrupt,

Hardware interrupts,

Help menu
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Using help,@
Help on diagnostic buffer,
Hyphen in the controller name,

|
I/0O access error,

I/0O device communication,
IF slot,
Index (PC station sIot),
Indicator Iights,
Inserting sleep time,
Installation requirements,H
Installing,
Privilege requirements, @
SIMATIC NET, fg
WinAC authorization,
WinAC components, Q
Instance, invalid characters,
Instructions,
Interface slots,
Interrupt OBs,
Interrupts,

INTF status indicator,

Invalid characters for controller names,

J
performance testing,
reducing,
tuning panel,

K
Keyswitch position,
L

Language selection,

LED indicators, [1}[33]
Load memory,

Adding blocks with SFC82 and SFC84, [44]

Logic blocks,
OBs,
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SFBs, [80]
SFCs,[75]
Logical address,
M

Main program cycle,
Managing sleep time,
Math operations,m
Maximum execution Ioad,
Memory,
configuring,
requirements, H
retentive,
saving and restoring,
specifications,m
Memory areas,
Meter, run-time,
Minimum scan cycle time,
Minimum sleep time,

107
Minus sign (in the controller name),
Mode Buttons,
Module removal/insertion,m
MPI, [24]
MRES, [

N

Names, @
assigning,

Naming an instance of the controller (invalid

characters),
Network,[137
protocols,
STEP 7 communications,
troubleshooting,

Normal priority,

o
oe1 [i9 3 e8]
0B10, 52} [59)
08100, 19 B4 B30T
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0B100 and 0B102,[42][54]
0B102,[49] [54)[101]
0B122,[138]
0B20,[52][60][7]
0B32 to 0B36, [52] [61][107]
os3s 521 3 Ealeriotlfior]
o840 52638 BT 01][138
0B61,[101]
0B80, [6]
0B80 to OB87,[60]
0B82, [52|[138]
0B83, [52|[138]
0B85, [52|[101][138]
0B86, [52|[138]
OBs,
execution,
supported by WinLC,
ON status indicator,
OPC server,
Opening the control panel,
Operating mode,
at startup,
RUN, [30]

RUN-P,

status indicators,

STOP, [30]

User privileges required,@
Operating system threads,
Operational parameters,
Optimizing performance,
Order number,
Organization blocks,
Overview,

P

Panel,
opening and closing,
status indicators,

Part number,m

Password,
changing,
creating,

PC station, @

configuring with SIMATIC NET,
configuring with STEP 7,[26]
CP card as component,lg
CP card as submodule,
OPC server,m

PC-based controller,

scan cycIe,
starting,
PCl slot,
Peer-to-peer communications,
Performance,
test for jitter,m
Personal computer, H
PG/PC interface, [24]

Power failure,
Power supply,
Power-Down State,
adjusting,
cyclic interrupts,
interrupt OBs,
OBs,
setting,

Priority class error,m

Privileges, [

Product overview,

PROFIBUS-DP, [1]J20,]24,]129 ]
assigning addresses,
communicating with I/O,
CP card submodule,
DPV1 extensions,
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logical addresses,
network troubleshooting,
specifications,m
Programming error,
Protocols,
PUT,
R

Rack failure,

RAM requirements,@

RDSYSST (SFC51),[139]

Real-time priority (Windows),
Real-time system clock,
Recovering from a defective state,

Register Controller for Start at PC Boot
Command (CPU menu),

Removing,
Authorization,

Removing WInAC software,
Renaming the controller (invalid characters),
Requirements, @
Resetting memory areas,
Resources (computer),
Responding to diagnostic events,m
Restart,

autostart feature,

characteristics,

retentive memory,

selecting method,
Restoring,
Retentive memory,

Ring ON button,

RUN,
RUN status indicator,
RUN-P,
Run-time meter,
S

spn e 5558 BB
135
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configuring,
jitter,
monitoring,
SDBO, [52)
Security,
Security command (CPU menu),
setting Ievel,
Selecting,
autostart,
Ianguage,
restart method,

Service,

starting the controller after reboot,

Setting,
PG/PC Interface,
priority,
security options,
Setup, ,
SFBs,
execution times,
peer-to-peer communications,
supported by WinLC,
SFCO,
SFC1,[82]
SFC11,[134]
SFC13,[134][138]
SFC14,
SFC15,
SFC22,
SFC26,[134]
SFC27,
SFC39,[138]
SFC42,[138]
SFC47 (WAIT),[83]
SFC51,[139)]
SFC62,
SFC64,
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SFC82,[42] [44]
sFcs3, [42)[44]
SsFcs4,[42)[44]
SFCs,[75]

execution times,

reading the system status list,|139

SSL IDs supported,
supported by WinLC,
Shutting down,

SIMATIC NET, 2 [9,[14]

OPC server,m
Slash (illegal character),
Sleep management techniques,
Steep time. 5| [£3 £6) 3 A foul[f0][fo7]
Sleep-monitoring algorithm, (83,]93,|97,[101,[107 |
Specifications,m
SSL ID,[139]

0x00,[140]

0x11,

0x12,[141]

0x13,[141]

0x14,]142

0x15,[142)

0x19,]143

0x1C,[143]
0x21,[144]
0x22,[145]
0x23,[145]
0x24,[146|
0x25,[146|
0x31,[147]
0x32,[147]
0x74,[148|
0x82,[148|

0x90,/148
0x91,]149

0x92,[149]

0x95,]1150

0xAO,[150]
0xB1,[150]
0xB3,[150]
0xB4,[150]

assignment of interrupts and errors (0x21 ),
available SSL IDs,

available SSL IDs (0x00),

backup memory (0x1 3),

block types (0x15),

C memory size (0x14),
communications performance (0x31),

communications status (0x32),|147
component identification (0x1C),
contents (SSL IDs supported),
CPU characteristics (0x12),

CPU LED status (0x74),[148]

CPU LED status, local only (Ox19),
CPU operating mode (Ox24),

DB number and size (Ox15),
diagnostic buffer (0xA0),

DP master system (0x90),

DP master system, expanded (0x95),[150

DP_module diagnostics (00B1, 00B3, 00B4),
150|

DP module status (0x91),

DP rack/station status (Ox92),

error assignment (0x21),

events that start OBs (Ox82),
expanded DP master system (0x95),
FB and FC number and size (0x15),
H CPU LED status (0x74),[148]

| memory size (0x14),

identification, module (0x11),/140
indexes for an SSL ID (0x00),[140
interrupt and error assignment (0x21 ),

interrupt status (0x22),
L memory size (0x14),
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LED status for redundant modules (0x74),
LED status, local only (0x19),

list SSL IDs (0x00),[140]

Load memory (0x13),

local CPU LED status (0x74),[148]
local module LED status (0x19),[143]
M memory size (0x14),

master system (0x90),

maximum number and size of blocks (0x15),
|142

memory area sizes (0x14),(142

memory areas (0x13),{141

mode, CPU (0x24),[146

module diagnostics (00B1, 00B3, OOB4),
module identification (0x11),

module LED status, local and redundant CPU
(0x74),|148

module LED status, local only (0x19),
module status (0x91),[149]

OB number and size (0x15),

OB priority class (Ox23),

OB start events (0x82),

operating mode (0x24),

order number (0x11),/140

peer-to-peer memory (0x13),
performance, communications (0x31),
Pll memory size (0x14),

PIQ memory size (Ox14),

priority class (0x23),[145]

process image partitions (0x25),

Q memory size (0x14),

rack/station status (0x92),

redundant CPU LED status (0x74),[148]
SDB number and size (0x15),

SFC51,[139)]

shadow memory (0x13),{141

size of blocks (0x15),

size of the memory areas (0x14),
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size of user memory areas (0x13),

SSL ID (0x00),[140]

SSL IDs supported,|139

start events, OBs (0x82),
station, module status (0x91 ),
status, communications (0x32),
system areas (0x14),

T memory size (0x14),

types of blocks (0x1 5),

User memory (0x13),

verify SSL ID (0x00),

version number (0x11),

Start date/time (OB10),

Start event,

Starting a controller name with a hyphen (dash or
minus sign),

Starting the controller,
Startup,
autostart,
configuring,
restart method,

Station configuration editor,

Station failure,

STATUS,
Status indicators, ,
STEP 7,[51]

accessing WinLC,

configuring PC station,

configuring the controller,

connecting to WinLC,

hardware configuration,

OPC server,m

renaming the controller (invalid characters),
SSL IDs supported,|139

system status list (SSL),
STOP, [30} [33]
Submodule,
CcP card,
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communications performance (0x31),
communications status (0x32),
component identification (0x1C),|143

contents (SSL IDs supported),
CPU characteristics (0x12),

creating,
System clock,
System function blocks (SFBs),

System functions (SFCs),
System requirements,@

System status list,[139

CPU LED status (0x74),

0x00, CPU LED status, local only (Ox19),
0x11 , CPU operating mode (0x24),
0x12,[141] DB number and size (0x15),[142]

0x1 3, diagnostic buffer (0xA0),

0x14,(142 DP master system (0x90),

0x15,m DP master system, expanded (0x95),[150
0x19,(143 DP _module diagnostics (00B1, 00B3, 00B4),
0x1C,[143] 150]

0x21 ’ DP module status (0x91),

Ox22, DP rack/station status (Ox92),
0x23, error assignment (0x21),

0x24, events that start OBs (Ox82),

0x25, expanded DP master system (0x95),
0x31, FB and FC number and size (0x15),
0x32,[27] H CPU LED status (0x74),[148]

0x74,[148 | memory size (0x14),

0x82,m identification, module (0x11),/140
0x90,[148 indexes for an SSL ID (0x00),[140

0x91 ’ interrupt and error assignment (0x21 ),
Ox92, interrupt status (0x22),

0x95,[150 L memory size (0x14),

OxAO, LE(BXS;E;T% local and redundant modules
0xB1,[150) LED status, local only (0x19),[143]
0xB3,[150] list SSL IDs (0x00),[140]

0xB4,

assignment of interrupts and errors (0x21),
available SSL 1Ds,[139]

available SSL IDs (0x00),
backup memory (0x13),

Load memory (0x13),

local CPU LED status (0x74),
local module LED status (0x19),
M memory size (0x14),(142

master system (0x90),|148

block types (0x15), maximum number and size of blocks (0x15),
C memory size (0x14), [142
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memory area sizes (0x14),(142

memory areas (0x13),

mode, CPU (0x24),[146

module diagnostics (00B1, 00B3, OOB4),
module identification (0x11),[140]

module LED status, local only (0x19),

module LED status, redundant CPU (0x74),
|148

module status (0x91 ),

OB number and size (0x15),

OB priority class (0x23),

OB start events (0x82),

operating mode (0x24),

order number (0x11 ),

peer-to-peer memory (0x13),
performance, communications (0x31),
PIl memory size (0x14),[142]

PIQ memory size (Ox14),

priority class (0x23),[145]

process image partitions (0x25),

Q memory size (0x14),

rack/station status (0x92),
redundant CPU LED status (0x74),
SDB number and size (0x15),

SFC51,[139]

shadow memory (0x13),

size of blocks (0x15),

size of the memory areas (0x14),
size of user memory areas (0x13),

SSL ID (0x00),[140]

SSL IDs supported,

start events, OBs (Ox82),
station, module status (0x91 ),
status, communications (0x32),|147
system areas (0x14),

T memory size (0x14),|142

types of blocks (0x1 5),

User memory (0x13),
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verify SSL ID (0x00),
version number (0x11 ),
T
Technical specifications,m

Test for jitter,

Threads,

Time (system clock),

Time error,

Time-delay interrupt, [60,|72 |

Time-of-day interrupt,

Timing adjustment,

Transition from STOP to RUN,
Troubleshooting,

defective state,
error conditions,
network problems,m
Tuning panel,
Tuning performance,
U
Unbuffered startup,
Uninstalling WinAC,[12]
Uninterruptible power supply (UPS),
Unregister,
URCY,
USEND,
User privileges, @
USTATUS,
\'

Valid characters for instance name,

Virtual rack,

Virtual slot,
w

WAIT,[100

Warm restart,
Watchdog timer,
WinAC installation, o} [10][11]
Windows,
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always on top, CP card submodule,
priorities, features, ,
UPS settings, priorities,
Windows user privileges,@ process control,
WinLC, properties dialog,
accessing from STEP 7, registering for start at PC boot,
clock correction factor, renaming (invalid characters),
communicating with I/O, specifications,m
configuring communications, starting,
configuring in PC station, unregistering for start at PC boot,
configuring with STEP 7, Work memory,
connecting to STEP 7, saving and restoring,

control panel,
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